SIEMENS

SIMATIC

TREEHI RS PCS 7
PC A& 5L (V8.0)

AP LT

03/2012

A5E02779427-02

W 1
PCS 7 #4iH) PC 444 2
PC HHTEL 3
2235 PC 3 4
b o




BB

EHERTARG

AT RSN G A DB G W P 1K, I ATE AT P IR . A B R iifen ] —AMES = mdkor, S0
PURA RITERAIE & =y B SSRGS 20 i Bk R R

/\ fal

FORUURASKIAH B (N O T, R P BOET 83 ™ N S5

/\ &

FORUWERACKIAR NI/ fE i, AT RE P BOLT 808 ™ KN S 05755

A /J\JD\

WAHES =M, RRWRAKPA N /N0 8T, W RS EUR I AN S5 5% .

/J\l[)

ANHES =, FORUERASKBUAR KO, AT RE T 200 7 B2k .

HE

PR URAE AN s, T RES LA B 45 R BR A

A ERSF RN, BRI R S R B S s . WURAERAN B SR Tl AT S 5 T R E G
P (K =y, AT REAE I T 4R 7R 5 A MY A AT BE S B 4 R R o
FHEEA R

ASCAERTIE I i R G SOVE AT 15250 0 TARZOR M B N REEATHRAf . SLAR AT A0 I % B P RO SCAF BT,
R A KB SR, TR MORE I A, AR N ST AR i R LS, I e v] RER S

K o

Siemens 7=

[EED

TSR

TR R AU

N\ 4

Siemens /i HACVFA T H SR A OGE AR SO UE AT IS DL o W AT AT AR 22 W] 0007 S AN AL, 2045 2]
Siemens #Ef7 FI o VF. IEAIRISH. A7, die. Bl Zede. WK, BRAEMYES L i IEWISITIIRT R .
WIRGRAUE FEVFIOIABE S5 o 200 AR OGS P IR 3R

P A AL S ® ARSI PU T T3 B IR w M R AR o ARAE P I HABST ST e — L8 MR b, X2 TR
PO E BRI H e 3 =5 iR bR s 1

FATTERT BRI ity o T A SRR 1 SRR A o SR I ANHERR A7 AE i Z2 I T RERE, DI FRATTASCRAUE ED )
i PITIR A B SRR P e 4B BRI St (K B oM 2 AR, B IEE A A A

Siemens AG A5E02779427-02 Copyright © Siemens AG 2012.
Industry Sector ® 05/2012 A2 w) O B B B AR PR T RRY
Postfach 48 48

90026 NURNBERG
et



1 1= 7
2 LTSI X ;o [ = OFF < ;SRR 11
2.1 P CS 7 R I A S oo 11
2.2 (Tl L oot 13
2.3 A L R T T N ERT32E 0 e e e e e, 15
2.4 AR (Y LR (3 =S 11 = = SRS 15
2.5 B A T 1 -~ SRR 19
251 AFHEZA T RIS LSBT PCS 7 T H oo e 19
252  AFFHIEA PC AT PCST T0 H e e e ee e 20
253  AEFA PC A TR o A i et 20
2.6 B AT R B I T T 2o et e et 21
R B X (=8 B o 7 B 7= - SRR 21
2.8.2  BATCH T2 T AT B oo e e 23
2.6.3 BB AR T 20 T AT B oot e e 24
3 N 5 /S B (=57 o A I =% SO SSRUR USRS 25
28,5 I R B 5 et 26
2.6.5.1 it Process Historian F1 Information Server K R oo 28
2.6.5.2 I RIARIRSS A (CAS) HEATHI AR oo 29
2.7 B T T R G I T 7T oo e, 30
2.7.1 O B T T R e e 30
2.7 2 BAT CH B T E T B e 32
2,73 BB R T T R e oot 33
3y G/ 5 /R B (%ol A I =Y SO SRRRIUSRRRRNI 33
275  SIMATIC PCS 7 BOX Bt eueeeeeee oo e e e e e e e e e e e e e e e eeeeneeeeenas 34
2.8 T ] P G T T 7T e ettt 37
2.81  JHIT OS Wb JE AT TR U T e eee e ee et e e e e e e e e e e e e e ee e e ee e 37
2.8.2 I I IR B T AT TZEFE T T e eee oo e e e ettt e e e e 38
2.83 LI OPeNPCS 7 T PCS 7 I ..ottt 39
2.9 A0 P O Tl oo 41
e T I Sr N s S I X5 1 O e OO USRS 41
2.0, BB B I L oot 44
2.9.3  THITTEZE LAN TETE PO it 46

PC & 5#4L (v8.0)
YAk 5 T1F, 03/2012, ASE02779427-02 3



H

2004 T I 2 oo oottt e e e 48
P T BRI ..ot eeteseeeeeeeeeeseeeseeeseaasesasaaneeanesnaanesensseaasenseanseaseaneanesReeasenneeereeaseeneennesaneneennnnrennsnneans 51
3.1 PCS 7 HITHZHAS PC R ) oo oo oo 51
3.2 B R T A 2 S oo 52
3.3 R RS2 S I W I RS A1 42K SR 52
34 T T T B A A e, 54
35 e o 1 R A USROS RS RSRRRRURRRRR 56
3 = oSS 57
4.1 T IR e 57
4.2 L TIIER oo 58
4.3 A BR S ettt e ettt er e 61
431 A R G T T 0 oot e et 61
F T - s o USROS P SRR 64
4.3, P C I T oot e ettt 65
O B = (O £ b e R U U U R U USSR SRRSO 67
Y N T 75 L (== USSR 69
4.3.6 LB 7E S e S 11 ST U U U USRS 72
437 WA RS HAZS Microsoft Internet 15 SRS (11S)..vvieieiiiiiiciceecee e 74
4.3.8 U A R 2 G 0ot 78
4.3.0 U S AT e ettt 78
4,310 T B BRI e 79
4311 B B 0 T R A R N et 80
4.3.12 U I B A oo e 80
4,313 23 SIMATIC BATCH [ B IS oo 81
R T R 11 = - USROS 81
4.4 R P S T U oo, 82
4.41 el ST OR R Al O e ol € -5 USRS URRRURRRRI 82
44,2 U B I T 2 e 85
443 U ZEEE PCS T A e e e e e e e en e 86
4.44 WA 2R JL ARG IRSS2E (STOragEPIUS).......vceeeeceeeee et 89
445 U223 ProCeSS HISTOMAN. ... oo 91
4.4 B S T A B B T e 91
447 ZBE OS WED T P Co oo ettt 92
4.4 8 BB L o oottt 92
4.4.9 W B I H BB AP oo oot e e r e 97
A0 PO T T BT K oo ettt ettt 98

PC A 5#HL (V8.0)

A3 T, 03/2012, ASE02779427-02



H R

4.4.11
4412
4413

4.5
451

4.5.11
451.2
4513
4514
45.2

45.2.1
4522
4523
4524

4.6
4.6.1

4.6.2
46.3
46.4
4.6.5
46.6
4.6.7
46.8
46.9
4.6.10

4.7
4.71

4.7.2
4.7.3
4.7.4
4.7.5
4.7.6
4.7.7
4.7.8
4.7.9
4.7.10
4.7.11
4712

S B L B T Tttt ettt ettt e ettt nn 99
B CETUAR” AR RS R “TUAR” B 100
T P CS Tttt 102
T PCS T 2B BT L oottt ettt et 102
T A B T T 1R ettt 102
T A B BRI <ottt 102
BA] 2 A ARVEE T TR .ottt 104
BT 22 ] ) 28 3 I 28 P T HELIZE T, ..ot 105
WA k% AT CP 1613/1623 1) PC 3 LIAE PCS 7 H AT o 105
PCS 7 I A8 IR B IR <ot 107
PCS 7 [ I A8 R IR SRR L ettt 107
BHATBIIT 2 VGA TEITE R e ettt ettt 109
D SNl S L L o OSSOSO 111
BB DCFT7 AU ST oot 112
VI TE ettt ettt et ettt et ettt et et ettt ettt e ettt e e 113
o =T OISR A5 s 2oy RSSO 113
BT AETEVFFTTEBE A ettt ettt e et e e 116
Bt B 1 RA T T SRR 118
T SIMATIC B AT FEIT R ettt 119
FFITE CFC R AT ettt ettt ettt en e e 120
SR K (AT B 3 - TSRO 121
T B T R R I 5 o FE VTR e, 123
TR TAESS I P2 AR B CBEAEZAAED oo 124
L BATCH BB TOH oo ettt 126
T R AT T AR TRT IR AR B oo ettt 126
TG PO I ettt ettt 128
VBT PO Bl — HEIR oot 128
SIMATIC LOGON. ...ttt ettt ettt e et e e n e e 129
WA FZAU JTZHZS SIMATIC LOGON. ...ttt n e 130
PEBE T THE TS (MUt eneaens 131
BT T 3 B 0 M R A TR o 133
WA BEE PC B L) B Z T FRIIESE oot 134
LN I8 R R v e L W3S T WU TSROSO 136
AT EE L PC I BB R TR oot 137
T e U 2 1N Y S N Y A ey N | o NSRS 139
BT FE T SNIMP IZSS ettt 139
] T 8 PO IR TR ettt et ettt et e et 141
BT T I3 ettt 143

PC & 5#4L (v8.0)
YAk 225 T1F, 03/2012, ASE02779427-02 5



H#

D e e S N = o [ =T O TSR 144
g g el = 5 TP 144
PCS 7 M AR A S FH AR TR ..ot en e 144
BTy e T s o 145
LR IR B S R SRRSO 148
TB T T T T ettt ettt et 149
S LITAE .ottt ettt 149
D E=To |1V (o] a1 (o] SO PP 149
D R I ettt ettt ettt 152
R - Ly PR T 152
LA A oL @I @74 F=1 7= 117, (o] T (o] SR 153
............................................................................................................................................. 155
BEESR A = BRI e et 155
BN B 2 o 1 NSO 155
BB B B TR e et 156
SIMATIC BATCH IR AL ..ottt 157
SIMATIC BRI IR AL oo e ettt e e, 158
AT e ettt ettt ettt 159
B B - PC 3l B A TTZHZS oottt 161
L A T L2 ettt et ettt ettt et 161
LA = SRR 166
RIS . LB A BRGEHIZHZS oot 166
MRS B EEE RGBS RESBEFIRZERED) oot 167
MRS AAERAINE (FEMRFA BRI o 168
o o L =1 OO RRTTOPTRN 169
B o i i Gl O (=0 NSRRI 169
AT R AR I o S ettt ettt 169
o oy LN oL = NPT 169
B o i = R (O (=0 NSO TR TSRO 170
............................................................................................................................................. 171

PC A& S5#AL (V8.0)

A3 T, 03/2012, ASE02779427-02



ARG A&
AIAIMEA T PCS 7 K PC 414, a8 LR A
o H[{EHFE PCS 7 M TAEHIM PC 4114
o i PC AU AT
o KA TR VR ATE.
o EPXSHANN AT RER) PC 414
o UNfal AL RIZL A PC M4
ARAEHA TS H5AE. WIRAMLEE AR,

ilal PCS 7 SCRY A R

PiHA
PCS 7 Bid 30t

Internet L[%) PCS 7 (74 3G BALSE T- By PCS 7 Fht. iEfr4ild iz PCS

7 H X L asa ok PCS 7 MEEE B IE.

® Process Control System; SIMATIC PCS 7DVD (] PCS 7 [ X 1154 5% PCS 7 1)
FEAF R, HOUEgm T4t PCS 7 30k,

o M PCS72Jn, fnlLUHE 132 “SIMATIC > P25 & > <i&=>"(SIMATIC > Product
Information > <Language>) #: %] (456 R4 PCS7: PCS 7 Hik /) (Process
Control System PCS 7; PCS 7 Readme) 1 (PCS 7 [{I#iti N %) (What's New in PCS
77) SESCRY .

Wb SO R A SR

FIAELL M A7 E AR E] PCS 7 SCRY rh R A S0RY

e SIMATIC PCS 7 DVD *[1J*_Manuals” Iy .

o [Fiit I SIMATIC Manager M FHFE 7P I /E 25 ) (CHM 3P

o T FEITEG | Windows“J14f"(Start) L [1)“SIMATIC” 1 “3C#4”"(Documentation) ¥
ey PDF SCF.

PC & 5#4L (v8.0)
YAk 5 T1F, 03/2012, ASE02779427-02 7



=
it

SCRY B AR RRCAS
H PCS 7 V8.0, Ffi “Process Control System; SIMATIC PCS 7’DVD HiEAtILA L
PCS 7 &G 3CHY.

ik PCS 7 11 Internet %4 £i www.siemens.de/pcs7-dokumentation (www.siemens.com/
pcs7-documentation) 1] DA77 {1 ] 5EHE ) PCS 7 XY X508 PCS 7 fieAs, nf

EBILLE S
e 7£“Hardware manuals for SIMATIC PCS 7 ...” &4t
— HAEH THA PCS 7 JRAS LA 1T 0

e {£“Software manuals for SIMATIC PCS 7 ...” ¥4
- SEERGE LR
— N PCS 7 SCRYAT PCS 7 Hi B ARG 225/ r . AT LR F A, nlfE
TCREND s ) DA A B B AR OGSOy -
- SIMATIC Manager I I F25 1 (762 #5 B (CHM S0
- Windows JF4A% B () SIMATIC SRS (PDF SCfF)

- SEEEI PCS 7 30k (FHLEE O

AR 0 T E

A% BIFEAFIR

A5

A SCRYE T #4441 Process Control System; SIMATIC PCS 7\V/8.0 {5 =il As .

LSRN AN TR RGNS RS TR RS
NG PC MRBLBE % Cngifeiet) WAL, IR Windows ##11E R4E.

FEASCRIH, BAFFHI TR AR ITE 5 SASCRITE 5 — 8. RN B R 20
TZEGTHIME, BEOES)E, MLV R RSN EATE S on, L, aTaEAs
)T SRR T A P

PC A& S5#AL (V8.0)
A3 T, 03/2012, ASE02779427-02


http://www.siemens.com/pcs7-documentation
http://www.siemens.com/pcs7-documentation

=
it

X TSR A K2R 5
N HEIBEE T ASSOR B S B RRCAS A L I A1 ) d B 2 19 5 0
o gl TR NGB OS 20/ i b
HRGER, E2% “giy LI 2 LI R4 (0L 25)” #i47

® Process Historian il Information Server
1§ 1] Process Historian #1 Information Server #4791 e 944 (11 28)

PC & 5#4L (v8.0)
YAk 5 T1F, 03/2012, ASE02779427-02 9






PCS 7 &4 PC A 2

2.1 PCS 7 ARG EAHS

BEig
£ PCS7 1), PC4IfFH T LA R u:
o [ FENivk (ES, Engineering station)
o FpfF ik (OS, Operator station)
o iyl (MS, Maintenance station)
e BATCH 3 (BATCH)
e Route Control T.{E3u (RCS)
o T SIMATIC PCS 7 i&#:3 SIMATIC IT FREEH vk
PCS 7 J1X 2L B FR oA “PC w7 o« FEIE/R T PCS7 1) Hf B — e ff,
IR BERM LI BATCHIE  BREEH PCS 7 OS Web &4
T,
N T TN TN 1 =
| | | | | Intranet/Internet
B (RBESRT B%) o ///'-_é
s mosscns JT e
Amfex I‘II LLLLoLR] |' . |
T SIMATIC
PROFIBUSDE o= 110 PCS 7 BOX
PC & 5#4L (v8.0)

WAt B, 03/2012, ASE02779427-02 11



PCS 7 #2119 PC 411+

2.1 PCS 7 ZZMIHEAN

Bl

”

Thfe

TREME, (0L 15)

R AR, nTCAAZSHF ek PCS 7 W1 REALHF:  #AE R uh. BATCH b,
Route Control LfEui. Hab &%, EHAFSAA /0.
TARIms R FR AR Fee T T4 PCS 7 i H i) PCS 7 TRE# A1 PC.

ERAE G (UL 15)

Al Dot ] TAEE R M ERIERTIAL PCS 7 R 48

Rt iR ) M2, Dl A RGBT B i 1 Bt i £

A B 4RI B3 T PCS 7 OS # A1) PC.

X ESRIEB SRR /AN, AR A Db Bevh o AR R G AR R ™ 4%
IR L) v, OS it sy OS iks5as Al OS 7/ i) 2 LA s R4t

Yegruk (00 15)

UESIOE TARAE B3 (OS). 1% OS REFIT “ L) B , JfFLatf 1) 7
N

T R RIS R, 15 OS ALY I . T L T
ST RERTRL LAY % OS HhREIATH i

Ve TR . 5 SIMATIC PDM i, 4633535 Ui i SIMATIC
PDM.

BATCH 3 (7T 15)

BATCH i F T 7E i FEA 20 N/ A AL A r = it B2y .
5 Ashik RGBT E G 0AS T B R vk %R . ik, BATCH ublidife 3| &g

BATCH i /223 7 SIMATIC BATCH #44:1#) PC.

Route Control T.1E
vl (U1 15)

{# ] Route Control T.{E¥4 (RCS, Route Control Station) K528, PCS 7 T.) 4
LA™ 5 IR S AL F

Route Control T {Eub#iifes) 1) B4k, DIRMLprmEdnm s, LR i BT
R BRAE k.

Route Control T4 /2 22%% 7 SIMATIC Route Control #{4:(f) PC.

BERG (2
ML) B (7T 41)

PCS 7 AS. OS. BATCH. RCS #l ES A AH H. 2 [Alif i s 4 R 48 (T EAK KD
WAL . £ PCST7 L) b, BEEEMIr LU P
o JHT LU ALAF Il A5 28 el 45 -
- FERFERIAEM RS (OS. BATCH. RCS)
- LRENT,
- EgAE (it MES. FRAEME)
o MTUUNAMFIEMFEN T Hek:
- k%45 (OS. RCS) MHEIMES
- ARG (SIMATIC iEHD

12

PC HAS#AL (V8.0)
A3 T, 03/2012, ASE02779427-02



PCS 7 Z 4519 PC Z1F
22 B OUR) A&

h Thie
H2hik FEN ARG AT AT LA M AESS
R4 o AS MUHEHEM /O AEFARIIATD RAAAE I FRARAE, I il Fedan 4%

M B {H
o AS A bSO Tl AL I
o AS YUNEAE b A IR IR [ B e
SIMATIC PCS 7 SIMATIC PCS 7 BOX s i/ N T I Tl PC. 504X 11O S &AL I, &
BOX (11 34) HA PCS 7 el R gt thae (CLREAR. A, #AE EiAhE .

2.2 wiE OUE) A%

féifi

FEEREFE AR ST A AR AL PR B B KBS A e I DUARBETHERAIE T 42 R 4
PRI R XA AR K T AR A Sy, TR T R S

AP L AN R AR S R, AT AR CAR AR A 1 il
fE5% -

PCS 7 L) # 1) PC ¥T&R
A LLLE PCS 7 i I TC AR 4Lk {5 PC b i s T Ik
o HVEETUAMRS B LA a1k

JEtE Hik

X IR 55 st R (1 X 7 | A AR IR S5 20 Rt H o, SR — AN IR 55 2 LR IR e

% Al A TUAR IR G5 ae gk S I RE AT A%, Xt R LA
o

i 5% s Hch PCS7 T) "hiZ 47 12 Mdas O

WNESPIERIAT A | N BEERE, TR S0 AT N S — A a5 4%— .

i SRS A AT AL BRI AT AR5 R A S8
BRI TR RS54 -

PC & 5#4L (v8.0)
YAz 5 T1F, 03/2012, ASE02779427-02 13



PCS 7 #2119 PC 41 1F

22 Bt OUR) A&

o T RICARMLEAF LU

Bt ik
HH I i S5 e A I (1) | 45 2IFHEE ) ) 28 G A T PC il 55 2 S 2R (1) T U AR I 4% -
LS o PCl MG R4S
® PCle MZ%iG it %%
o AR LT L
WEMKAEL, TSHEFM GIFEEHIRS PCS7; FHid s
TR %) (Process Control System PCS 7; Fault-tolerant
Process Control Systems).
HIL T B2 MBE i 1) | DUR M IERL s 2 — AL CP) n[HF PC 35 T &
VIES LRI TUARIERE

e CP 1623

e CP 1613

BEZAKGEE, ST GIREH RS PCS 7; A iy
HARL) (Process Control System PCS 7; Fault-tolerant
Process Control Systems).

XL (PRI
R PR Y

PCS 7 H [ S R IR RS 25 Koy o 28 HAT LB TUARHFAIE o
B AR 2 R, I hmliats.

Xf PC M 4438 e s 2 AT

BRAEHITUR M E8 TG HC AR MO AR 201, RIVEE 199 2% T P o Al
B AN, AT ATiET

T SRAH N FH AR A o] FH PR T8 PCS 7 T 2 K H 2, N AR 24 U AR IS5 4 4 o
IR EAER PSR PCS 7 1) 1 PC ufi, iU 2 ANl 45 -

o HREu-MRST A RAR AR, THSI “ 2 T RGN E TR R 8] (22

EMMEE, W% “UARILRIRSEHRIIICAR (50 91)” .

o ARMBMMEITTIURIIBEME L, WZHE T (LGRS PCS 7, A FEyE il
#4:) (Process Control System PCS 7; Fault-Tolerant Process Control Systems).

BBLALBR
@il
LR
5 (5 15)” 4
o HKUITHIEILA
14

PC HA&S5#AL (V8.0)
A3 T, 03/2012, ASE02779427-02



PCS 7 £Z119 PC A11F
2.4 Z T1Fa R LRI TF3E R R 707

e 17X BATCH s A MISEIIURINREMIME B, AI2H T GIrEf R4 PCS 7;
SIMATIC BATCH) (Process Control System PCS 7; SIMATIC BATCH).

e {750 Route Control TARSSZHAFSLBUCRIIBERIE R, WZ% T GRS RS
PCS 7; SIMATIC Route Control) (Process Control System PCS 7; SIMATIC Route

Conftrol).
2.3 st I AR i on B 190 328 T30
e £ PC
FEAE RIS %) PCS 7 RGEHAT W VHIN, RILIAT 2Rk +e.  #ildn, fexf PCS 7 R4t
ATV, QR A PC Tkl 242K, W LMEHI 24~ PC.
AT TREBOEIE, A2 A PC 5 AT SAN TRENE X Y & 2 [ 22 501 b S LA P 3
J=1c & 24 TRk {5 F BN TAR I
3 FH 40k o KPHARL o NURY
o AP o ARHARAT Bk
W g Rl TR A S o HHIRS
AL A1 B2 A
H&l o LA TR PCS 7 Wi H THE |e fEfA PC ESZHL—4~ PCS 7 Wi HM T
Fik (7T 19) T (7L 20)
o (LA PC R4S TAZIM S, FIHEAE ik
(VT 20)
e ffiJf] SIMATIC PCS 7 BOX #k47 #: it
HRAER, AIZ% T GEEEH RS
PCS7; SIMATIC PCS7BOX) (Process
Control System PCS 7; SIMATIC PCS 7
BOX)
2.4 Z TR REM B TR RAZIF K ZE R~

AR RS N RS PCS 7 AR (i, OS. BATCH. RCS Figiduh) 41735H
BT AES RGEBCK & HL-IR &S 28R R a5 2 TAER 248

PC & 5#4L (v8.0)
W A2edE T, 03/2012, ASE02779427-02

15



PCS 7 #2119 PC 411F
2.4 Z ARG T3 R0 27557

% TARHi REGERT € X

2 TAFS RGEE hAE PC I R4, X2 PC (filtn, OS &/ Hl. OS JIRZ#%) 704l
A FHUIRSS 2R R 45kt PCS 7 N HIREFF IR &M TR,  Process Control System;
SIMATIC PCS 7 DVD b t$efit T AH G 1% 7 ity 5l Al 45 2% 4K A

T2 TAEMARS, @WAS AN EmEgk (5L BLnit) » HT&EIISRSHZ
[A] [ R i £

BT RGHE X

FTAR RGEEL “ L TARS,” 24t PCS 7 NHFR P58 Ren) PC, i, #AE bk,
“WFREEHIR S SIMATIC PCS 7'DVD Aubdefit T “ i TAERE” #ff.

TR BT (R RO R T Ak LRI B (i, 4 PCS 7 1) g RN AEtE% T
S REEND)

% TAEU RGN TAES RGBT

JB % T RA B TR RA
W Atk KHHRS o NURY

o ARHBERAT: Ak
o RS

N &2 PC 1% ) -5 ds ik R 45k | A7 PCS 7 MR F
o HRAEUNZ TAEM RS (WL 21) 2T RER A PC:
e BATCH % T1Eui 2% (7L 23) e OS H T RS (T 30)

o RIS TAENE 2 TAESE RS (L 24) | BATCH HT{Eu RS (1L 32)

o YEP T AN TR RS (T 25) o EAEFEHIN AR RS (V1 33)

e SIMATIC PCS 7 BOX i (1T 34)

o YEY TR AES RS (UL 33)

AR RIS St 2 v 32 A TARE, A LA IR 2 A 4 NS (BT H
)

PC HA&AS5#AL (V8.0)
16 BApE T, 03/2012, ASE02779427-02



PCS 7 2119 PC A11F
2.4 ZIAMFURGRE TFH R 755

Bt Z TR RS BTAE RS
CINEER A PR PCS 7 1) [Rwmnl FHYE, o] DLKE IR 25 28 4L N TUAR IR 55 284 (PC):
o Ak i
- OS 554
— AR RS A
- MS [R5
e BATCH ifi
— BATCH IR % %%
e Route Control T 1k
— Route Control 55 %%
HEZMHIAFE, W% “Fir OUR) 435 (I 13)” #57r.
i & iy fEPCS7 1) Wi H 12 Mg OF) o PURRE—I# T A — AN S 45«
o X TAFui RGNS 45
o JURRSS AN
® MS JIR% 4
o PR RSSA

Intranet # Internet %4
] LLf L OpenPCS 7 5, OS Web & /15235 Intranet 1 Internet 1354z

BE2MRER, EZ W “ilid OS Web ik fFitAr e vii (UL 37)” A1 “Afi/f] OpenPCS 7
Viln) PCS 7 #dl (1 39)” #7r.

PC & 5#4L (v8.0)
YAk 5 T1F, 03/2012, ASE02779427-02 17



PCS 7 #4119 PC 411t

2.4 Z T AMFURGRIA T F3 R )25 57

RN |
THREIAZS B8 THE PCS 7 1] W2 TAEM RGN TAER RSE N H :
% THEd
OS BEF#L BRI H R BATCH &f
OS EF#l #l #l
+MS B (
A% ) [ | [ y [ )
. E;—-: [l T BATCHESE
\ | ) | | LRl
[ LR 4 Tl LUK ]
Ti2Ifgh
+MS ZF
(A ) g
™~ % osmsE |mamssy 7
| - - |_ | U | | U | | U | IndustriaILLI
( T BTl AN )|
# Tk
Ti2Ifvh 4P T2 TG OS B TEWHRE
|- | |. | |. |
I I I L g
( BETLAR ) ’&ég
I I I == Industrial
|. |, |. | |. |
BATCH B T4k BRI THE SIMATIC
WRE RS PCS 7 BOX
PC A 5#HL (V8.0)
18 AE AT, 03/2012, ASE02779427-02



PCS 7 #2117 PC 11T
2.5 TR HIME AR 5

2.5 ARk IO TT SR

2.5.1 fEFH A TREmu A A% PCS 7 TiH

AFBIHEFHIZ L
f PCS 7 1) HBHES A Beg T4 TR . PCS 7 gkl LIl

pris] IR

EZTH AR Z I H TR AVEE T H 41 I A B 2% H .

- CRRIs v I Y 2% 3, AR AT AL T AN )X

S SCME I H FZ | TERZRY (ST R Qo MEHTH, 35T TR LA
i A%

M R 28 4 7 2 TR ] LA S [ 09 (1) RISt , ) I Ak A7 i 7 v ok T
U5 3 AN T H (ke 2 82> (9 AS. OS)

Z T H TR HALE)
0s B4
TRMES TR 2
THEmYE 1 ;J uk =
58 3. Tl B A Y | |
’,/ \\: I 4
0S B H 0S &S
(. ‘ | [ 7, |
'm| |- .m | BN | a

i I
[ I BTl BLRM ] == //—_//_4;

BZER
AR THBBTEAE R, SHAETM GIREHRI RS PCS 7; L ARL) (Process
Control System PCS 7; Engineering System).

PC & 5#4L (v8.0)

B2 T1F, 03/2012, ASE02779427-02 19



PCS 7 #2119 PC 411+
2.5 L FEIaE e 7 %

252 fF R B4 PC A&t PCS7 i H

SEhTRAS
AR TR Y BT PCS 7 NWHIRER (OS. BATCH. ifeiziil. AS) bz
—/~ PCS7 %#%.
WER AR AL ASHE P 3R H AR RGO R M IGUE, Wl TR I 2] 1) B2k
GUEESI PSR o

LB

0S &F#l

T )

- | | 458 5.4 Tl BUA
|. |
e — TR
0S B OS % . | BATCH#
| | LfFu
L | E..E,.élﬁ |-
( T B&TUAAN ] f//

Industrial

SIMATIC PCS 7 BOX

SIMATIC PCS 7 BOX i n] -AE/NRIAT R R TARIMS, . HZAHRAF R, WIZHF
(I HIRS PCS 7; SIMATIC PCS 7 BOX) (Process Control System PCS 7; SIMATIC
PCS 7 BOX).

253 FEA PC LA & TR Mus AER/E R vk

BAS PC LR TARISE FI#RAE 5 35
AR A TR Y BT AT PCS 7 414F (it OS. BATCH. #fzfihl. AS) &rpdlas
—APNRRSGE GBI AR
UL, PR TREIT AR D1 2 AR . RIS DL N, 34 Rl g 0 il
DL (ETE

PC A& S5#AL (V8.0)
20 k2 T, 03/2012, ASE02779427-02



PCS 7 2119 PC A11F
2.6 Z IR TNIMERTT

PURSEGIA S B TR AL /80m & 1) Sl s dokitr, 41
s R AR MR H s RGN R S8 5 i R

AR
IEMuEAMIRAER S
e
|. |
Tl AR o ;
| | -= Industrialm
BHLRSLE iﬂ% m .
AS 400 I‘II R L | Tl
o SIMATIC
—I_F)ROF'BUS bE asRlo PCS 7 BOX

SIMATIC PCS 7 BOX

SIMATIC PCS 7 BOX th n] HAE/N RIS R R TARIS . HZAHRAFE, WE%
“SIMATIC PCS 7 BOX i (11 34)” #7r LLAC T Gl Rz 5248 PCS 7; SIMATIC PCS
7 BOX) (Process Control System PCS 7; SIMATIC PCS 7 BOX).

2.6 2 TARMi RERIMFRTT R

2.6.1 BAE RN Z TR RS

Ve R 2 7 Si- T 5 2 R R G 2 TAESE R G HIBRAE A h

o OS ZTAui AL hZ A 08 %/ i (LARu) 4p, X% Il —4> OS fiks5s (=
Z A 08 lussae) it Zui i 4k (OS LAN) SRR EMs (I H Hodl . il RS, 4
%*niﬁ'§\> o

e OS li%s#simz Lk 32 4> OS & i ik FEAd .

PC & 5#4L (v8.0)
YAk 225 T1F, 03/2012, ASE02779427-02 21



PCS 7 #2119 PC 411+
2.6 Z AU RTINS

® OS %)t 2 il LUV i) 12 4> OS M5 s B (2% ) D .

o ML VGA % nlff 4 NIEMAERD TAuE (0S %/ ) « KA A
BB BV RT3 e T Y AR X

o OS kg4 R Mg im e, KU rT LI R L OS Ikgs+s LR (lr: S,
HE AR o 2, A OS fledsas L REm i thn] L& e OS k55
RIbR2E AL &

o JEIAAIUAR OS kg5 slifi T R R4 Z A OS Indrds, W LASRAFHRAE Sk
A . XTIUAR OS JIkRS 4, 2" SIMATIC PCS 7 fIR55 a5 LR 7 AL,

iR
I RAE OS Mds as L4RAER) OS & s ANEERL DS, T AKS OS k54 A # A1 5
W AR .
S
e[ e 0S &4l
oy -
1 [ | cuskmamss
osEEE | | TROSHZ®  MB1240S
R, | | wl—l- B8 (TR)
- T
( TUSARRESE ) -~
KR T $odfE
M PCS 7 V8.0 T4, W AFEZ AT SR AR b AF 2 T b AT ik A ORI £ B %
R, WS MRk & (U1 26)” 5T
e

Yegrob T TR al, JFRUMEI TI2WDiRE. A, PR e ulify il TR RSt
BLMRER, 5%

o “UedP ARG 2 TARuG RS (W 25)” #Ro)

o ANTM CEEEHIRS PCS7, 4E4rui) (Process Control System PCS 7,
Maintenance Station)

PC HAS#AL (V8.0)
22 2 T, 03/2012, ASE02779427-02



PCS 7 £Z¢119 PC A11F

2.6 Z IR TNIMFRTTF

OS ZHI R4 i) Web 14
Al LAM# ] Internet Explorer Vi i) OS (40d, HiH&/2h 2 LU 44
o 715 OS XKML —/~ OS % /i 236 T“0OS Web & .

FER 28 BB T 7 T AR

ARIEEBMEZEL, HS N0 “Hid OS Web LA AT Y; 0] (WL 37)” #57

2.6.2 BATCH ¥4 % TAEU R4

Ve R R % P =M 55 2 R R G ) 22 TAR S ARG BATCH 3

PC 41544 (V8.0)

BATCH % TAEBE ARG 24> BATCH %/ (CLAFu) A, X4 i h—4
BATCH filt 2% # il ik oy i R gt 5t (T H B W FRE . AR, BRI ED .
—/> BATCH Jlrg5t e 2 Wl i) 32 /> BATCH % )™ i f (e R Hiedha

£ PCS7 T, XfT—4 BATCH Jlg55+#s Hfef7—> BATCH Il H .

f£—> BATCH g5 a5 R al KABES — A BATCH 1t H .

i BATCH % i E R L2 A PCS 7 R48. Ak, MWJHZ) BATCH % F i b
124> BATCH 7/ 3 [ I RE 3 JFAE SR S I IE AN R b A= T H - CREASIH —A4>
BATCH flud5 %) o X TiXFHEoL, @2 VGA k.

WILATUA BATCH JIgs#%, TSIl PCS 7 RS mnl k. #t PCS 7 T H ik
e BB, WENIURT) BATCH R4 a2 0 BATCH JiR%s 4%

L]
WA BATCH JIr45 s L 45AE ) BATCH %% )7 s AN L PUAS,  WA] LK BATCH k%5
A AR T A

YAz 5 T1F, 03/2012, ASE02779427-02 23



PCS 7 #2119 PC 411F

2.6 Z I MFI AN T 5
HASRB
05 % BATCH fli%5#% BATCH % /¥
5 \ LE
| | 2ot T AR : | |
0S Mess#% 0S Mess#s :
L DL 8% 12 605 s |
| [ &% oo |_GHTIET AS 03815 g
( T CTADURR)D ) Aﬁé
T AS iB1T

WARAE BATCH I H 417 75T AS L7, W BATCH iR 55 4 b UL B T Sl 2k

26.3 PRSI TR 2 TARS RS

VERRRZ L - IS5 as PR R G4 I 22 AR Sh R AR B A2 1) A o

o ARIEHI TR 2 T s R h 2 AR HI R L CEfEt) 4l X flm—
AR AR IR 55 Al 2 D AR PR (I Bt IERRE. TR HREA
JSORN

o NSRRGSR 2 W] ) 32 AR AR P A S MU A

e {EPCS7 R4, —AMEAREHIRS SR Nl CBIAEEH TR
B .

o PRARIE I ST A T EOERLF] OS LI R o

o ML VGA R nl s 4 MRS ER P TR Giassiilz mpl o Ao
SHEAS A BB B AT SR A eh e T R 2R G X

o THMABICRHMARTERIRSS A%, PR AR B AR = . Wt PCS 7 T H
IS5 B H T, TURAS IR AR TR ST s S BN B AR AR IR 55 s
L]

UERAE BR AR IR 55 s EERAE AR AR R P HUASERE DU, AT DURE B A2 il 5%
OB S (AN ECER (BTE

PC HAS5#AL (V8.0)
24 BAE T, 03/2012, ASE02779427-02



PCS 7 2119 PC A11F
2.6 Z IR TNIMERTT

AR
OS EF# BEREERFH
| 1 I TS ARAR B
] |{ | |=OS B %528 ] IJ I ﬁgggﬁﬁu

|

Tk AKRMRG B4

-
Industrial

264 AN (SLERR(SF

(Pl
Yeyubi T PCS 7 1) KIS WA B 2 P

Ve R 2 P vi-H 55 28 A R S5 K 22 AR S R4
YR 2 AR s RGO dedr ol i DL A4k
o YrPSSA (faifk MS Hids &)

MS ik 55 #5452 Gei2 Wi i 75 (1 i 1 5 S A Al ZEh 21— A PC L. MS R4 a8 2 N 41

e UIAE MS 2/ i SR s R ClnIit B 2 #ERIE D -

— K H OS MR 45 1 M4 w3 Kb

- MRS

MR AATCART MS IRge2%, T 3RAFGEd bt i) e v] FH

o Y i (iR MS % )73

MS % = g F 2 Wi (R K T WA IS WDIR S, IR AT 75 44 5L s e

— TRfisE s OS v JH4E MS %/ it .
TP PR A 2R oIR A T DA 2 TREI S, R 752238 T MS & i o

- B % VGA RiZ vk 4 G I ESEER— 6 MS 2%/ . U7 FH BB R
P B AT B4 FH I B R G X

PC & 5#4L (v8.0)
YAk 225 T1F, 03/2012, ASE02779427-02 25



PCS 7 219 PC 411F

2.6 Z LFG RN
iRN
TRIF 0s BF 4L
(EBMS (BB MS OS &FHL
L) EFHL)
1 I I I
( Tl SRR 54 )
|| MS R&E | || OS k2R &% 12 & OS RS
1 1 (%)
( Tl ARRL L ) . //_'//5

Industrial

AR R R
E7&3UR S VAL Se MY WS
® MS 55 a2 N RGN A AR OS fids &t

o MS &y nl FIAE TRETRGEE OS & /i e A RIS U, IS WAETM iy
H ARG PCS 7; 4i4uh) (Process Control System PCS 7; Maintenance Station).

ARLZIENELEE, W25 “Qifl 23 PCS 7 #ff (1T 86)” o).

BZ2ER
o [l “EIAT4ZS (1T 161)”

o (IFEHEHIRG PCST; 4yl (Process Control System PCS 7; Maintenance Station)
Tt

2.6.5 AR I RS AR 55 2%

75 PCS 7 P FHAMB IR R 55 %% LK SR g PR ok B PCS 7 (K4 A 1) Hodie it A7 (K40
k. 75 PCS 7 V8.0 KM mifA, WJ AR LU N B0 p AT 1B £«

® Process Historian #1 Information Server
o dLHRY RS AR
ANV A 25 2% 2 e i 2k B —AN N, ASEERIT) Bk .

PC HAS#AL (V8.0)
26 2 T, 03/2012, ASE02779427-02



PCS 7 2119 PC A11F

2.6 Z LTFIH RANIMER K

AR VA i 55 25 8RR
Process Historian #1 Information Server e A AR S R
Process Historian 5 BIRE5%
it H IR R ¢ H T #4 Process TR KR R ¢
Historian H {7 fif (1) £ 6l
NG RARE R R S
RS KHZAPCS 7 I H kH—4PCS7IiH
o RIS IS = ISP
* OSif#% A
e BATCH % IS = JEp =
Br¥E AR N AT AR I AT f§H StoragePlusViewer
(1 O 58 LBk
o I HHIEVED)fE s A ALl Gt
e l/8 BATCH % &K H] PDF SCHEER
o ilyk BATCH #i¥i i SQL Thik ANitgg
KRR R RSN | T2 REE 3N
J
S EE
e jEil WinCC #1f e CSV Xff ® CSV Xt
o XML 3t o XML Xt
o IFHA e PDF Ut
® RTF (1
SALEE AT RN BN
Excel nZ& I
Wt Web B HR4$3E ® ISl Web JIr55#%
TLRAR o Bk e
Ui Hg
ZHSMBIAR RS A
LA R B R LR L
o JyftmtERe, WETE— AR PC e AN IH R IR S 4%
o FUIH RAID REKMIIREH 24
PC & 5#4L (v8.0)

A2 2 FHE, 03/2012, ASE02779427-02

27



PCS 7 219 PC 411F
2.6 Z IFI RTINS

ViR AR
T JEL O AR R R 55 5 0 P s S A BR AL 2 B DR
EZER

o LR IR S5 A
— StoragePlus 7147 Bl

® Process Historian # Information Server
— M4 (SIMATIC HMI; SIMATIC Process Historian)

- XHY (SIMATIC HMI; SIMATIC 15 B Ik%4:) (SIMATIC HMI; SIMATIC Information
Server)

2.6.5.1 i3 Process Historian 1 Information Server 315y

Process Historian FIZ)RE
fii ] Process Historian nJ 4T LA F Zhfig:
o ok H PCS 7 OS (131 &AL R ITRY
o K1 SIMATIC BATCH (it L =45 4%
o R IRIEE T B AMBAEE AN T

Information Server Iz Rk
e Jfil Office 7 # (Excel. Word. PDF) #EfIfilEiR#%E
o oRHLA AR B
o ST Web w7 ML il 4k

EEZER
e UF% (SIMATIC HMI; SIMATIC Process Historian)

o U} (SIMATIC HMI; SIMATIC 15 B k%5#5) (SIMATIC HMI; SIMATIC Information
Server)

PC HAS5#AL (V8.0)
28 BApE LR, 03/2012, ASE02779427-02



PCS 7 £Z119 PC A11F

2.6.5.2 W TR AR SS4 (CAS) AT HAIERYS

faifr

2.6 Z IR TNIMFRTT

“CAS”  (FFRIARIRST A% AAMBIHR S48, T TAET RE X R A PCS 7 1%
ot ) HE BEAT RS ARS  RT A R R TR e 5% e R AR B DL SRR PR RS SCAE

ES (B

- OS HRYH e I A AN S . OS ik

SIMATIC BATCH

— PDF #& it Ar~Ha& Cafig)

— XML #%50H1 SQL 2 F LA P2 B
HrRHEEE, 12 W SIMATIC BATCH 0

URVEL Ve anpl RYAS S OR i S it S
TR TCARALAS P SRR I 55 2, T USRS )R e 55 2 1) s vl A

A P R SR DR A 55 45 7T LAARAT BL T Zhe

AL

Fk H PCS 7 OS 13 S A F2 L A

R4 OS #3k

¥k F SIMATIC BATCH (fftb 7= H & 44
K BT VRS B5HG AL % B A7 i A TR
BT VAR s g ol H %

P S 8 R

A5 FE S 0 2 i DA WS P R A 1 T o s e A (i
Kb FHE L CSV 3 XML SR T

7R SIMATIC BATCH Hr itk A= H &
TEHET web [ 575 1] 7 5 7 U A cahs

Alif i StoragePlus A& 2% A& VRS H i

PC A1 54%4L (V8.0)

A2 2 TFHE, 03/2012, ASE02779427-02

29



PCS 7 #2519 PC 411F
2.7 B IAFI R NI

k7S A
A FAT P R R R 55 A O P R E B, AT LAV R ARG

AR BZE A R S5 5 KR I
LA R AR EL R LA
o Jyfemthag, HE AL PC B2 TR RS As .
o FUWAEH RAID RGUAH LR A 7631

HZER
StoragePlus 7E£k 7 1Y)

2.7 BT AR RERIFRTT R

2.7.1 OS BT AEU RS

BAPC EAE R TAEMRAK OS
e OS R TAEH ARG EA PC L E& PCS 7 T H Frds 00T 5V DL IR 125 Th e A 384 B 3l
(HREFITIHIE) .
o 1) H L OS B Lui ARG n] 5 e B TS a2 LA S RG AT -

o MTAIAIUA OS T AEuh Rk H LA AR 24 OS B TAER RS, wlAff
PCS 7 KGR H mnl HPE. W SRAETCR 0 RS PC i 1352235 7 “OS Single
Station Redundancy” VFrliE%EH, MIEELLITA 7 X\ EAE OS HL T A/Ew & 4¢.

o LTILIE PC b5 OS M TAFu R TREIsE 45 S8 H] .
BEMRMEE, WS “7E PC _L4LE TR MERAE Gt (50 20)” #5).

o WATLIE PC oK OS H TAFuli RGeS TREINBEFI H L R4 BBl . Affik
J7 ik SIMATIC PCS 7 BOX RTX K44t

PC A& S5#AL (V8.0)
30 BAE LT, 03/2012, ASE02779427-02



PCS 7 2119 PC A11F
2.7 B LAFI R NI AT R

HERBI
TFEImu,
| SR 48 Tl LA
I flrintttentenke fankententinontentntionlentests s
- OS B TEIER
| S
|- |
( TI BT A AN ) o //"//_4
OS HET1Ev RS Web 4

LT R AN SAE ISR N, afLUE ] Internet Explorer 1ili] OS [#) %4k «
o (7 OS %%:“Web Option for OS” #ff:1i,,

o LA B4 ) il BLBR o

MXRAFE, 7Z% “Hil OS Web S AF#ATIERE VI 0] (W 37)” #5%-

AR %38 5 2] Process Historian

OS ¥ T AEus R GRS K 1) L PCS 7 V8.0 51 %] Process Historian. #H3¢{5 &, i
Z WL ARG F M (SIMATIC HMI; Process Historian 4 #) (SIMATIC HMI; Process
Historian Administration) .

EEZER
o “YEHA PC EAIA TREMSEAIERAE G vl (VL 20)” #i4y
o BT (G Fidahl &% PCS 7; SIMATIC PCS 7 BOX) (Process Control System
PCS 7; SIMATIC PCS 7 BOX)
PC 4175 54 (V8.0)

YAk 225 T1F, 03/2012, ASE02779427-02 31



PCS 7 #2119 PC 411+
2.7 B IAFI R NI

272 BATCH B T/EuE R4

BASPC _EAE MR TAEM R SH BATCH

o BATCH M TAEU RS LA PC L BATCH 3. A3/t S A0 s WL T B s my it
TREIUE . BATCH S TAEuS 2455 BATCH I H G FESIT/HI0) MCEE.
o T HLIE o B S P B A
— LT PCIEATIN, 75l o B2 I H: LR R0 HAF Al (OS R4s4%) LUTER
SR G AT B .

— T AS BATH T B AN E
a) P& B LR IER:, DMEFIE 2 8 E bl (OS g5 4%)
b) BT SZkiids:, DMEER ASLRS.

e BATCH L L{Euk RG] TEAERMIBAEEAN T . M TEAEZ AR R ooy, A
R ICHRS S A Ts N B 2] OS R4S 4% FIAH N 421 BATCH L TAEM R, Witk
PN EZA RS, @] BATCH 362 TAERE R4 (7L 23).

o B T 24 BATCH H LEui R24::  FrH A BATCH L AEul RGN IERE S
/A 0S &%,

o W LLUARERAE BATCH H LAER R4E.
o N TR, WIS OS kS5 A ifdHe.

HETH
TR 0S % F' ity
3
g

. | ' | E 2t 24 28 Tl DAY
|. | ]

' 0S Hss#s TCAx BATCH ®.T

05 s | fEmES
| | = 1 |'-|,

| (HTIHT AS igfr)

I - 5
( T CLAELUKRD ] 424%

PC HAS5#AL (V8.0)
32 BAE LT, 03/2012, ASE02779427-02



PCS 7 £Z119 PC A11F
2.7 B LFI R NI AT R

273 BRI T RS

BA PC _EARA B TAER R ST B 242

o PRI TAESS RG LA PC LM AR TA S . Al M AR 2 i B ARk R G mT
SEULPCS 7 1) Rl R = S AR g 1 3k

o W UJUARERAT AR R AR S R
o iy TAEHILS R, AZAT 5 OS kg as s
Y

U RAE AT AR PR T AR ol R G RN L e AR P R R L, WAL iR — R4
FEBIHI A DI B T K o

AR
p—_—— 0S &4l
N [ ] 4388 T AL B
m
5 % OS B B HIE T
oS BE B S b RE
=1 |- |
Lk |*="""__. T
( T B&T AR ] --4Zé§

274 Yt TAESE R TARM R

i

Yl T PCS 7 1) RIS Wi ¥ 7 1L

VEN B TAR B R G gt e — D BAT TR, . OS H ARl RGEMLEY i 1) PC ki
PC &5 (V8.0)

WAk 2e 3 T, 03/2012, ASE02779427-02 33



PCS 7 #2119 PC 411F
2.7 B IAFI R TN

EZEL
o “UefPub® TAFME RS (W 25)” H
e “OS M ITAEu ARG (U 30)” #hor
o “YEHA PC EALE TR ANERA: Sk (5T 20)” &5y
o [ffa “CIAATHILLA (BT 161)

o (WIFHEHIRZ PCST7; 4y uli) (Process Control System PCS 7; Maintenance Station)
Tt

o Tt (ilFifE#I RS PCS 7; SIMATIC PCS 7 BOX) (Process Control System PCS
7, SIMATIC PCS 7 BOX)

2.7.5 SIMATIC PCS 7 BOX i

SIMATIC PCS 7 BOX HfE/MI T MdEEHI RS

SIMATIC PCS 7 BOX /& /N T i Tk PC. 5004 11O g5 &4 i, & B
PCS 7 = R G ThAE (TREAIA. Ak, HAE myEflfii .

O FH AR
SIMATIC PCS 7 BOX Ju Hud@ HI /N LT ik 24 -
o EpErh /N R ]
o MTIRAFLITT
o SR E BRI A Bk

SIMATIC PCS 7 BOX PC i fHi#rift PCS 7 R4 11E 4 SIMATIC PCS 7 R4 1A% -
EATEAT AT RGP AT A HAN S8 i H e

PC HA&S#AL (V8.0)
34 BAE TN, 03/2012, ASE02779427-02



PCS 7 £Z119 PC A11F

SIMATIC PCS 7 BOX /=3 &
SIMATIC PCS 7 BOX A FHT-LLF PC A%,

2.7 B IAFI R T MNIMERTT

ek | 2R AS %% Ei::3%)
SIMATIC | BH&EAS |Hk: SIMATIC PCS 7 BOX RTX 1/ 58, ES/OS 5% OS
PCS 7 BOX | [ PC ¥ # A CPU HAE
RTX (WIinAC RTX) WInAC RTX 2010 >(Hf#:% 2000 /> AS i X 4
(PO).
SIMATIC | B4 AS | SIMATIC PCS 7 AS SIMATIC PCS 7 BOX 1] 528l ES/OS 5k OS #1f.
PCS 7 BOX | iy PC ¥ °RTX WiInAC RTX 2010 37 ##45t % 2000 /> AS 3T fix %
AS im S7-300 Design/ | (PO).
SIMATIC PCS 7 S7-
mEC
AS 41x (&7 SIMATIC | SIMATIC PCS 7 BOX 1] SZ3i, ES/OS & OS #:1E.
S7-400 R Bk AS AT AS 41x 27,
AS 41xH (& T SIMATIC PCS 7 BOX n[ 528l ES/OS 1k OS #:1f.
SIMATIC S7-400H S5 | g5k AS HHASHR B T AS 41xH I,
(S7 F &gt m))
SIMATIC | ¥ PC ¥k T AS SIMATIC PCS 7 BOX a5zl ES/OS 1k OS #:1f.
PCS 7 BOX
PSR A
HR= ARG R, B2 STPCS 7 Hk.
o VFH[

o {EN4EH k1 SIMATIC PCS 7 BOX.
o HAHT SIMATIC BATCH [faar #2511 SIMATIC PCS 7 BOX

o VENEZELMNA Web %7 Web k%52 (Windows XP #:1/E &%) 1 SIMATIC
PCS 7 BOX

PC & 5#4L (v8.0)
W A2edE TN, 03/2012, ASE02779427-02

35



PCS 7 #2119 PC 411+
2.7 B IAFI R NI

HEwpl
HAGKRG], Jeh s AS. ES. OS Jf

TEERT SIMATIC PCS 7 BOX RTX 1E 158
BT o3 A 1O,

SIMATIC PCS 7 BOX RTX
24V DC

SIMATIC NET SoftPLC
WinLC RTX
! l =J

Ethernet Ethernet
on board on board

PROFIBUS DP

'DDUDDDDD E

] el
v e J

1=
—

!D] DP/PA Link
PROFIBUS PA

0w

"J.J.J.-IJ
VFATHIE
ARSI R G AV AT uE LA AT RER) T KA EIE R, IS W0 G R4t
PCS 7; VFa[iERIZHZSBR Y (Process Control System PCS 7; Licenses and configuration
limits). AL Internet L) “3i AR EF"(Technical Support) F# A SCRS .
HEER

o “IEFRIEMIMIVF AT RS (U 118)” ¥4y
o T (LFiEEHIZRS PCS 7; SIMATIC PCS 7 BOX) (Process Control System PCS

7; SIMATIC PCS 7 BOX)
e Hxx STPCS7

PC 415 (V8.0)
L2 T, 03/2012, ASE02779427-02

36



PCS 7 #Zt 119 PC 411F
2.8 1y PC JEHIRE S I %

2.8 Yila] PC W IfE R 5 R

2.8.1 T OS Web &7 T F2 1 1)

1T OS Web & A-#4T 21 1)
OS Web &4 s8] PCS 7 i3 Intranet/Internet %} [ 24kt FERE T H4E 61 A
OS Web #EAFELHE LN ANLAF:

e PCS 7 Web % #%
7 OS #1, PCS 7 Web Hz55 a4 4&—ANHAG PCS 7 Web k4525 ThREN OS %) i
PCS 7 Web R4 251 DhHERT LLIE“Web JIRZ52%7 5L “Web 2 Wik %787

e PCS 7 Web % J'iii
XU 3G L Intranet/Internet SB35 ] Web k4528 F24E T H $dt . PCS 7 Web
= P i) FHAVE“Web %5 7 5“Web 2 W% i 7

A REE SR U
DA R HEVF AT T PCS 7 Web & 7 i fil PCS 7 Web 121 = i [F1 i R4 1 -

® WinCCViewRT
ki PCS 7 Web & /75ii/PCS 7 Web 12 W& = iy — g 2244

® Microsoft Internet Explorer

PCS 7 L) HHAS
£ PCS7 1) i OS Web &A1, TTLLRR UL FALA:
o XIT OS Z I AFuh &A%
— R PCS 7 Web %441 PCS 7 Web 2% /it [ 4145

o XI7T 08 H LIRS
- RHI PCS 7 Web [IR55 %3 fil PCS 7 Web %) 3iii (I 425
— RH PCS 7 Web 2 Wilg 45231 PCS 7 Web 2 1% /i ff1 41 4
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2.8 11 PC B IIF e 7 %

EZEL

2.8.2

38

o Tt CGIFEFEHIRS PCS7; OS Web iEf}) (Process Control System PCS 7; Web
Option for OS)

1o 2895 i 5 REAT AR T

5 7l OS Web AT B VT FI4h, 0T Ll A PC R4 (JET OS Web i1
i ) fE PCS 7 T thHHT i p .

LS Yl o
PDA
[
i T2 i
< >

[ —1
— \
AT ESATAWN

WinCCViewerRT i FHAS )T

Bt

LA LV RIS, I HE PCS 7 1) w38 imiieds ds . £omllnds ds vl 2 E4E T 41 PC
uti b

e gl PC
® Web Jlzd5as L2 ol R4
Ly ) 0] At il 55 A% LA ERAEST T — bR (Zmaxil) .

i A
43 Web 5&ARE 3L (X Windows Server 2008 R2 #:/E& %)
T SRR T P I e R R i 5 i A 20 A5 30 Web 55 28 IR 45 2% 5.

o X A A A EERAR TR PR, B, ANT 2 XU, AR SR Bh ot AT A 2
MBS N BAT.
o MHINFER IR . Hlin TRt % Ei-SEHUM PDA.
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EZER

2.8 1y PC JLHIRE S I %

SEPLTR P AR  AE HLR R G 4k
JITE N R P YA T2 AR 80 R I RS #s L.
YEEZ R ERE R Y, Wt Windows CE. Windows 98,

HRERS IR, WS WAKTM GIREEEHIRS PCS7; OS Web ikft) (Process
Control System PCS 7; Web Option for OS).

AR ER, S ARZTM (WIinCC; Web JIE#:) (WinCC; Web
Navigator).

FHRIET LS MILR L) AEGE, ES IAHNE Microsoft SCRY .

2.8.3 i/ OpenPCS 7 i PCS 7 i

OpenPCS 7

7 HA4 OpenPCS 7 (1) PC 35 (fTil§fX) Open PCS 7 ¥%) L, f#ifi§ OLE DB i OPC nJ ¥
PCS 7 L] MEHRF UL =7 RG]

R LAAE L 252481 OpenPCS 7:

BRI 27

TR A P A
MES %54 (HiliE4hiT R0
ERP 254¢ (A3t IR

OpenPCS 7 #4174
OpenPCS 7 uli/& 2% 7 OPC fl OLE/DB fRk45#%1) PC.
OpenPCS 7 i if AT LA L5

il E T4 OPC 2 1 3R H sk id R ¥) PCS 7 Hidls .
BAVFE PN (OPC B OLE DB) jinl n] ¥ PCS 7 ¥

OpenPCS 7 il il & iy i 283645 PCS 7 T.)
A FER N, OpenPCS 7 ufiil it #fEvl (OS HR4S4%) 5 H ML R .
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2.8 vl PC B T %

NN |
TEBR T Bf OpenPCS 7 LA 4H & .

® ® ®
PC #%8 PC %8 OpenPCS 7 ¥
BEFiHRMAER BB ARR
OpenPCS 7 ¥/ Q |%| ﬂ
B AR | . == —
0OS EF i - i
Intranet/Internet Intranet/Internet
OpenPCS 7 ¥ (5 + Bk 3%
] 0S i) ] me
LR | : LR | LR
| | | | |
| Il oS B&E ! os msE Lol I os ms
1 —1 —1 1
( T4 ] ( T4 ] | T/ B4 )
| | | |
WY mzezs W gz zme: W mapezs
4n  |4HE N 4,
%
1 OpenPCS 7 3. OS %/ w17 /7 i N AR | T AES RS-
(OPC =, OLE/DB) fiT[H—&I= PC I HWH T NYRS
2 OpenPCS 7 i 5% F i v I F2 ¥ (OPC &, KHE M-S as ik R a5/ 2
OLE/DB) 735 FANFEI) PC L, W He M | TR RS
2% () Internet/Intranet) #3445 . BWHT KPR RSE

ST IS, OpenPCS 7 ulith n] 22444 OS %
J 1

3 | OpenPCS 7 3l 5% i 27 (OPC &Y
OLE/DB) 43l Tl He &% (&l
Internet/Intranet) &I PC I, wlyi4a
B KBS PCS 7 1) & i 26 .

R LIRSS Sk R 2
TS ARG
BT KPR S

OpenPCS 7 W] %44~ 41 PC 3l I
e OS L T{EuR%

e OS k%4

o RIS & (CAS)
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EOBR

EZER

2.9

2.9.1

g

2.9 FE PC 7%

% ) g N R Pl 1 3 11 Vs 5] OpenPCS 7 i F £t

OpenPCS 7 A I 414 - ks A BEA T B il 15 -

e OPC DA (Hdiii)

® OPC A&E (HUEHIFAF LK Py s 4R e RIfi )

e OPC HDA (JJj s ##i vjj 1))

e OLE/DB (S OLE 13 FIF 5[5 1 MS Office] 1) i 4 )

WEMKEE, TSEFN (IREEH RS PCS7; TRAEKRZL) (Process Control
System PCS 7; Engineering System).

o T (LFL#IZ% PCS7: OpenPCS 7)

o Tt CIFEHEHI RS PCS7; THAERS) (Process Control System PCS 7;
Engineering System)

o T GLFEHI R4 PCS 7, #:4Fu) (Process Control System PCS 7; Operator
Station)

HEH PC

KWMBEN L] BERES

FIFH PCS 7, AS. OS. BATCH. Bfa4&biA ES sl il 51 Tl LU (¥ 5 2k R G ik
AT o

PCS 7 14k R G0 4:

o LUk

o ) %k

AR 2 TAR RGHOR & B L) B2k It. A NURSGH, AL T /4 i
BRI B ARG
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2.9 ## PC 7
EZMHREE, AIS%H “LZ TR RGM A TR RG22 W ZES (T 15)” #H57.
HRANIRAG BRI, n]S2% “fE5 PC L4l & TR s FIER4E D1uG (7T 20)”
o
NN |
b
BATCH &F#l OS BEF#l i
ay +MS AL (A ) MES, 7+AM%

T O e
I 1 11 las

BAETLUAR
| TR & & 0S HE%%E' BEES% T/ | BATCH B
+MS B ( R s
ik
) UE) BNl B - DT,
- ., —

| | p:
1 - ]
: ( Izrgﬁzmutml | I] o 4§Zg
1
% W0
I, I, MRl RllLKl
TR SIMATIC LR LR
PCS 7 BOX AS 400 AS 400H
wmIh

i A EM L) R AT REAT IR 413
o {EHTMLEIKIM (10/100 Mbps #1 1 GB/s)
o GZM. WA, A, EMEOURIAGEH
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2.9 F# PC 7%
HiEfE
o i 2k
THRE/RPCS7 1) i dEmE s,
AT o L s Lok PCS 7 JEFR B E w4, B, MES 2017 A M4,
HAEERE PR A IR
HAFIE N TRRITRE AT LR 3 e
o HEIAIERS (OS Rks4e. OS /0
B
e BATCH i (BATCH Jii%-%%. BATCH %
FHL
o AP TR (MR HIIRS2e . BRAE
FEHIE B
45 2% 2 8] R A5 e OS %%
e BATCH R4 2:M15 BATCH #5511 OS
i &
JI 55 2% b BE RO R B st (& | e OS R%#RA1 OS & AL
WL BEAT A4 e BATCH AR45#:H1 BATCH %/ HL
o [RIRYEHIIR S5 B N AR R S HL
o ) %k
Pl PR A2 18]
HABHR 3K TR H E Eh ik R4
TLRE R AT HEML RS OS s a%. By hiliRgs o
W5 AR
CPU -> CP -> BUS -> W% i& it %% (CP) ->
OS/RCS
HE: 5 SIMATIC BATCH [fyil {5 i ik &
st A2 N OS 45 2L 4 3] BATCH IR 4528
KA.
Halb KL HIEE (SIMATIC i#15) Hahb &40
W5 AR
CPU -> CP -> BUS -> CP -> CPU
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2.9 ##% PC 7%

EZEL

o HRFAEBHIMGFEE, WSHHUEFM GIFEEHIRS PCS7; L) (Process

Control System PCS 7, Engineering Station):
— TR g 4LE

- PCS7 L) &t Iy g

- R TAEEHEA S5

® “PCS7 RGMIAAZS (W 11)” #
o TR/ T) B (W 52)” Hoy

292 ERDLm R/ L) B2k

OS. BATCH. #=#4IF1 ES KZE#

{fiF] PCS 7 MBI HC 3 4E Bish . BATCH mh. BRAR4a I T AEBGFN TRk 22 3 Tl LA

KMo BIRBRAE T T PC/PG i) — M ikl .

BEEER

TR EESRAL AN A PR TR R

A RIBINER L, 7T2% “HTERS& /T B LA (0 52)” #5r.
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2.9 % PC 3
AL
PC ¥
\ I PR
| Tl BAKR ] o ///'-_é;
i# ﬂ “l BELRE
CP 443-1
EH AS
i/ CP 443-1 i@ AL FEZR 5 CPU LK IMFE 1, K H i RGEFLR T LUKK . Al
HEEMAE TCP/IP. 1SO il UDP,
FEL A Y 2 40
AR FHEERIER, TSEAETH IR R% PCS7; LF2INELY (Process Control
System PCS 7, Engineering Station):
o LRI 4% 414
e PCS7 ARG & At [alfEE e
TIRBERG
AILAE PCS 7 TR E R, AHGE R, WIS HIgeF N (PCS 7; i Bl
R4 (PCS 7; Fault-Tolerant Process Control Systems).
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2.9 ## PC 7%

293 T Togk LAN %8 PC uf

T TR LAN (IWLAN, Industrial Wireless LAN) ## PC vk
TAVTEE LAN CFICRR ) WLAND & aT LUERE PCS 7 1) whifde N sk i 5 ok [
€ PC ul, WAERLLT PC
o OS &7
% 24~ 0S & Gk WLAN &8
o Web &%k
%% 2 4~ PCS 7 Web R55#s L1 Web % /5 GEid WLAN iE#%)
e PC i
B, R, H Tl NetMeeting BYze Fe 52 THZE FE U i) TR JHuk i 54~ PC 3l

PCS 7 1 T WLAN F4 4

(PCS 7 - C.kAifER) (PCS 7 - Released Modules) SR H T CMEFH T PCS 7
WLAN [ &8 4014 F1 PC 411F,

2 PCST 2 JE, nIE “FFHi(Start) LY SIEMENS SIMATIC SCRYSCJerh#k3) (PCS
7 - CRAE) (PCS 7 - Released Modules) SCHY .
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2.9 F# PC 7%
PCS 7 4 WLAN [#j7~45)
FEE/RT PCS7 I.) " WLAN A FHREAH A
T2 R TR ik 0S BFHLE
Web & #l
| |
— \p—
= =
7
[@l 18] &
(WLAN) BATCH &/ #1
TR OS/BREBHIZEFH
v R Rk B
L | | | L3 B 4% Tll BAA N
| ] OSBEEEEHES | —'l || 7T% BATCH R%

[ T RET AR ]:://_'//-é

BFEFR
1k WLAN Z1F . 2ehedifm LU BRI PRS2 LR SO

o FIMERE GIRFERIRS PCS7; PCS7-CAABE) (Process Control System PCS
7, PCS 7 - Released Modules)

e SIMATIC NET %:Aiiff] WLAN ZIAFRIERAE BT G2 W™ s R G REs il R 4t
PCS 7; PCS7- C.kAiBHL) (Process Control System PCS 7: PCS 7 - Released
Modules))

o AZTM (SIMATIC NET; il - Tk ok LANY (SIMATIC NET, Basics - Industrial
Wireless LAN)
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2.9 1F# PC 7%

294 NNEIEPZ

ARG F ) 1] [ 2

N ARICAT AP Al 1) i FEKcdfs
SRR B IR TR I A AU 0 BE R e BRI, S5 RO — 80, S AL B T AE )

X TR

RERRPE AR GE B AT LA A1 i 2 LI IR 8 H [R5 b A

DAZBUE FH— AN R AAE A B e A i sl DU BT e R i R Ge 2 A 34 A8 1)
N TN ESER PCS 7 A A-RR I TR B . AT LR an g 1) 4k SICLOCK
i OS k4% 24X L 20 fH2H A& Jy I R) ik

i T) 3 33 4 SR I )5
S

[R5 1T

A BIEERAT RIS S PCS 7 4144, #iltn, $RAEu Rl A 2k &

RG] TR TR EE ) PCS 7 41T

Route Control %}

i Ek7
A A PCS 7 Wl
Uedriti I T T LR g s
o Aifiisk
o T M
BATCH uf R Bem A OS i, ALt PCS 7 #H4T1HID .

A BL R IREREAT R, il .

Bl DCF77 % F it AT [R5
T A Ay i o 2 D B T 3l fg ek o) B R A T[] 2D

SIMATIC PCS 7 BOX

WEHAT PCS 7 AIBIAA . Al nﬁﬁ/ﬂm?mn Ui (UL 34)

CHRAE B AS)
AS o WL RAHHTIE

9, o {2k b I T R A AT 2

o i 23 o IESEHERAE PC Ht, S 1Ry 2 LA 1) LA Y

%,
It ) 385 ] DAAS R 0% 3o LUK 90 199 28 4 326 B T 435 5 PR ] 12
% (i PC)H .
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2.9 ## PC 3
EZER
R FEL G R, 162 TN G REEHI RS PCS 7; WE[FEZ) (Process Control
System PCS 7; Time Synchronization) .
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PC A4

3.1

PCS 7 FITHAZA PC RS (F=mfl)

FF LM%k (ES, Engineering Stations) f1#{Eu5 (OS, Operator Stations) [ PC £

RN AL

P 4% e

LA EEAMA 2Rk PC 4 T LREf%; (ES, Engineering Stations)
FIEEMERS (OS, Operator Stations).

PC Zifftu /& PCS 7 MTIZZA PC R4, CAMX L1 I N HSURIEAT T4k
FE91] ST PCS 7 H IR HR “HIZARL” Fal k2t PCS 7 741 PC R4¢,

0K SIMATIC PCS 7 BOX PC JTI-T- PCS 7 WM& b i) /N R Gk 2H & 1) AS/OS 3
FHEZMKGE, ESLTM QIR FRS PCS 7; SIMATIC PCS 7 BOX) (Process
Control System PCS 7; SIMATIC PCS 7 BOX).

R EDR L e SRR PC M PCS 7, WIHE “ILAMEMRAAS (W 52)” Pk BIAMIOAE 1 2

WP IEN PCS 7 Wit de:
o [EHFRAENEINAS: B/ NarPEE 1280 x 1024
o iAo HER 1680 x 1050

AR 73 HE al LA PCS 7 BAFIR R RE, Bt B b A AR T2k A
THER, BARA A G KSR o

firfi PCS 7 7= it B34 %) Windows TAEAL M2 2
W R AE Windows I ELFETRZLASH) PC R 48, WAAUERE PCS 7 2 he e e BB B0l % 4
B

ARZEBENENGEE, HS W 23 PCS 7 N HEEF I (I 82)” .
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3.3 M FHEHA G/ L) H LN AT

EZER
e H3X STPCS7
e [I5t STPCS 7.1 (SIMATIC PCS 7 1)

3.2 HAREIATS

B SCHF A AR B

A KRB PCS 7 BihiiA—l R AT SRS S, W53 SIMATIC PCS 7 DVD Hr (1) 30 FY
(A FEEEh R4 PCS 7; PCS 7 HiRkXXAF) (Process Control System PCS 7;: PCS 7
Readme) .

EEZER
o H3t STPCS7
e [t STPCS 7.1 (SIMATIC PCS 7 [#iH)

3.3 T4 T nekmas

OS. BATCH. Route Control 1 ES Hi&#:
AL SR A (R R BGEAE AR AR KLU PC a3 Tk UK -
o iRfFuk
o BATCH i
¢ Route Control i
o IR

W 2GRS ] PC s e (PG) HH AN ARHE ZESRAEHIAN[R] R 9 243 Bl 4% o

PC 44+
W5y PC AR, MG R, "SI0 PCS 7 FHit X 1.
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3.3 J FE#E b T mZENIA 1

LS B RER

FH 3% R & i S 2 -

o FRMEEfGEIER (f4n, Intel® Gigabit CT Desktop Adapter)
o PC i 3| £ 3y M 2 1 TUAREHAR A

- FHATIUR MY
- RIBEE

AL it SOR R BB AR PR A5G F T S B 2 e 2 (AR S

WEZMHFEE, WZLTH GIFEH RS PCS 7, &I R4:) (Process Control
System PCS 7; Fault-tolerant Process Control Systems).

B L) R

o WA PC AP ARMEB S BEIIER T BE&M Y iR% 8 MBI (AZMLRS
oS As) RO AE %

o fE NAHLL I ity S AR AL B &5 10T A B Bk

PRI T M
AN SRR O % 64 AN Ikt
- B AL RS

— EERIURF ) B
FANRE R % 64 MRGIKEE (BFEIUE RS

HEZMHKAEE, "S% T GIREHIRS PCS7; AR HIRE) (Process Control
System PCS 7, Fault-tolerant Process Control Systems).

BEBA B RS (S7T-400H/FH)

L Ej S7-400H/FH HATIUARMAS, HFEAHT CP 16x3 {5 AL BLAF FIZRAFVF AT H) S7-
REDCONNECT #ff.

BWESE- Ay

QRAE T Rk AR B kO, I F5 206 DL N B o [ ()l {5 AR #E 88 H T SIMATIC 3
CP 443-1 EX xx ([F/FMA T b4 V2.5.5; EX xx Fs: EX 10 &L )

IXZNFEP
BRI SHRE ] HYERIME B, W30 PCS 7 [ X 1.
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I 1R [R] 25

CP 1623 1 CP 1613 SZfF TME LRI (PR IR _ERIEE] [R5, fidfs CP 1623 /CP
1613 1] PC 1] M\ LL R ) 2 32 28 B i bk 1) o «

e [iify CP 443-1 [f) SIMATIC S7-400/H/FH

o T TOEAKKME SIMATIC NET I jH] A ik 2%
CEZMRAE R, WEL IKPIH>

e SIMATIC SICLOCK
e fiify CP 1623 &l CP 1613 [} PC

T A BRI MR IR AL
WIRAE T gk A6 CP 1623 i CP 1613 {7 NetPro M4l A& i 4, ¥ %
BCE ¥ rJilt.

S,

i i AT R IAT S5 (UL 41)

3.4 A 3 A AR A

B
VAT R AL
WUTE ST PCS 7 HakH kB PCS 7 JFHLHEME AT AR #1411«

TR R R RGN RO A LI Tl BN AL (R bt (o, P 8 e R RO b
#HE) .
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3.4 HIENIBEFAF
iR
1 ]
BReRERS (4P TR S R R PC . P BUSEBUR ] P AR A
B R
FTEIML K47 BB AT BN T RE 4T ENALERAT AT ERH LA 4T BV B 214
BAE R G AL FFATEINL
B AL ] Ev‘%@%ﬁ%ﬂeh?ﬁ BB A S kIS . fE WIinCC %
Wy CmEEE TR T, WX EAME T RIES IR R . WA
IR A 1” o DRSBTS S BIH AR AR 5 Ak 4
155 BRI AT A5 5B B SR A AT B T
OB ERE TAE S MR EAME S RIS L AR R il
IR RSN KRSV E o H = Sk SEREY sEs o8
W HAT A DR, S S BIAE AT BEAT A RS PR AR
=S A CLHARAE S kY e OS FLTARu RGN OS % /i, i[5 A
Yo, WTLMERGIEMBE (. RS RIBIBOCHE (Flhn
“wav” ) .
TCEk v I A TR PC 5T R4k,
AR ZERAER | IR, wAEER X AT A B2 4 PC #AE G (BHF™ 5D
TG FREAE 750 m LA 1 X8l 2 XA#AT L.
Multi-VGA ¥ FEIAE AT sl 2 7 3 () PC 222 multi-VGA ETE <
o RN E
o HEfEuG% ik SIMATIC Route Control %)/ i
XFEAIE—& PC (HER i il TR FiEEE2IL 4 & e .
EPROM Zgfaik | IXFEA %) SIMATIC 174 <1 EPROM #EH g 174 e o
%
USB %24
TURMLEIELEE | IXFF ] LUK PC SRR TUAR 20 i 2k
BEZER
o Hx STPCS7
o “PCS 7 KIS INBL & MIKBHFE 5 5 (BT 107)” #5
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3.5 JAFILT I

35 HAAFITIY

AR

TER

R SRR TT 5

56

Interactive Catalog CAO01,; Automation and Drives Engineering DVD E424t4 1] 4 PC ¥
28 K AR SRR I A S G AR A5 2T

A RENAN PC AR LB ER, WE% GIRREHIRS% PCS7; STPCS
7 H3%) (Process Control System PCS 7: ST PCS 7 Catalog). Pt it 40 &t % 44 T
J T R A B S A . 1% H SRR T AR YT &

KT PC ARG (il RAID R0 1) H SRR S, 055 0T5t 2w 1R AR 7 24k
(K155 P41 1 ARBI R .

H7E Internet (http://www.siemens.com/automation/partner) _$% #| Siemens B R 7.
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%35 PC 3 4

4.1 ZETFEWIA

faifi

REWE

NS PREIR T PCS 7 23k PC uliffIEA IR,

T TTATHRET PC MRS TR, AT LRI, IR )
L R

1t PCS 7 AR P AT 223801, # bR “ 223" (Security Controller) % 15 HE,  JHx
THAE 7R PCST efE e v PC uli FASUH I R WA

WEZARGEE, WS W “23 PCS 7 B ST (T 82)” #i4r.

RSN LR

AHEIE A AU 2 AT 55 AT I o

Lz

WA

LEBRIERSR

1

TRARERSE (T 69)

LR R GRS (WL 78)

BEEHIRAFAE SIS IOALE (T 78)

BAT ARG E (W 79)

LM B BAIIAR S5 (T 72)

22 (Ut 80)

N R SR DR e 55 4 2 2 I 55 4 D e (L 74)

%3¢ SIMATIC BATCH [#JFf k25 (5L 81)

O |0 NoO| o || W|DN

WE B 7 R AR (T 80)

N
o

Iy (UL 81)
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ZH PC 7

4.2 I {F4] Fitd
7 N
11 2% PCS 7 A4 (1L 86)
12 g LR R 25 4% (StoragePlus) (7T 89)
13 FITCAR RS 2 HARTUA (UL 91)
14 i PCS 7 OS Web 15012255 PC (T 92)
15 WoE PC iR 5 kB (0L 98)
16 LR I INTE A B AT PCS 7 (145 € % E (7L 102)
17 VFR FI4ZHL PCS 7 #A: (7 113)
18 #E4 PC uli - #ti& (1T 128)
19 Bl (00 81)
4.2 TAEZH AR,
THEHES
AT LLE PR/ TAR A B3R i iz 4T PCS 7 T (K H L.
FERA T XIS RIS S ONBARA LR PUACE AN IHE TAE 4L Fisl b (1) 2451
O S5
YiLBg
AR BAE A THE SRR P AL, BN T NLER S E NI  BREAR RIS, BN
FELH b UE (T, T @R IT. Microsoft VAT, %, TAEE R4EyEs) .
B, (AD; WE3IHF) T4 (WG)
WHER (5 H 5 B A AW ATEZH R E.
Microsoft | rp e A Yt e 22 A ik e
Windows HI0) o e e % (T | BT L) B L A
) MR PC s
7E AD A BRVE A AN SCAE AR o | &S PC sl By B 4 S
AR o
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DHCP fR4-%%

4.2 T 1E] Fitd

3 (AD; ¥EFIH)

TAEH (WG)

EDAL IR

£ AD AR B

EREAS PC b 7 B 2

Ml

k- ps/bIp

PR 4 SR

PC i ()4 TAEAAME PC SR B AD. 5 | DS g B Al kit (41 DHCP
L Windows lx 5528 A7 il s | ids4s) B, 4 7% Window ik
2fE R %%

B EI LA AT AR (Gafg | B H R AGAE TAEA M2 PC
ZHRTD . iR S W IKESLIN

5 SIMATIC ffFF % AD BB . AI7ET g PC sl A ELR

Logon &4 H]

EE

£ PCS 7,
P Mk

SACVERLAETH B DhRE(EH] DHCP JIwdsas.  Prfi PC uh#R L Ziife s i il O

DNS/WINS fi 433

WS

PC A1 54%L (V8.0)

VLI AL FR AT A D 5 24 H) DNS/WINS fik 554 -

ik WD)

I (AD; ¥EZIEZ)

TAE4 (WG)

IR T A

75 AD &R RIESETHI T

WIALEREAS PC Sl s g

B SLEIETAT PC i Bl ]

WAHEREA PC 35 LA S 1.

S .

£ AD AR AR BT

WIAEREAS PC ulh BT Ui .

AN B v L

FE AR LA PR 2 SR 8 Bl 1
HBE

WAHE PC o X E AT A i
.ﬂiﬂ_::& o

Bz i E

75 AD PRI SRE, RRIE
M REAT 23 o

WITHEA M T A BEE

431 Microsoft
.

@it Microsoft Windows Software Update Service (WSUS) 43t 5

e
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4.2 T {E4] Fitd

sl

TAEA B

S

60

HE G . (AD; ¥EIHZ TAHE4H (WG)

AINBES (FndT | ik AD B AT A . NEIRB A

EIBL. A& ELET 4 ARG R B NI R

(PO DU BE R S B A A | MR 1 P A A A
Ho It PC 3l EAH g, HaAZ0m it

AHT R RS

AHPERE A | TR R A P E S, | PR PC 3 BRI A
HSAL SCRFAE A S IN E F )p7 | GRS

1 PC 3.
SRR AL SO, WA
PP O AR S

FIRINZIFBA Xy N AL A A AT R LR e O AR SC I PCS 7 1) i
E‘:go

FIAESRE R R SEILER T UREE T T . B, Tk AniR, 2288 OB e T AR &
T BT T o

FETARA S, & EAEAMI HNL EIAT M weE . EE, Wk PCS 7 L) [ & 1
BEEIEAT, i B A AT DR, MK R A E IR ARSI, A
LA AR BRI, AN ZE AR N S4TSR I

BLHA

BEZHKRER, EZSNW “ (PCST7 %aMid; @il 4im) (PCS 7 Security Concept;
Recommendations and Notes) (http://support.automation.siemens.com/\WW/view/en/
26462131)” F.

PCS 7 P\ PC 8% %) Windows TAEAIHTAIA . WHRAE Windows 18 {4
AT PC 248, WAAUHN PCS 7 22 he b Fp SRS % 2 W E

PC HAS5#AL (V8.0)
A3 T, 03/2012, ASE02779427-02
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%5 PC 3

4.3

4.3.1

faifr

BIERA

2R

4.3 ZRIRIERT

CRBIERS

ZRBERAENERFH

ST EATAN G I S A% N B34 T s e e R gy US4 LRI
R AT IR DT AT B E A R

K% PCS 7 AF PC b IM#EAE RE N5 S, 1EZS L Process Control System;
SIMATIC PCS 7DVD L-f] PCS 7 Hik 30,
TR T W T PCS 7 [3E RS0 B S LRI

HRFAMGEE, B ICR GIFEHI RS PCS 7, Y iEFAARRE) (Process Control
System PCS 7; Licenses and configuration limits) .

® PC LU W BT B 4 o
o MAERIEAERIUL 32 ArfGLIE 64 fifi, LK PC 35 id i % fE R 4.
o MEHRIERGIETIEG LA PC LIEKAE.
o ARG MmEW. B
FERR BT XXKKK-XXXKX-XXXXK-XXXKXK-XXXXX
AIAE LA 7 B it B
— LR B T
- AEZIEIRAE AR AR
o ifR CABREALS KW FHLIZAR CT) il PC 354450 o
o &{} PC i3I, DL AL

o PR T T A B T
N 2 i SETUP DVD #E(7 223,

PC 417 548 (V8.0)
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FE M 2% AR R

BT R B

62

AAEMZE T PCS 7 () PC ufi. TFER IR JLAi:

TiEH

AHLZ s PC uli, 8of PC b 288 TAEAIH . Al D Bk Tt G0 20 i g sl sk B, B
1 FHAG 2%

W4E PCS 7 LA PC sl H T B (i, DHCP 2 DNS li%#%) -

e OS JR%#%

e BATCH iR 4%

® Route Control JIk45 %%

WRIEAARS 2% (OS 45 #%. BATCH fiR45#%. Route Control iR45#%) b FHA/F X EEARSS
IR SS %5, W PCS 7 HhREn Re 2K PC % YR Ik 2811 52 2 52

UEAE PC i L2 SO S PCS 7 BefF e 3 FIBSSH T bR ) PC 3
(OS. SIMATIC BATCH. SIMATIC Route Control) , F&anit.

SR R 2 1 TN TT RO R AR 2 PCS 7 RA M= A A R
BRI 7 R AT AR A AT, A R A5 = 07 . A 2%

PCS 7 i 48X 5™ il . PCS 7 FIXLEEE = Jy /™ il ANfg Rl N84T

TE R LU AT RO A 10— A e

TETE R LA o

o I PC ¥l LAk wd: PCS 7 MIRIERSE, THER %% PCo X EH IR E RS

o PuUTHrce ik G M. HRER, WS W PCS 7 L 5%, PCS
7 H&XF”

o HWVFVE (BRI W IERE)

o HURE I RAFA W I H A S (i, DRAFBIBUE D o HEZAER, WEH
FW (LFEFEHFL PCS 7: [R5 LHFRIZHT) -

o HURTAHEMER . HEMER, WSE TN QIR RS PCS 7 B EH)
(Process Control System PCS 7; Software Update) .

o Gt HEAT AT SR B s 1 K

o AL B I BB 2 X o

PC HAS5#AL (V8.0)
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BIERGIES

WA PCS 7

4.3 ZRIRIERT

FCR ) HAT R AE = A X 45 15 & (1) Windows MUI (Multilingual User Interface, %
WS B RS

o {#iF
o Yiif
o kif
o RO
o MYLFIE
o X

1 PCS 7 I, ZI7E Windows 5 5 & i RN B B8 I i (M8 5 M. X5
M “ X I AITE 5 177" (Regional and Language Options) FH 1) il A v F & & .

WHRAEH PCS 7 SWMARA, 1E4E Windows DX sk AITE 5 b AT DU R 38 :
o 7t “dE Unicode F2/7 1115 5 M4 (Language version of the non-Unicode programs) 1,
EFE “Hpsc (FED "(Chinese (PRC))

o UMUK PCS 7 I FHHINE 5 W E A 9eih, WAL “Se s g AE s Al H K7 57
(Language used in menus and dialogs) k% “3EiE(English).

o WL PCS 7 FH P S iiE 5 BB 30, WIFE “ S SR il HE Al T ) 5
(Language used in menus and dialogs) Fi% % “#iE”(English) o{ “r 3¢ (fajfk)
(Chinese (simplified)).

o 7E” krifERIE% " (Standards and formats) #, EFE “H 3 (FH[E)D "(Chinese (PRC)).

TR N SRR LR HE PP 48 D (115 57 (Language used in menus and dialogs), WA

DU FRFERAA S BB . D UL 3“4t ” , SR7E “Bor > WoRjErk >

4 A" (Display > Display Properties > Appearance) Fi£#:“Windows £ #”(Windows

Classic) #£3.

L
PCS 7 (N FHEE RGBT M TS (REET) » PlanseX0mm Ak 0eE .

4 PC #3535 —A“SIMATIC PCS 7 Vx.x Asia”USB H 7 fik#:/E OS i,

PC & 5#4L (v8.0)
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4.3 ZRIBIERH

PC A
PCS 7 1™ it PC Bt 2 15 S #A1E R 4.
BB S AT RSB S, TP asEE. EE. SRMEMIEHLL .
WAR AT %% PC, NAEEFEERIE R GG 5 INEAE LT B
o W PC I AT —FE T, TEIEFRAASAI T B RGOE S .

o WA HE PC EAEMZRHES, WEFZIEFRIERSE GRANEATE) , R«
ez A,

Internet Explorer 5 )% 9 M )

HLAEBLUT, 7R3 3) Internet Explorer 2547 —/MF 1M L. Internet Explorer x.y 2
W E R E R ET. 2R3 Internet W ¥4 http://go.microsoft.com/fwlink/?Linkld=74005
DL Internet Explorer.

AT 4 & Microsoft Internet Explorer [IEEAR . 41X 16474, Microsoft £t Internet I
()t 7 "KB945385" | fit T iR vk ik

4.3.2 R X

R T E o

AR PCS 7 7= i (T4 PC, i AN R, iEF PC 4%
IR ESR I X LUME e &

o JHTHAERGM PCS 7 %%%: %/>100 GB, Wl
o HT PCS7IiH%#: %/ 100 GB, W LIEFEJLAN X

o JHTRM: KeIUH ARG AN BIAZ A a1y PC sl ik s e mn i o, 4
4 DVD 5145

W RAE - S TR AS PC, WISy gl SRR @ 1143 X

PC HA&AS#AL (V8.0)
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4.3 TR
7~
PC ufivb IG5 7~ 1 «
# K/ (GB) | WBhEE AR - Sawie T &
7%
C: 100 SYSTEM NTFS BAE RS LA PCS 7 %2
£
D: X DATA NTFS PCS 7 i H £k
CEPIESS
25 (0]
= 34
.7 IRE) A RN SCHFAESE I E R B o R A SO AN e HFRAT il A e I TR
by NP E AT AR R “C:” B D
100 BACKUP NTFS T PC ¥ i & S
BFF Jees A A X ) 8 PC 3 1 £t S
AN AR
EEZER

A RBACEEARE OB E R, WS W (RS PCS 7; PCS 7 Ak 30
(Process Control System PCS 7; PCS 7 Readme).

433 PC Wil &R

PC ¥WHI& K
VENLAFRER I H SR T 2.

PRI A FR PV LA AR, XA TR B RES 4R (It PC B AEHEA RGEh A IO A
H

JN 0

PC & 5#4L (v8.0)
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o FEAHAFRLILLK S PRI k.
o MR A REL & T REAE T,
o IFENATEL A 16 MFERF CREBERGMRED .
L]
THER, 41725 OS 5 BATCH ik 554% AL TREN I, LUK 44 FRab 20 58 4 A )

o IHEMLAFE
* PC g4

HemiaE
ARIH ML E LA E, HS:
o Fit (SIMATIC; WFEEHIARS PCS7; LRAUERSF) (SIMATIC, Process Control
System PCS 7; Engineering System); “PH 1y )7 5545
o (L&) WinCC 7.8 74 “AeIiH > % > Tk 77" (Working with projects >
Appendix > Invalid characters)
o 1t Projects.pdf. AT SIEMENS SIMATIC 77 5 223 S e
BEEOtEL AR

54 PCS 7 JE Gk LS SR (LU SR SERLA Bt R R A S, ISR 2
% (P4 DVD)

TER LT LA
o WIREF Y PC AMFOIHHEHLARK, IME DVD Hr %4,
o WIREH A DN PC ITHHNLAFK, I H0Br %% Windows .

1E23 PCS 7 AT Bt HE ALK
AIAE “ PR (Control Panel) H B Btk SEALAA PR

PC HA&AS5#AL (V8.0)
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ZH PC

434

faifr

EEVCRI U B

] 2%

PC MIZ&E

4.3 ZRIRIFRT

PC &% 2w E

SMRTIAE PR T H 3 S B I R R T B 45 58—/ . A 7 8B 3] A
T g 2y fa k. ik, (5 ARG MM L 2248 T BRE i FEf ) R 40 1) 5
Rl . MER T A= A2 XSS AR AR 305 SR EBURH S it e SR 97 1 HH R I3 1 JXU S 42 D i 2
RN PCS 7 PC w2 PC Mg, WIFF 24 %9255 Microsoft Windows 4% 1]
SR

T CLAERSHIAR S PCS 75 @b PCS 75 @ANER I (Process Control
System PCS 7; Security Concept PCS 7; Recommendations and Notes) 11y B 511
RIS PC 2%

o LTRSS THENUAI A BLLL L PCS 7 rh P M7 T SRR A8 BEREA T A
o BRI A K PCS 7 M2 AR Windows 5 B AR 48 P K H 245 KL
o Ny THRIAE PCS 7 L) rR A WREEZE TSR] I J- I a] [] 20 .
o Wn LI CWITAE PCS 7 L) 1¥) PC uli Z [A] LB M 7 BRI 22 i A5 e A2
R
BLEA
AT MHT L5 PCS 7 BC AR AR RAE R S8, IFHBOE TR Tl W i BRI Le e
R

&F

NFGE IR % L a8 N SRR S PCS 7 1) MM, LU E A AT i g 52 m 3|
PCS7 L) (Hlan, witIpAML) .

4 PCS 7 B, e PC LRI At e A i B

MAEHH A PCS 7 L) I, AN 1 2 A EAA R — . AN A B O
R ERATIM

PC & 5#4L (v8.0)
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4.3 ZRIRIERH

TR P A B
FITELUG e 2T T PCS 7 5 3 4R R 7 AT

EE

ER, AR ERER A ) PC, D VAR e o N 34T 203

SR REITE R B (5T 61)” #%
o HRTARBWELEL, WHSWLLFHS:
S APHEIMET . BRI, RS (7 139)”
o HOBHIHRFREROEL L, T5%.
— WIEE (70 149) 55
— SR ATEEAMET . B, RS (3 139)7 #55

o B (A EMES PCS 7 Ml WInCC - SEASIRY) (Security concept PCS 7 and WinCC
- Basic Document)

o Uff PCS 7 F1ib X

o
=
N
1>

PC HAS#AL (V8.0)
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43.5

ZRRIERSA

4.3 ZRIRIFRT

BAE RGN BCE R I ICABE W e N IRIA T i SEEAT T (0 B A A R

o T4
WS AR (4 tiits PCS 7 F1 WIinCC) (Security Concept PCS 7 and WinCC)

PC & 5#4L (v8.0)

HRHE

HSCRY AT M Internet %5 S S 3 (http://www.siemens.com/automation/

service&support) web T N4k
— AR B DY AP A

- HEHICLMEN, WAL AWM. BT ARG E I BE DRI T L

i I AL B R R B 8%/ 43 X

WEZMKAELE, WESN A 1X (71 64)” .

WP, AT RERS L5 7y XM R, SR 5 B BT 731X
Windows 7 JEALAR Windows XP

Windows Server 2008 Windows Server 2003
Windows Server 2008 R2 Windows Server 2003 R2

LR s T 71X

“HARK Windows 2RI 4L ? "(Where
do you want to install Windows?) X} 1ifAE
>“IRF) AL (PE) "(Drive options
(extended))

WA 22 F M, 03/2012, ASE02779427-02
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ZH PC 7

4.3 ZRIRIER T

70

THHHLARK

HEMRMELE, W20 “PC uhi)4FK (7 65)” .

B (F

ORI B ECE I VFRTUE . R G MR S5 a Al 2RSS 4R VP T Ik LK R G e 2O 1Y

P mVF AT AR (CAL).

PCS 7 &5 a5 AN i VAT ik (CAL).
— Windows Server 2008 1 Windows Server 2008 R2 )% F ¥ i I iE (CAL)

BAE R G RN EIE % CAL.

- ¥ & Windows Server 2003 1 Windows Server 2003 R2 )% F 3 ¥ AJ i (CAL)

T HR R AR

W

¥ & Windows Server 2003 F1 Windows Server 2003 R2 3R,

AR BOA B E Y RIS

R A IR S5 AL — 5, B ke I

o

G, WV RE “ A ik

# s H P (per device or per user) HLEF A, IXAMEBLT X 5 ML LAE

2 Bk .

BERLER RN ES AN

Windows 7 JEALR
Windows Server 2008
Windows Server 2008 R2

Windows XP
Windows Server 2003
Windows Server 2003 R2

1.
2.

{171 “4Z#I " (Control Panel).

75 “IEP . 5 T X 8L 1 (Clock,
Language, and Regional Options) [X 1
HhiEFE TR TE 57 (Change display
language) . HGFTIF « DRIBRIE 5
1ii”(Regional and Language Options) %
ThHE .

A TIF “BESAIE 57 (Keyboards and

Languages) LT F

R i MERTE S . (Install/remove

languages...).

IEFRIET W B S E R 2% (Browse

computer or network).

AR 2R RE P U WA T 2

7. A5 PC,

1.

A2 E 7 A AL CD 22 he iy
J¥o

TG 2B e U AT 22
7E“Windows %15 H ) LT 4"
(Windows Multilingual User Interface
Pack) XJTEHE, 1B AT 7R IR 1R AE
PR S TEREZMiES) « &
PEERE T . 1k “ULECE Unicode«- -+
it 5" A “ULECERIA shell FEfp----- i
SIEAE .

T 2R P BT 223

FHi sl PC.

PC HA&AS5#AL (V8.0)
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4.3 ZRIRIFRT

FEZH Windows Z3EH M ARG #THRE

FITIEVE SO
Windows 7 FEARLAR Windows XP
Windows Server 2008 Windows Server 2003

Windows Server 2008 R2

Windows Server 2003 R2

1. $T7F “#&HI A" (Control Panel).

2. AE “mFBh. S XL (Clock,
Language, and Regional Options) [X 1,
thik e “ R TR 57 (Change display
language) i .

3. I “HEALANE 5" (Keyboards and
Languages) i1+,

4, MR BB FA, Wl “BRiEs”
(Display language) X3k FE 2| “iEFER
5 "(Choose a display language) i
EU%O

5. WA R BIHRiES .

6. =HiE3) PC.

1. 4TFF “FHIER > RIBFITE S %"
(Control Panel > Regional Language
Options).

BT “IXANE 5 15" (Regional and
Language Options) X if4E .

2. $TJF “IX4iET"(Regional Options) i1
=, IR AR RGEEAT RCR .

3. P “HERLFNE T (Keyboards and
Languages) 1~ 1247 R Ger [
o

4. 7T “Ege’(Advanced) I+, FE4ExT
ARG AT RE

5. =¥ PC.

=908
BEFAR
¢ Windows XP

7E “PE AR (Control Panel) Fri L Makmi:  “#AF > s/ Windows 211
(Software > Add/Remove Windows Components) >“[f{{4: 1 T. H.”(Accessories and
Utilities) 15 >“£ 4115 5.”(Details) 1241 > 2511 “Jik”(Games) i

e Windows 7 JEALAR

fE “FEHili AR (Control Panel) FRIE LA NIET:  “FEFFILIfE > 97T 85¢H] Windows

Iifig”(Programs and Features > Turn Windows features on or off) > 28] “Jifak”

(Games) 7

2H “ B3I R4k H"(Automatic System Restore)

XA sl a A A s RS R

PC & 5#4L (v8.0)
W A2edE T, 03/2012, ASE02779427-02
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EZEL

Windows XP
7E “PEHI AR (Control Panel) [ “& 4 > R4k 5 (System > System restore) Fik
B CORPITAT IR 23 1 R G (Turn off System Restore on all drives) % .

Windows 7
7E “¥HIH (Control Panel) HHik#% “ R4 > R {EY(System > System Protection)

U 2R SSRGS (BT 72)” EoY
“U] kIR 45 #4412 Microsoft Internet 15 BUIRSS (11S) (WL 74)” #B5»

4.36 el 2257 BB RS

fej
PCS 7 %] Microsoft  RUAFIRSS . BLAMF ARG 7> . {5 Windows Frif %
TP IEAEE MS T S AF, IR 200 Al 75 B b 22 e
AT 222 I 75 B AT A R SE ) %22 CD.
Bk
o &I ST K.
Windows 7 I
1. E “FHIHC (Control Panel) kLA Fkmi:  “#HIER > B I)EE"(Control Panel
> Programs and Features).
2. fEAMZERL P “FT T 5E ] Windows T fig”(Turn Windows features on or off).  #447
JF “FTIF % 4] Windows Zhfig”(Turn Windows features on or off) % iHHE .
3. %411 “Microsoft Message Queue (MSMQ) k45 #3”(Microsoft Message Queue (MSMQ)
Server),
4. VG LA kT
“Microsoft Message Queue (MSMQ) 45 #3140 (Microsoft Message Queue (MSMQ)
Server Core),
- a4t
5. i “ffie”(OK) HEATHA
PC HA&AS#AL (V8.0)
72 BAF 2T, 03/2012, ASE02779427-02
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4.3 ZRIRIF AT

Windows Server 2008/Windows Server 2008 R2 1 [ ;5 5

1.

75 “PiillHAR"(Control Panel) LU FIETH:  “EHHETH > RS- BE I (Administrative
Tools > Server Manager).
BFIF “ RSS2 E 17 5 (Server Configuration Wizard).

ity “1)ge"(Features).

3. P AT “USINTIAE"(Add Feature).

Wh W S F1)" (Message Queuing) #E3, AL “W B BAFI IR %" (Message
Queuing Services) H1 “Ji E BT Ik 55 #5“(Message Queuing Server) i

Windows XP = )20 B

1.
2.

76 “PHIHERC (Control Panel) FRIEFRLL NI :  “H#4"(Software).

A SE SR BT 5 I/ Windows 4144 (Add/Remove Windows Components).
“Windows 211} 1] 5”(Windows Components Wizard) Bfi 1] 7T

3. P “IH BB )" (Message Queuing) Z11F.

Hd “IE4{E K (Details)

5. 7 “W S B\F]"(Message Queuing) X iEHEF G “ A JL"(Common) F-4114.

75 “W ELBAF”"(Message Queuing) i HE A% FH T 7 e 14144
A “A I (Common) 1414,
Hdr “IE4{E K (Details)

7E “ NI (Common) X G HE s 1401k .
TRKIIEHE, I3 ) T e A il B4R A

Bl “5E R (Finish) SCH1Z

Windows Server 2003/Windows Server 2003 R2 & {55

1.
2.

3.

© N o o A

PC 4175 548 (v8.0)

fE “PEHHC (Control Panel) FHIEFELLNIET:  “FER4"(Software).

FEAEANSE s dh sy “ AR /R Windows 411" (Add/Remove Windows Components).
“Windows 411 ] 5" (Windows Components Wizard) B EI4T T

SEFRALE  BERVEFFIR % 5° (Application server) Jficly * F—4(Next). HHHTIF “RifiifE
J# %5 %% (Application Server) XJ1EHE.

EFE BN (Message Queuing) 41fF. RS “1E4{E S (Details) 4l
il “PE4IME B (Details). KT “IH EBAFI"(Message Queuing) X ATE.
Wod “ A3L411F (Common Components) F-4114.

SR e T AL “ e (OK) #iik.

FTIF “Hi45(Disk) XFAGHERS, 6 AT 75 (1 Windows 223 CD. il “ffiiE”(OK). ¥ 2ed
MS 7 B BAF1

i “5e e (Finish) SGH% T S

oAz 5 T}, 03/2012, ASE02779427-02 73
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4.3 WRIRIF AR

KA H BB S5
T “HEER ST MEES IR T R ASIRS”

1. 1 “#=iHIH A (Control Panel) i FLL FiET: “HBT AR > EHAEE " (Administrative
Tools > Event Viewer).

2. TEMTEALEIT, &8 “FifE A G 4" (Event Viewer) >“I 27" (Application) .
WA “Yi"(Source) FIHP L E 4 HMSMQ” , MR & IEMi @S T “WHEBAIIIRS” -

ANIERAKIZIRE

WIRAE “HAFJEYE"(Event Properties) X iGHER “HiA”(Description) T~ HIL T — 48R
KB WM 2R A IR AT . IS B e W ARG .

437 fA] R G5 24417 Microsoft Internet 15 B kS (1IS)

faifr
ZLLEREH] PCS 7 PC 3, ity ZHEH] Internet {5 IRk 55 (1IS)-
o (& PC L¥uHizRss ek M4 PC it
— PCS 7 Web Jli4#

— PR R 4548 (CAS) (fWi&E T Windows Server 2003/Windows Server 2003
R2)

- R B
- f#fi# BATCH J#41) PC 3

o XFFPfHE LA, IHEHIRIRS .

2R
o I EALUE B O S0 B

£ Windows Server 2003 SP2/Windows Server 2003 R2 SP2 %3 1IS

1. 1t Windows"JHf"(Start) S5, g i “RE"(Settings) >“ IR ELE 1) 5" (Server
Configuration Wizard).
BHHTIT “ 454l & 7 3" (Server Configuration Wizard).
il “ N —2"(Next).

2. (ERBJE B DU AN ST I E . il “ R 2 (Next).

3. M REEIRRE D SR EINAH, ARG B3CH . WA Windows F7 k8 7R
AP RN, i “ANFBHIE"(No longer block) BEATHfIA

PC HAS#AL (V8.0)
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AT LA A5 { s I 45 A TG B 2R T
WEFF “ 11 58 X E”(Custom configuration) 37
iy “ N2 (Next).

CAER T, b “RS AR ThAE”(Server function) KEFE “ N RIS A% (11S, ASP.NET)”

(Application server (1S, ASP.NET)) 4 H -
ki “F—2"(Next).

R L, EF4&H “BiG ASP.NET (Activate ASP.NET) i1 1) &2 EHE .
i “F—2"(Next).

- B LU IR AT .

7& Windows Server 2008 5§ Windows Server 2008 R2 _| 223 11S
TR EAEH] WinCC OPC XML-DA Jilgs#%, WIZEINAE I 22355 2 /i 5t 2225 Microsoft Internet

==
=

B (11S).

7E Windows Server 2008 R2 I, ik AHIC A (i 25 1“Web fIx45-45 (11S)"(Web server (11S))
AOAA “IRS 48 PEES" (Server Manager) [ E .

1.

7t Windows JF- 4" (Start) Sgfirh, =AML “RE > RS 3B HAE"(Settings > Server
Manager).
BHTIT “ M55 2 & 17 37 (Server Configuration Wizard).

2. WA T He i e P A IR 2525
3. MR R “ il A" (Roles Summary).

PC A1 54%4L (V8.0)

EFE “US A" (Add Roles).

FFTFF “anfh A" (Add Roles) 1] 5

iy “ N —2"(Next).

FaH T e i RS A1 £

e “Web %28 (11S)"(Web Server (11S)) ZikHE. i “ F—"(Next).
B BoR 25 B

iy “ N —2"(Next).

F LI IR o “ A (A ik 25" (Role Services) 413,
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4.3 ZRIRIERA

8. LT A ILHE:

— X Web JIR%5 2%

gk IR

W HTTP Thfg o HRANE
o BRIABIHR
o JIWIH%
o HTTP fi%

N RS e ASP.NET
o NET n[J ik
e ASP
® |SAPI § &
® |SAPI ik g

SERENE RS o HTTP &%
o ifRIATL

YA o ARG IE
e Windows &4 iiF
o Kk

PERE o HAMNAEY

- WTEBTA:

gk IR

1S & Pz &

IS & BEEAF T 5

RS

IS 6 & H e bk o IS 6 JUEH F A A ...
o IS 6 WMI 3451k

9. il “F15"(Next).
Kot e 1 2%

10.15f “ 223" (Install).
b R AT 2
1. 228585, Hati “KHI"(Close).

#£ Windows 7 %23% IS
1. EP “EHIER > FEFFAIZLAE"(Control Panel > Programs and Features).
2. F A “as niER Windows 2811 (Add/Remove Windows Components) #4411 .
3. T JF“Windows Zfit”(Windows Features) %G HE.

PC HAS5#AL (V8.0)
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4.3 ZRIRIFRT

4. 7E"Windows JjiE"(Windows Features) XfifHHEH L H“Internet 5 B k45" (Internet Information

Services) HiEHE,

5. % <7 4ER IR 45" (World Wide Web Services) W
6. 1E “JIYEMIRSS > N R IT R BhhE” (World Wide Web Services > Application Development

Features) it 41| 5 IEAE:
- Xﬁ? Web H&%%&

Thie

IR

HH HTTP Bhfig

o iFENE
o IRIMR
o Y H
o HTTP 4%

INARIREAE DY/ a

e ASP.NET

o NET o4 etk
e ASP

® |SAPI § &

® |SAPI ik 2

SEHEPE RIS W

o HTTP %

o iR

w7 o LG rIIE
e Windows S/} 5 iF
o iFKiiiL

PEfE o AWK LA

- XNTEBTA:

Bi): prit ]|

IS Lyl &

1S 7 B AR T 1

EH MR

IS 6 & FiLHfe A

* IS 6 JuHldl H AL ...
* (IS 6 WMI ezt

7. fEH LR E 2 Internet {5 RS ©

PC & 5#AL (v8.0)
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%4 PC 3
4.3 ZRIRIERH

4.3.8 Wi ABRERA ZRREE

faifi
R LA RGN AT 2 A5, MIAE AR SR A i T e iR 55 1
A
iR
WZ% PCS 7 FH3CAE, VLT DTl (I RRAS o
E2
S AEF RS PC by, A 23RS, 2RIRSWTRES AZhER PC ¥, W fE
i 2T Bl HR A REAH SO DO e
HE]
1. RIS .
2. W RS A A 8 PC k.
EZER

o IR AVEBAMER . PVBEAMEF . RS (W 139)” #o)

439 WA LA 5> T2

fai S

XTI, B RS H E L 2 RS ORINAY; ERAE RS X BB
)

PC HA&S5#AL (V8.0)
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4.3 ZRIRIFRT

BB TR/ RN
TP ORI NR T PC Al 4l . AT AT LU R B

o Ny VOUATAEE AL B R AN L
f: PC e LA (RAM) 11 1.5 &2 2 .

o gy BUSCAT I AR RIS AR R R A A TR R

A BN T
AR TS BN AF XS IEHE, TS5 A NARAE R NIAE LA B .

4310 WRHTHINRZRE

P&

1.k “FHEAR " (Control Panel) BB A P A4l EZAH ER, ESI “wEH) 4l
FIH (00 92)”
2. FRATHEUGHEAT LR SR
J PCS 7 LT WE L —:
- TR FRUEI LAY . BN HEE 1280 x 1024
- TR SE b IR . BN A 1680 x 1050
— AR R ] A ) PCS 7 341 o ThhE, 4 an s A vb i T AR A T
LERE. VIR O e THHNV M IRENFE T, H HAEFH & A (1 A 2s
- EHTEREEAR) PC i b, NS AR OR Y RE P A s A 7 & .
— 4 Windows server 2003 LM 26 1 R P IR ek i . nl /e 28 @ 1 (1) “Microsoft
X 288 SCAE AN FT ERFLAL 52" (File and Printer Sharing for Microsoft Networks) i I+
FR B« Ak 2% N TR B £t &7 (Maximize the data throughput for network
applications) £
- 4 Windows server 2008 i+t /5 & Ik 5. 72 “EHIER > R4 > T RURA R
E"(Control Panel > System > Extended system settings) %% “ " Ji£"(Extended)
wIR, DS & RS
3. A 2 IE L A% 1T e AL T
HEZMKAEE, WS W W45 F X 26E Fl % 115 FiIE I (1T 105)” .

4. A “FHMEEFR" AT RS MIRSIRE R SRR TAE.

5. OS R4 %s:
TEE S RSB LR “ b 281" (Processor scheduling) Hiseid FH 1061 5 & IR S K R Se 1k fig
HEATARAL ()35 371

PC & 5#4L (v8.0)
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4.3 LRSI RS
4311 W ERE T EMEERD
fRifr

ZRICEREFIN, AT BB E S AR N

=908
LR n 3¢ 7 PC uhfPERE. D EERIE S IEDL M ik E .
o Fift . I -Zh
4312  wfarzeM i
T B oA Rl PC 2 A 2225 N Microsoft 4144
LB
H RIHE Microsoft 4141 BT /5 A Am] FHPERIME B, 152 0L PCS 7 Bk 3Cft
Ee
WL SR RGE S ST IM A N Microsoft 4114 .
A IS SRR AT DU G4 5 R385 SO 58 SO 42 H e = TR AR i BAIX 45
TR T MRS 2 B A A6 R R s 1]
EE oA Microsoft Iz 4551 T2
fili German German\xxxx-KBxxxxxx_xxx-xxx-DEU.exe
HiiE English english\xxxx-KBxxxxxx_xxx-xxx-ENU.exe
Vi French french\xxxx-KBxxxxxx_xxx-xxx-FRA.exe
=ORRE Italian italian\xxxx-KBxxxxxx_xxx-xxx-ITA.exe
PEA I Spanish spanish\xxxx-KBxxxxxx_xxx-xxx-ESN.exe
PC HAS5#AL (V8.0)
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zH PC

PR
1. %% PCS 7 AR ALt

4.3.13 223 SIMATIC BATCH M nARS:

4.3 ZRIRIFRT

fEi A

W R FEAG ] FTP 4£3% SIMATIC BATCH V4%, 75545 PC i kT2,
& B 23R RS 2 4h

PC 3} TERIRR R RS B

BATCH VIR44%3% ) H b5 PC 3k S ks

FTP Ji%5

FHR S BATCH VARY4E4 1) PC FTP 4%

FH k97 M A& 32% %) BATCH R4 () PC 3k BATCH #7410 (BatchCC)
BEER

o HRAXBMEMELZER, A% TN GIfEEHI R4 PCS 7; SIMATIC BATCH)

(Process Control System PCS 7; SIMATIC BATCH).

4314 QIEZD

Y

HOF R SR e Ia, w0 ZRATEAE RG/PCS 7 WA K 731X

PC & 5#4L (v8.0)
W A2edE TN, 03/2012, ASE02779427-02
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4.4 %4 PCS 7 #fF

NG AR o> XN X S o K, 2 DR 2 (WG A RS mT I A A2 7 DX i Al
IR ASEAE, BEE A PC k& L T8 3 Ak

L]

TER, WAHESPIA R IR OSSO,

o GUEMVEHT, WPRVFRNES AR EN R E FRAEEY U S XA .
o LFEWURIKAFNS, BCRZBATE A PTHIEAE R S .

o ZOIEEMUR, UFRAEMEIAERIE R KB .

4.4 223 PCS 7 ¥t

4.4.1 73 PCS 7 I HHERF I

faifi

PCS 7 B &3 TN RE )y, TR I LN IRy T LA RGO FAEIsAT Wl R R Se kAT
PRAEAEAL . BREEASTAE 1N IR PO, 3 AV 2 HY R PR N 3215 (0 T B AN T 4
BAF AT B LUR 28

LTI R PCS 7 KA AT LRI 5%, WS E0pi STPCS 7 Hxk.
KVEMAG, HiES R IR HI RS PCS 7, TRAEARLA) (Process Control
System PCS 7; Engineering System).

NIHAASEA PCS 7 # AR 3

BRI

o]l B E ) Process Control System,; SIMATIC PCS 7 DVD %% (A A AR
B, 1S W% DVD W) “WFEEHF 4% PCS 7;: PCS 7 [ X1F” XAt

PC HAS5#AL (V8.0)
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%4 PC
4.4 24 PCS 7 #1F

BHT 2GR

TiBH

TR LR S

o {EMZd: PCS 7 I, HiffE/bA —A> DVD JR5h%s LA K — AN A R sh s vl i

e [iili% Process Control System; SIMATIC PCS 7DVD |- “if f2#5#) %4 PCS 7: PCS7 []
XA SO R AR IR A DG 2 e B R A SR I BB A B

o UNRAEI e PCS 7, I A AT BE S BHAGT e (1) 21 SR i e BRI . ml it i e v i DA K
JIT it IR B2 A ) A Y 1 A B B3 AT A

o UIRAE ] Windows B ki, WZi%52e3%5¢ PCS 7 5 A felis e .

PCS 7 A1 e B i 222 e A F R

7£ PCS 7 PC I H N 22 AR TF v B s AR A = b e AU F Tk #EE1) PC il
(OS. BATCH. Route Control) J&:hid .

LA FE A O ARV T T FA AT R R 26 PCS 7 RG M REF=AE AT

LA =T, P N B AT AR 2 5T,

WA T B = 5P, M AR 22 PCS 7 2 B 4eiaix sy b, PCS 7 X sess =5
FEANRE [ B IEAT

E—A> PC ¥4 EiE17% 4 PCS 7 MRS

—NPC uin] ] Tig47 A PCS 7 IR (Bl OS JiRS54%) Wl Hl Ti817 24> PCS
7 NHIREFE (10 OS kg #s M BATCH %7 5i) o BHZHIAEE, WZHMx “ k]
A (I 161)7 .

A PCS 7 %35 Microsoft SQL Server

£ PCS 7, T8 ly—uekrE i) PC ufi%eh Microsoft SQL Server:  #iltn, #4Eus, TR
Uifiss o

H PCS7V7.1iL, il PCS 7 ARG wHefE iy 2e31Z 57, 24 PC WL ATT ZR,
2 Ak FZ IR S5 s o

EZMRAER, WS “BEH AR (10 92)7 .

PC & 5#4L (v8.0)
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%5 PC 3

4.4 2 PCS 7 #1F

i F§ Microsoft Office

ZEWE

84

FEZER, S0 GIREEHI RS PCS7; PCS7 HIAS ) (Process Control System
PCS 7; PCS 7 Readme) S 14.

i SAEVE MR . DCOM LA Windows B K (1 4511 & h 64T — 2830, BLARIIE PCS 7
BAF ISk T .

7E PCS 7 3R P AT L2501, K ldon “&a¥ilss"(Security Controller) X iGHE,  Sbx}

THAE 7 PCS7 2P AE PC i BN I RS E

e Windows Pl K5 A2 2 rp (B E G H] A 28 (R (. Wik PC whify T
AN R Hr, D)5 B o Xk

e Windows BJj ‘K 55 (11151 4151 K & 7E A5 H Windows [ i IR DL N B E 1.

o FVEM “ 1438 (Security Controller) Xfi%HE. 7F Windows“JT 44" (Start) 35
H1(1) Siemens SIMATIC F2J7 Fik#E3 a4 “ 22423 #l2%"(Security Controller).
TiBg

WERAE TAEPR R AT T e (0 B3skroh AR B b TARA SO » R
A E

Vi

Tt SIMATIC PCS 7 BOX 2 SIMATIC IPC %25 PCS 7 =4 PC 43, i1 E LN

T0i .

o ML RZAEH I, LEVEE. DCOM A1 Windows 95 k3% FR 451 #1471 2 gk A7 i A 1
WHE.

o IR, PCS7 =i PC HIAH Windows Bij ki V4%

o AL kB At H &

MR A PCS 7 LI, BN 2 e R B — B, S AN A H DX
SERLE AT .

PC HAS5#AL (V8.0)
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< Windows, PR /ARIR

T AT SEH] PCS 7 tHEEHL L Windows, HJal{# il dr4 “S&HL"(Shutdown) B “ F35T )i
Z)"(Restart). AE{FHLLT TAERAK:

FEHLBL
PRI

442 AT e B 2% AT 2 2k

WR T LA PC, HH T LR UES T AE:

¥ SIMATIC PCS 7 DVD WA HERHIZI AT AL PC Ui R . XFE( AT DA I 222
%4 PC.

I 9 45225 PCS 7 I, 1S LR R

Hitrrs PC B8 PC HOB R 2h)e Ak RS PCS 7 #AFIE H R MR .
BEE PCS 7 BAEPEH = CUEesidizhas) 3tz )m k.

NI BB LRV AR -

- BAEM BRI

- A% Bl

. ¥ DVD ISR RISk

IR G R SR B PCS 7 ) PC E#R1E.
1F Windows %% J5 & P 25 7y $8 I’ 48 A 4547 DVD BIlAS [ 303k

3. R

W& T
R
[ ]
[ ]
[ ]
B
1
2.
PC 4175 54 (V8.0)

BEMRGER, WS W “dify et PCS 7 AT (UL 86)” #i7).
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4.4 2% PCS 7 #1F

443 {223 PCS 7 Bt

faifi

VFH]

RE IR

Process Control System; SIMATIC PCS 7DVD fi% PCS 7 NI F I se ik, H
HAORE i N R AT e e, RAAREGR T PCS 7 MR P AL . frltpir B, PCS7
R IRET SRESCRE

HAE %% PCS 7 2ol e AL A I I VF vl Uk 4] o
ARVFAEM S U], S0 “%T PCS 7 BATFVFAT (1T 113)” #R7).

PCS 7 RG24y x A sl fr2che PCS 7 [ AT 4L 15 et PC L.
WG, SRR . AR SAEIA B R k. A2 /b
BT RIGERTR 3 PCS 7 ARG 2 ALY

fEH Process Historian 154K BRI R & A T

JE RS T H 3 Process Historian [1] OS 45 #3i£# LU FFEFfL:  OS-Serverfor Process
Historian

W MARAE OS RS 2% 2234 “Process Historian Ready Component” , A f4)& 7t OS Ak
Zen ek, R “H P B L@ % (User-defined Installation) 76 U4 FIHR 15
(Archiving and Reporting) SC:3% T #2120 1F

RTREMRAFTTIIRER OS Mksr4%

86

W PCS 7 RGh %A v HI4Edrul, WIn] LL2e3e—A OS M55 #5 K SCRFIX S ] 1 =4
BRI f) L D) RE

o MAIIXLL e T B IV Al Uk A
o Uthh, MENIIE OS Meds dsik it “ Uiy Ry,

HARILFEEZFLE, WIZHON (IR RS PCS 7; 4i9uk) (Process Control
System PCS 7; Maintenance Station) .

PC HAS5#AL (V8.0)
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%3 PC 3

4.4 %% PCS 7 #1F
R
o CARIERS, O “hBERSG” W AT A L.
o TS AL BRI L2 3 PC he
o THELHA PC ¥l B ALK .
A3 PCS 7 32/
1. ¥ Process Control System; SIMATIC PCS 7DVD ##i X\ DVD Kz 2.
2. Widi“Setup.exe” JHH)LHEFET
IR RIS 3l o
ZEBRFTRRE
DU 2 RAE & e R e P i E b B AT (A B (45 B IR 850 i e UL AR B (1) MR 41
1. HERTIE S (Setup language)
— B, iE#E <9l (English), SRJ5 i ¢ R 27 (Next)
2. X (Welcome)
— . Bl 7 (Next)
3. &5 B (Product information)
e DEN TG R, RS N2 (Next).
4. VEaJiEdiX (License agreement)
— PR SERE BRI VE AT PRSI S A LR TR VE AT MR 45 (1 accept the
conditions of the licensing agreement as well as the conditions of the Open Source
Licensing Agreement).
- Bl R —287(Next)
5. ‘%HM (Setup type)
— OGS “l(Install) B “ BB (Update) EIEHE, AR5 ¢ N 257 (Next).
6. /{5 (User information)
- WAHPER, RERE 27 (Next).
7. LHAY (Installation type)
— U W 227 (Package installation) 5 EHE DL 4 TS B IR A
— L WCRESRE AN H BRSO, 1SR« % (Browse).
- AR 2 (Next)
8. /71 (Program package)
- BRFERFE. TLARINIE PCS 7 L. WS AH DY I R IEHE .
AR “ AR (W 161)7 H 0 3 SR AUER ™ i A 5 .
- AR 2 (Next)
PC 4175 54 (V8.0)
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9. & (Programs)
- OB e AT
.l R 7 (Next)

10. 3% 2 R4 A T 3 42 5% Microsoft SQL Server ), 2 i x—4 SQL Server 7 AJiiF
TEHE. BT NER I BE Sk .

M. AZBRE
PCS 7 W2 E M ARG B AW E . XU EE N T e % . DCOM. OPC NiJf]
LA L& Windows 7 K501 405113655 . WRAPAT I E, Toikiede PCS 7.
e “TREZ ARG (1 accept the change of system settings) 2 IEHE .

12. 1% R Tk 1AL (Ready to install the selection).
- FEEORE O, I TE I PCS 7 NHITE PC _be s (1844
- .23 (Install)

13. 2458 )5, KRIARGHE .

14. 55 H 5l PC.

BB B 5 2 1 P 4

WERTE PC F&de T 2N MEKIERL AT, 20T B B 2 v i 2 1 N 482, UERERS 7E

PCS 7 1) ##4Fi% PC.

%3¢ PCS 7 o R —ANWEHE, A2/ Ho i £ ) T 2 i M2 I M 45 iE Il 2 . e f0d

Bods o, i “fhe”(OK) #HTHIA, ARG 5t “2"(Yes) itk “EHIiHL"(Reinitialize)

XA o

o MHATHZAARER LGRS, W20 S on & om B IE R A . C “ 2% B 1k
(Network Properties): “ig > w44 %" (Advanced > Advanced Settings)) .

o WAZUAE VAT AT F () 9 286 G5 TiC 2%

EZARATE, WS W “ T B E A TR 21 2 B 2 i 3a AR B (1T 133)”

BB
AR AT PC b b2 TR a4,
ik, AR “TFUR”(Start) S %k $E“Siemens SIMATIC F2F > P= 53t > B2k

(Siemens SIMATIC programs > Product Notes > Inst. Software).

“FE " (Products) IR H 4 BN DU BRI AR

PC A% 5#HL (vV8.0)
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‘&R PC
4.4 2§ PCS 7 #1F

PC BV A IR % 2 UiAF 2 0 B TR R H

Ll

LAE PC i HIMEZ BT H TREMISCIEAR S 4%, IAHE IR S5 a4 A R0 b 2020 TREw .
VRSP 55 g ANits 22 PCS 7 YRk,

AT RAE M 28 e 55 s EAFREIUH IO SEZ RN, wr S5 BYSTEP 7 #il)”

4.4.4 ] e gL H RS AR 428 (StoragePlus)

il
S AdH SIMATIC PCS 7 DVD 2236 R4 k%5 45 (StoragePlus k45-4%) , 15 7EZ3E
HA M) I 22 R P AT DU AT 45
iEAe
7E 222 R R 45 2 A1 StoragePlus I, 8 s P FIERA R S s [H)—FhiE = .
R

o BENHREITRSG S (IS K& ASP.net) .
o UMK RS TN FR.

7£“StoragePlus %% B ” SHEEFHITIRE.
1. 7F “UEE BTk ¥t 1”(Ready to install the selection) 22 FEFE X ilHE Y, Bl « 220
(Install) 4241 .
#1471 “StoragePlus %% ¥ %" (StoragePlus Installation Settings) X[ 1% HE .
TiA
“StoragePlus 4 BCE” X UTHE B — B, AR k.

2. HATUL R BE:

PC & 5#4L (v8.0)
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90

(A AR

HHfa )2 AL R i N R R 2R AL R

Kl e AR BH PCS 7 . HAMRSS s AR A b0 e SR IR A2
(Path of the
database):

ol HBER AR | S H SRR,

SR HSR: | B R H R B AR AR
AR I K OS i g5 i VA BRI P 45t 380 v e DA i 5 1)
NILE (R

HZHMRAER, nIB% “Uififede PCS 7 #At (10 86)” #ir.

TV R BN S0
o KPR S IR B RN E A FR, W P
- HBEIE - B4 “DBName.mdf”
- AEBIEE - B EHE X4 “DBName.Idf”
- BITRGEIRE - Bk E 4 “DBName_D.mdf”
- BITRGEE - s HE S/ 4:  “DBName_D.Idf”
o VERL, WA I EEFE, W 2T R B ) A4 FR R A N [ T AE B AR
WK LL R R FAES 0 X _ B A RS s s, AT DASRAS fef (1 PR RE A B A 22 4k
o ANEDEE R A E R BRI AR H Sk 1 B A T E B Windows #E RS A X
o ABAELUT o X R AE AT e Bl (B, 3 REEMAS S -
— LR HE RS X
— R X CUn SR o8 B BARE R « i At 75 5 1 43 Lk (Fraction of hard disk
capacity) %)
A IR, A VAR T A R s R B BEE T 40 X FR R s ) mT A Te) e IX R
T B Renlvy 2 A el S A
o FPRILTEIARY H XA X A RSN S 0] XA, BRI o RS R 25 A b i R A
R&ILJE, OS Mr&as A ne gk sl AR B
KTAEA B A I 3 b S R iR 5 e bl e, BRATIHR AL DL 2l
o [T ZANEEL ) LR RS A
o NELE B FE I B AR B B BT PC B E R NREEL T CRREL AR

PC HA&S5#AL (V8.0)
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4.4 2% PCS 7 41t

T € e o
T RLL N S
o FHILHEA] RAID R4 (RAID 0) Kt itk fig
o RWIH RAID RZ0 (RAID 1) AR i b S I i 55 i (K s 2 4=k«

o L AEAG T SR e A5 A AL BEOR AR, U] ST PCS 7.1 H b I 2 55 4
(SIMATIC PCS 7 K1) -

445 A 223 Process Historian

24 Process Historian

N 2% Process Historian (15 &, 12 W. SIMATIC Process Historian X4 .

44.6 AFTURIRF A HITLR

faifr
i 28 PCS 7 TR IR 55 A AL A& UR AL -
PUR g M T UURIESS

o XfT OS Jik%5# Ml SIMATIC EAedzi
T A 1) COM 5 11 1) 2 1 1 Ak U 45 1L 208 e 3 28 A o LA ) o8 6 3 P45 £ 1 4% HL 48
(XL .
e | T BATCH x5+
AR B BR N LK A 190 2% 3 P 2 1) R 4 LB (A2 S )
WK PC AE BATCH g5 4%, X ME——Ff RVFIIIUARIER !

ARATICRMEZELR, WS% “UEEE A PC MR (T 141)7 &7

PC 4175 54 (v8.0)
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EZEL

o HINITLERMAHAMSFMLE. UAFIUARWKGEE, SR (EREEHR
L PCS7; #HFEHIRS) (Process Control System PCS 7; Fault-tolerant Process
Conftrol Systems).

447 2% OS Web %44 PC

PCS 7 Web JiR4- 251 PCS 7 Web X /7 3 () 2223

(R R4 PCS 7; OS Web k1) (Process Control System PCS 7; Web Option for
0S) TMHRAL T 2235 LR PC il jr 5 14 i s MAIZ 5 3] -

® PCS 7 Web I %
e PCS 7 Web % /i
e PCS 7 Web 2 Wi/ilk5 2%
e PCS 7 Web £ W% /™ i

EZEL

o M (MRS SIMATIC PCS7; PCS 7 HASUfF) (Process Control System;,
SIMATIC PCS 7; PCS 7 Readme)

448 wEHFAMAER
%45 PCS 7 HAFIN 25 A B0 — L[] P 4RI )
TRERT
o JHSRBIEEIT P LRI PR PC 3l bk 2 .
o FHPTH T A 2 I RS I 0 R o Bk B 6 44

FiE “HRPAMM S RTKERER
o LRI ARNAL” — A ORI T ALRU T A AU PC ot b g e A
o YT —HIEN PCS 7 REULARE - rH QI Al A P IIbR AL T

PC HAS#AL (V8.0)
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ZH PC I
4.4 2% PCS 7 ¥ 1F

o C“HIFAURIT” FUB AT I B S G R AR . P ALEL “ORAR” bR
e

o WM FHIHMTAE PCST L) hormeas A H P A .

F P eaFnE P
DRI |PCS 7 &S% | AFR4A/AF IR
4 R4
5.,
BAER S - FiF :
7t Windows XP/2003 ', ¥ PCS 7 FH /" /3 iic
YA FBR P A o LA AR I 4
TR PCS 7 T#% | SIMATIC HMI OS 1 H T2

4 IRERESE A
FAE
BAERA

BATCH T.## |SIMATIC BATCH BATCH il H T F20if

R4

Route Control | RC_ENGINEER
Engineering | RS MAINTENANCE

RC_OPERATOR_L1
RC_OPERATOR_L2
RC_OPERATOR_L2

Route Control i H L /ifi

Route Control & # b1 (HA Fra SR
Ak 5

B2 KAAE ARG R, IS E T
FE¥th =48 PCS 7; SIMATIC Route Control)

(Process Control System PCS 7; SIMATIC
Route Control).

1B1T RS Me%s | OS s 2% SIMATIC HMI T H B
L AR
AR A
BATCH fli% | SIMATIC BATCH BRAE
A
Route Control | RS_MAINTENANCE RAE R
55 4 RC_OPERATOR_L1
RC_OPERATOR_L2
RC_OPERATOR_L2
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%5 PC 3

4.4 4% PCS 7 #1
LRI LT |PCS T REZ | AP AR S AR
H A RREFTIA
4,
BITRZ/AT | OS T AE%; | SIMATIC HMI T A E 5
1k A
BAERA
BATCH . T | SIMATIC BATCH - (A
Yk
Route Control | RS_MAINTENANCE FAE
LR (3 RC_OPERATOR_L1
RC_OPERATOR_L2
RC_OPERATOR_L2
BATRAIE | OS %3 | SIMATIC HMI IR R
i A
BAE R A
BATCH % /" | SIMATIC BATCH A
i
Route Control | RS_MAINTENANCE AE R

i

RC_OPERATOR_L1
RC_OPERATOR_L2
RC_OPERATOR_L2

SIMATIC Logon

LOGON_Administrator

T H 4 B A

SIMATIC NET | SIMATIC NET | SIMATIC NET BIE“SIMATIC NET” H /41, fdiH PCS 7.
PCS 7 OS =% Route Control 5l H i &
Windows H #0201 A 41 B i

2355 STEP |STEP 7 Siemens TIA T A2 STEP 7 /=435, kst

7

94
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ZH PC

4.4 2% PCS 7 #1F
FA P& B IR
DX 23 LA PR 2
e Windows H ;. SIMATIC Logon s} it 1] = 45 24 .
- P PC L
— M Windows (] PC) [RAS gl B AT HI 45 B
o ¥ JEN1uFE SIMATIC Logon fFH J 45 .
V% PCS 7 N R F#E 5 48 H“SIMATIC Logon” kAT I P4 8. SIMATIC
Logon &1 Windows Jij /& 21 [1) 3= ZE L .
SIMATIC Logon $&4 7 LA F J 4 B o 2 R -
- HPERY RO Windows JEAN e & (i) PC) 1#) SIMATIC Logon
- HPEREY RIS PC LK) SIMATIC Logon
% & PCS 7 ] Windows Fi
7F Windows & #itt, £y AEhH N3 PCS 7 4L, S ILE X se A i )
WSRO P PCS 7 414, WWAZiAE Windows & EABATT, 45 L0 lic 45 AH
KM PCS 7 4t CHP 4D &
WEARGEE, WS W “afr i s 0 H BARRR (1T 97)” .
HEADR

o 7F Windows % T 4LAFIE AR IS AT LR TRk e 7 R - 4.
— & XAEPTER Windows %4585 1 nl F R R P 4l
-
o {fiffl SIMATIC Logon & X H F ftam, LU HEEEF «
Af{E—4 PCS 7 N HFERE (B4 SIMATIC BATCH) P42 I R o 40 43 o o fA 10
~f:  SIMATIC BATCH
- WP (BRD
- BHIEN ERTFMHEPAE GRS RS TENLD
- WAL ITET RV PR CEERTRENRR E BT
o PCS 7 MRl g S -5 T8 S P A B, IR T BIDC TR 8 sl AT
(RIATART B 5 LA R e A R TR i o

PC 4175 54 (v8.0)
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2R PC 3
4.4 25 PCS 7 #1F

7E Windows 3+ [ EE A #E D T
LRI PR, B LU AN S — AN 4 a2 I 8 “SIMATIC HMIE” H P 41 B 1 b
o IR G TR P P RN, A T AL 5 [ X 4% A B T R B ) 7

B

o MU BLLIE PCS 7 ARG HATE B S R BL, il BEAT AL B e b i AT
S
HEWAE PCS 7 T H 1 A I AN ZEAE X LEAL R

R

o WUE P OBt AR 4L
o B BE O ORI kA R P A N T e IXEE ] RTHE X SR DT ) WInCC.

L7
1. 7£ Windows FF]JF LAEX & #H,

2. fESPUE O, EEE “ A P RIZE > 417 (Local Users and Groups > Groups). fi 41
R RAER & Db, EFR“SIMATIC HMI” 4.

3. R PREESE I IE “US N 7 (Add member) X UEHE, KR4S R S 4LAE S “SIMATIC HMI?
P AL A

ZE Windows Server 2008 #:4E & 4t S B R
“EYH P (Power user) HI 7 AL b S AUOG I R 4
1. % %] Windows “JF4f"(Start) 2., 1%+ “iz47"(Run) X iFHE.

2. TERMAI A A LR N2
gpedit.msc
BHTIT “ LSR5 % 4 45" (Group Policy Object Editor) i1/ & 1 -

L EREALE T, R AR LRSS T AL E "> Windows i E">"Z &R E">"4H
SEmg”>“FH F AR 4" (Local Computer Policy > Computer Configuration > Windows
Settings > Security Settings > Local Policies > User Rights Assignment).

FETEANME B O “R M &4 (Shut down the system) X 4.
BATIT “I M R4 (Shut down the system) X5 HE

. Bl “YS I EZH7(Add Users or Group) 44411 .
BT IF “ 3 k47 (Select Users or Groups) X iGHE .

. FESRA TR A

w

»

¢,

2}

EZER

T (SIMATIC: SIMATIC STEP 7)
ELHEB) WinCC 175 74

PC A& S5#AL (V8.0)
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%5 PC 3
4.4 %4 PCS 7 #ft

o Tt (GLRE# R4 PCS 7; SIMATIC BATCH) (Process Control System PCS 7:
SIMATIC BATCH)

o T (iFEEHIFRS PCS7; SIMATIC Route Control) (Process Control System PCS
7, SIMATIC Route Control)

o T (SIMATIC; SIMATIC Logon)

449 el i B I H B2 R R

[1PCS7V7.1SP3 2, PCS7 OS It tuffipy i S Gt EpLbl.  TIEI "SIMATIC
Rights" F2 /5 HUAT I H M2 % S . T R 7E PCS 7 22 M 578 15 YR ET I OS T H it
H AT .

il "SIMATIC Rights” F2 1 & OS JI /" G NTFS #24L.

Bk
o 4T PCS7,
o I EE AR AT LA R A IR
o AT b ZiAr B “SIMATIC HMI” 4. IX [RIREE F T e F 4T JF OS i H (1) H
e
— Windows & # 5% OS Bl 28 117 [l AR AN 52 FR 461 .
— “SIMATIC HMI” I S 4 i OS il BAT “35 7 U5 RIALR
[ I 4 25 I 21 “SIMATIC HMI VIEWER” H P 41 ik %) OS Bl A EA “3e” 1
) PR o
i ]

XfIUH (STEP 7. PCS 7 8 WinCC Tl H ) FrEI T A g A2 AT LA D 3%

1. JA3) SimaticRights £/,
ARIAFM A TS R, ES W PCS 7 [ X 1.

2. &P PCS 7 WiH W%k 4E, & NIKAEM#LE "Storage location" . i “#fiE”(OK) BEATHE
o

PC 4175 54 (V8.0)
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2R PC 3
4.4 2K PCS 7 #1F

Fr#E Windows FH AR R &1
274 PCS 7 Ja, LUNBURIAE A FrUE Windows H BB ) FH P A5 BT B 161«

o “A%fE A "WInCC Hil 1 RS K17 AR
W HA AR P AR ¥ Windows 17 R 2R B FE B, AR S “ /e
ML F"Windows 41+
“ZRG 5 B"WIinCC JHIE RS E R

- CPU %
- SR ES

e ODK ZhyRefs F B
HATFRUE Windows FH AR K FH B A HI LA ODK i
— CreateDatabase
— DatabaseAttach
— DatabaseDetach

BFLEER
e Tt (SIMATIC: SIMATIC STEP 7)
o (BT WinCC 17 E Z4

o T GLFiEH &4 PCS 7; SIMATIC BATCH) (Process Control System PCS 7;
SIMATIC BATCH)

o T (iFiEEiHIFRS PCS7; SIMATIC Route Control) (Process Control System PCS
7, SIMATIC Route Control)

o Tt (SIMATIC; SIMATIC Logon)

4410  PC 5 RpE k%

Windows B k5%
PCS 7 {f[HEEVE RGN ks (B, pes7 readme) . 123 PCS 7 (i B 34T i 5
WHE.

ET) Bk RN KRERE K

WRARLE T Rk LA K, 2620008 CP 443-1 i M R IRAS . A7 Ot 3/
HEEE, WS “PCS 7 W4l PC &4 (7t (I 51)” #i7r.

PC A4 5#HL (V8.0)
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ZH PC

EZER

4411

B

EZER

4.4 2% PCS 7 # 1
o M TR/ T) MELMALE (T 52)” o
JE e R E R
WH PC L35 PCS 7 #iEtL, N PCS 7 RE w3k B0 Tk 2 B 28 Y [y o}
THAE . AR R IE AR i s T B e R
o A
o HH
Wit Es ke, TUEHIE PCS7 g, HEZMGER, 1SN “Msxk B-PC ¥ B
SN (T 161)7 ¥4
I TR, AR R AR AR AR AR BT AR o B DR BT AR 1 S50 4 A
j=:9)'8
FH PCS 7 AT HTEH H 5 PC ¥
i
PCS 7 (13 Se R A0, 25 70 57 () B 3 87 i3 3l PC i
i
WREEEH PCS 7 Wi H, LABHRA PCS 7 B G RiA ) PCS 7, 4% WA ikt
FEFT T U B R A
WL, ST GIFREHI RS PCS7; B H:#) (Process Control System
PCS 7; Software Update) .

"4 PCS 7 I [ R 10 (5 82)” #4

PC & 5#4L (v8.0)
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ZH PC

4.4 25 PCS 7 #1F

4412 R “IEILR7 HRAMRSSEYT RA LR B

PILARTS
£ PCS 7 ) 71— HETCAR I R4 Ik 55 7% (CAS)
VR
ZAETUR IR RIAR R S A g oA TUR . REGHN R T — B85 PC ul, n¥HAE
HICRIREEIZAT .
WBLIE
PLUR R “CAST” 4RAETUAR I Hp S AR IR 554+
fFH“CAS2” e PC s
AR RTUR AR RS A ZER LA E B ZE R, SEFM GRS 5% PCS 7;
RISV HI R S) (Process Control System PCS 7; Fault-Tolerant Process Control
Systems).
=k
o PCS 7 RGEMIHAT B LA B 58 ko
o JLHTIEF R IR RS 25 “CAST” [ ETA AR B Sl ik F3h 7
e “CAS1” }z “CAS2” ] PC WAZiliii /& PCS 7 HHITUAR R, Hlln&3E A, AR
Y
o i I TR AR S5 B IR A EESRAE“CAS2” 1) PC e RS, By ZoRIHRAE &
G EMOETE, HOLfrgarsosgn .
e {E“CAS1” H*CAS2” ) PC [WJfF —40Ux s, HUOME LR,
WZAIKAGE, WS% UG PC BITUAR (W 141)” #55.
o ] DLl i s 2k 17 i) “CAS1” 5“CAS2” 1] PC.
I
1. EX“CAS1” LI H H& %,
E“CAS1” 11 PC 35 J4"WinCC CAS Appl.” i1 ES I5 H vl [t % . P
WPt “xt% )& (Object properties) > “Htr OS”(Target OS) >“% Hix OS HHE LK) 12
(Path to target OS computer).
2. & X StoragePlus %/ A FRUAKAECAS 17 LERCE MR “ A IR 458" (Common
Archive Name).
ZARR M R LB “ ARG E " (System Configuration) >“i F”(Common) iy 4 44T T
StoragePlus & HEHI G . BIALHE_ARCHIVE_01_*." . ZBAEEE “AHA
R4 44 " (Common Archive Name) #H i 4 Fr I 7B
PC HAS5#AL (V8.0)
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%5 PC 3

%
=

4.4 2 PCS 7 #1F

3. 7E“CAS1” (2% H kb s X StoragePlus ik FE 115 .
AAE Windows 785 HLg8 B L R AR 2 DL B E L Rk e ke (i,
\StoragePlus\Database.” ) .

4. 7£ ES T H 2k “CAS2” i In—ANHrt PC ¥,
7t HW Config H 41 Z“WinCC CAS Appl. (stby)” I FHFLT L 5 i 12 (134 32

5. 7£ ES Wi H , b )RR S5 25 “CAST” HILIZSM “TETCAR” Bh “IUa” HKa.
TE“CAS1” [t % @ Ehikd% « Hix OS”(Target OS) ikJii-F, J4E 7B “#& M OS”(Standby
0S) thILFE“CAS2” 44K

6. Mi'E PC uh“CAS2” [ Hinikz .
1E“CAS2” )@k rhik$ “ Hbr OS”(Target OS) K “ ik OS”(Master OS) LI+, J4E
B “EHFr OS K&k OS [i#%4%”(Path to target OS and master OS) H i & ¥ 1% .

7. HEHCAST” IR S 2 5 .
76 ES T H 1“CAS1” [ RFESE ik F a4« A 4548 28" (Generate server
data).

8. 7E“CAS1” 1) PC LB ik FEi=, FHrHsh PC u“CAS1”

9. I “CAS1” LMless#iil iR H“SQL Server (WinCC)” fili%5 .
e BRI

10.7F Windows %5 Fiash, ¥ StoragePlus $¥i/E (fU4E#k4e) M“CAS1” # 15|
“CAS2” . L&fELIE 2 1 3 i Tik4s (filtn, “..\StoragePlus\Database” ) K%k
4
HJH“CAS1"PC .

11,3847 —IR“CAS1” I 5e 4 BTt I g B

12.{E“CAS2"PC i I 2235 Je R4 IR 25 2%
Ji3) SIMATIC PCS 7 DVD ERy“%Z4efef7, RJE M “FE7 " (Program Packages) % i&HE
(1) “IBAT R4 > 554" (Runtime > Server) Hagk FIEFE “ a9k k454" (Central Archive
Server) £,

13.1%% StoragePlus il FE 11 %42 K 4% Fx LLUCEC LR A5 B8 10 FR A 10 #6428 S B PE A R . 52 ik
“CAS2” [fr)adk,

14. 55T BT OS 2 v 1 I 25 2 Bd, X el s e i AR A RS e
7t ES 1) OS % /73 4T JF WinCC T H . fERTERLEI TRk £ “ k45 %5 4" (Server Data)
PE
PR LS “H8T.."(Update...).

15 B FPERSE L ar S “HdE..."(Configure...), FFE PRI UEAEF 1% OS &/ uiific & 1k
2% 2%,
KT HTf OS % Fif, HEIXLDE,
16.7£ ES Wi H Y, AHTA CEAERTIII IR T T R4S 28205 1) OS % 7 i N2k H br R4 .
17 8 T OB RS 4 31 v g RS IR 45 28 “CAS1 " H#AE B vk gk H Ax R 4.
18.181T—IX“CAS2” M15¢IME It i ik FEAR =

AT S5 2K I0A (UL 91)

PC & 5#4L (v8.0)
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24 PC ot
4.5 2y PCS 7 %95 =)72 )7

4413 HE PCS 7
Wik PC i EAHFE PCS 7, wIHAT MADEMNER PCS 7 #fF.

300

TR VF l e 4
AL, i, PCS 7 T H BRI S

B
1. #fiN\ DVD I8 8l 2y .
2. WP “MMFR”(Remove) Z3E L Pk I .
3. JEFE PC i AP E AL
F IR ULPH IR PCS 7 Ao

4.5 J PCS 7 RS F

451 TBIE A HE 2 IR TR
4.51.1 TBAS M HEBRIRBI R P

féifi
PCS 7 %X HENEHMEN T PCS 7 T SHL b 2 B A B e o A SRR 177 X2
fE22%5¢ PCS 7 i CURIEAR B PC 5L N A2ttt
WRAE 2% PCS 7 2 Ji BSOS BB (152, )06 200 S 2 b B A MR (1 9 S 2
(“SIMATIC NET PC #&f” 1) .

PC HAS#AL (V8.0)
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%4 PC I

K] vl

4.5 2y PCS 7 %9502 )7

1T PCS 7 HIEAR AL BE AR SR R EI AT . PC A BN 2 B ahdEAT Prfs e

LB

T FEAAS I B BN BP0, 15 7E BIOS HHAS £ 75 3 BN 4E R H AL sl . SE 2
MAF S, AT S BIOS ik i i) SC kY .

X SIMATIC PCS 7 BOX, B4 B 2EL 2 (A Sn i ) BE A by RO IO B o

FEEZ (TMBIRM) EYI#H

WATEE SRS P AL W (i, A TCP A2 1ISO) , WIIFE BEAE LAR TS, F8 I 5
HIRA N (TCP M ISO)

AR, BASEEE A AS LURERIE S IR RS

TR

AT WA ANZEZE ] TCP/IP 50 1SO thill, PR ARIEATING , XM F s—AAT!

BRERE RN R & P

T B&nE

FOR AR CP AT L L B 190 208 T P o 70 S50 A7 i o 4 R e U7 1o R e 14 v L s P O
8

A BN EE “ BT (Autonegotiation) (] TSl AN B T3% I 48 42 11 () e Al A%
g NI RVIN S PSS O
HEZALEE, WS W “UTE s PC M2 i ama e (50 137)” #5455

XL R AT LU B

o ZEH] “ S HAIFT ENHLIL =" (File and printer sharing)

o Z%JT“Microsoft %% 3" (Client for Microsoft network)
o JiH I1SO thiX

o ZEMITREiL I

AT TR BA R SCRRINCS A DG A5 S -

PC & 5#4L (v8.0)
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ZH PC

4.5 2y PCS 7 #JE95=) 727

4.5.1.2

AT (EFEEHIRS PCS7; THEAKRS) (Process Control System PCS 7;
Engineering System)

HATH GEFEHI RS PCS 7, #:4E 1) (Process Control System PCS 7: Operator
Station)

WInCC {5 B ARG  “il7 A 21> W 438 oo (10 ik 55 45 (ks IRad £ D g

W0 e 2 A A R I TR B

BCE #1 SOFTNET CP iR &

WERARGA M B (KB T B , FATEBON T B &I 1SO Prisir4t
HI TCP/P Wsle 5 LR R GEREATIEAS N1 5p -

R

W

104

SIMATIC PCS 7 BOX
SIMATIC PCS 7 AS RTX

H CPU HATH LA M B2 1114 B 3h ik R 4.

BLEA

. HW Config #1/5% NetPro 21 2518 (5 BLEL i 0 1) i Ze b R ppisl

o % %% PCS 7,
EEBUL
H PR 2 M.

W9 2% 18 il 25 AN 2 CP 1613 5 CP 1623.
CP 1613 i CP 1623 f{MIERMIER (ST IER) .

- AEP R JR T 1A F DA A . ) I % T L AR B PR AE P . HERZ AT

- Rik4. TCP/IP
- TJ E%Z: SIMATIC TALLLAKM (ISO)

- X HRAZA M IERC ST PC:

- PR E.
— H5 “¥EH"(Connections) X sk r 2% dii i £k (1 9 26 X $ 7% B 2 THUAT A7 A

PC HAS#AL (V8.0)
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%5 PC 3

4.5 2y PCS 7 2 Hea #1727
3. EHR 5 PC LG IX S & .
4. VERRT) Rk LIEE A AR DL R R
— Microsoft 4% % i
— Microsoft W% SCAERITFT EpRL L =
A
RiEB% WInCC 158 Z4 H “Hia 2 AN M IE N 28 IR 45 28 Rkl s e 7 &
R (R e 2R

451.3 YN {RT 22 F Y 4% 35 FiC 28 ) 7 FRL I T
VI 22 DA X 25 A5 R T I 5% 385 I s 4R S RRREJR A FEIDRE . WL IX SE 1) R nl /D REAE .
FIH RS, PC nf LU AT AN B RN BN . S BE 75 RELE I, WY PC ZE &2 1Y
I BN AL T ARG BPIR AR, XSk T2 0< A PCS 7 PC 8434 fit & 587 JA )i
e RS BT LB T PC,  #E IR Y REAE 1L
4514  WfAMELEEA CP 1613/1623 (] PC 35 A7E PCS 7 F i
i/
W AE PC ul i ] CP 1623 / CP 1613 {5 bk, WILL FH5H N 75 2414 NDIS &R
P
o A 4Pl (MS, Maintenance Station) WiHL T E 2k b1 R 28 4L 4E (2 W7 .
CP 1623 / CP 1613 il {5 itk Fl F-Ae e drulif) PC rhifa) L) B2k,
o B ANES TR Sk inZk SIMATIC PCS 7 BOX H it A3 & 4: .
CP 1623 / CP 1613 il {5 it H 178 TAZu i m) 1) E k.
NDIS #x
fEH “ ML I3 FE P2 D BV (NDIS, Network Driver Interface Specification)” At nJ 58]
fE—& PC _LIiZAT 2 /Nl Bk ol (7 S X 8 A i B o 348 0 1300 £ A X 496 3 T Al P 2
i
PC A1 54%4L (V8.0)
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24 PC ut
4.5 2y PCS 7 %05 =) 727

4175 NDIS & 4s

i
1E PC i X PC 344 CP 1623/ CP 1613 M S Mt 4T N ik P48 % & .
M PCS 7 V7.1 JFif, B 5HELpE NDIS i1 2% F sh2eds, R Fxf Hak 4l 4.

1. FTTFH 0 B B (P TR HE
2. PSS “HE"(View) >“FE41 {5 B (Details).
3. W Ebr AR, 765 “%&4FR: "(Device name:) LA NI A FR I E A5 B o
- f#f CP 1613 It}:
w454 Fx "SIMATIC Miniport CP1613 PCI Adapter"

— fiiH CP 1623 It} :

w454 Fx "SIMATIC Miniport CP1623 PCle Adapter"
HEPRIREESE iy & “ B (Properties). K7 f1 1< 4% 1% 2> & 1" (<Network Connection>
Properties) Xf i .
A
T, ERIEERRm A “EfB” (Rename). I AN— MR RR, B0
"CP_NDIS_Nr_1",

4. 7F “H " (General) ik £ZE R Internet 1M (TCP/IP)” . Huili “J& 1" (Properties).
P47 H-“Internet % (TCP/IP) J& 74" (Internet Protocol (TCP/IP) Properties) % iH4(E .

5. B “AfFH R IP Hihik"(Use the following IP address) & 1EH#E.
BRI L) HE TR B
— IP Mk
- THHERD

6. Hudi “HfiE”(OK).

7. i “HiET(OK), KHI“<M 48> 8 " (<Network Connection> Properties) % 1 it .

B
H

BN Y ] NDIS i e 23 1R 9 45 1

PC HAS5#AL (V8.0)
106 A3 T, 03/2012, ASE02779427-02



LR PC Bt
4.5 2y PCS 7 %95 =) 727

452 PCS 7 WIBfhn i & FIRBIFE P

4.52.1 PCS 7 HIM & & K2 F 5 0
WRALAEH PCS 7 e @b, WIFE 2R R ISR T

B
1T RIRBNRE Y (K Pt BATF R PR IR R, W20 PCS 7 AT

B I s 26 AN IR Sh AR P AR
BASPC EHZNNEME
BT EZER
Matrox Multi-VGA ‘i 2 VGA EJER (1T 109)” #84>
TURM % EH) PC
WEhiEfF BEZER
PIZEE LA (s 2 TURER AT HIBN | SO (IR RS PCS 7 AR FEERIRSE) (Process
O Control System PCS 7; Fault-tolerant Process Control Systems)
it DCF77 AE i {5 5
BT EZER
I PR F S e 55 “Unfa s DCF77 Boss (0L 112)” #45
FEBOEEE S RIER
Wi BEZfER
HRE AR 2% PCS 7 I 4x A 2Pt B o
SR R RS PCS 7 AN (
Process Control System PCS 7; Operator Station)
PC & 5#4L (v8.0)
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ZH PC

4.5 2y PCS 7 %0147

FEETRIAS

WP

EEER

PR

Rk Windows Fiift 224 it ;
R BRI (T 111)7 355

BRFE

WIS

EZER

SRR

WinCC 1.5 7 2T T BN F 7«
BT SIMATIC Logon & 3k:

e "OMNIKEY CardMan 3121 USB":
CardMan3x21x86_1 1 2 4.exe" [IIREFLTF

o (fYFR Windows XP/2003) "OMNIKEY CardMan 3111":
CardMan3111_V1_1_2 1.exe" [HIRZFLT

T AR RS SIMATIC Logon HIfEIL F & (fE{X%d
Windows XP/2003 £ i 45l EAfF ] WinCC H 7 88D
e "OMNIKEY CardMan 3111" [{JIK 57
e I R Y Eda o
— CardMan3111_V1_1_2_1.exe
— CT-API_V4_0_2 2.exe
e "OMNIKEY CardMan 3121 USB" K50 FE+
LT IS TR«
— CardMan3x21x86_1_1_2_4.exe
— CT-API_V4_0_2_2.exe

EXER

AL AP (DT 54)7 EAy

108
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LR PC Bt
4.5 2y PCS 7 %95 5) 727

4522 TGS % VGA B £
PLR S5 IBA R 78 A MR TR -E 1 PC w5 5 2225 Matrox multi-VGA EiE&.

L]
RNEHTMEFJBERR
AT LN EAE R Multi-VGA B~ ST T PCS 7:

¢ Windows XP Professional
® Windows 7 Ultimate

4 Y Multi-VGA Bk

B2A5E, WS IR (AP R% PCS7; PCST7 HRSUAE) (Process Control System
PCS 7; PCS 7 Readme).

o ZPBIFHEREAHI 1 Multi-VGA B+

o s AT B AN EN R R
L]
Multi-VGA K+ E£eid VAERTE OS slhivh i . #InfiH] ES s, (HEPlas 1 fE
TEA s I AT W 1

L H Multi-VGA EJE- RN, 1E#ORI T WInCC (5 RGP Ui, HAKW T
“-1375"(- Options) > Options for Process Control >“OS Jiil H 4% #5"(OS Project Editor)
>R 4y B 5245 FE 257 (Split Screen Manager) >“% T Multi-VGA [#)71: & 277" (Notes on
Multi-VGA)

“FRAERE"(Release Notes) >“4 il 11" (Control Options) >“Multi-VGA”

BiHA
G450 Xk

55 EAR I HENCAT Matrox G450 YUK EITE R PC LK “ B Zed% )" (Bus mastering). It
B AR AN AT T multi-VGA Fx .

PC & 5#4L (v8.0)
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ZH PC

4.5 2y PCS 7 % JE95=)72)7

WA

% TAE

110

A

BJa, ARWEREERNSH.

AJ LLYE Windows [ “ i & P (Display Properties) i 1 HE 5 & Wi Wi 4% (1) 5 5200 R
FiAif/ GE21fd H Matrox T H“Matrox PowerDesk ..” ) . {EZAEHET TR E 2
W, i “ g (Advanced) $%HL, ARJELE “ IAES"(Monitors) B IR G R
ZIALASC I R A 30 (Hide modes that this monitor cannot display) #£37i.
WP S e at, RIGRM E2A A,

A7E WIinCC 5 R RS I LA A7 B 4R B K IE o % )3 S 00 . “1ETi"(Options)
>“Options for Process Control”>*0S i H 443" (OS Project Editor) >/} J# & B %" (Split
Screen Manager) >“Multi VGA t1]”(Notes on Multi VGA).

WA %% T Matrox BEIGERCAS s LT 5, “Matrox 57 & 1" (Matrox screen
properties) 4 4 WontE “yiiilIiER”(Control Panel) .

xR M PC ¥k,

15 PC i bz /g, HEEH PC M F M rtl & 1065 &

e RN H 3) Windows..  ZEHAT BLERAE, W] PC JFHLINGZ T F8 .

1E “W &4 PEES" (Device Manager) 1 A5H OREIER) BB IERL 25

YB3

WUR LUE AR EE O B ETE A, AR T AN 0 BB 22 b i i B BT

PC A& S5#AL (V8.0)
A3 T, 03/2012, ASE02779427-02



ZH PC

4.5 7 PCS 7 LW 50 FE/F
g
1. I B R Y AR R B R AN I 42 1 T A iR A D
2. ®HHB) PC.
3. I, A E multi-VGA EIE RIS HL.
AR EBMEZAE R, 2% WIinCC 15 5 R4
“# 10" (Options) >“Options for Process Control”>“OS il H 45" (OS Project
Editor) >“/3 b & 2L 43" (Split Screen Manager) >“Multi VGA 1t #”(Notes on Multi
VGA).
- “HEIi"(Options) >t FE 4 il 1" (Options for Process Control) >“OS Jit H 4 75"
(OS Project Editor) >“/> i 45 # 23" (Split Screen Manager) >
- W fE <" ERE RG> T RCE <"Grafikkarte™> %
AU " (Release Notes) >“i fE 4411 11" (Process Control Options) > Multi VGA
i B
WA 23T Matrox BIEIERCAIKEIFE T 5, “Matrox b & )& PE"(Matrox screen
properties) 4 2 Bontt “ IR (Control Panel) .
1E “Z SR WCE”(Multiple Display Setup) -k Fp AN E i AT BB . (EAE(] IR
Bi F#ANEL I 8))“Matrox Y & i 7R"(Matrox Hybrid Display).
i
fany LIS 25 H R A D RERT 1R AR GBI WA D) REEAT AN A5 B8 LR B 04
4523 AERZERIFEF
fei/r
A P AR AR 75 A A T R
PRI IR B RE P 6 2007E Windows AT e, A CHtiER - PCS 7 UK ZRE P I £ 4
G, WS W (PCS 7 UFEHEHF4: PCS 7 HAX ) Y,
2k
CZdem R,
PC 4175 54 (V8.0)
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2k PC uf
4.5 2y PCS 7 %95 =) 727

P&

1. WERAR R RIVIEIRE Y, R R B B A E Db Bs—A “? 7 f75,
T I 2R R 2 P R I ISR
AR PERER, 1§30 PCS 7 ARIfF.

2. THE3) PC,

S
>

EEZER

ARASHEE IR HAWAEFAMNELER, ISBASTN (EREHIRSE PCS7; #:
Y 513k) (Process Control System PCS 7; Operator Station).

4524 i ¥E DCF77 BBURS:

DCF77 W RS
DCF77 IR & AT L R AF 55

e 3ok A [ Darmstadt Mainflingen Physikalisch-Technische Bundesanstalt [f]
DCF77 Ki&Zs P )45 5 .

o FI[AIfE 5 5 PC uii) RGN M HEAT LU
o WAEIN T IE RSN (A
P LA R B 18455 . SRS IEL PC sl )4~ #R AT 1 B 1) {5

Fo

B
FHEDCF77 MO sSSP P oK ) AT i B (K ANy DCF77 46
ety PC

PC &5 (V8.0)
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2 PC

4.6 i AfiF
Zk
o DCF77 st L4z 2] PC 3l i m] H HR AT % o
PiHA
HRIKENFE ) TR AR aT R S S, ES W PCS 7 H ST
IR
1. LREIKENFEIT
2. Qi EE, A R TR R O
EZER
o R (IIFEEHIRG PCS7; WaI[EIZ) (Process Control System PCS 7; Time
Synchronization)
4.6 VAR

4.6.1 ¥ PCS 7 M4

HEARE
TRANH T KRB LA
VFAE VAT UES AT 7 SRR . AR TN -
e CoL (VFriEiFE+)
o VrHlilE%E
CoL (¥FAUE | CoL PAUEVFRIUE. 7 il U8 FH VAT Uk I 3 BRI A N S A e
ED
VF AT IE %5 VFATUE S SR VIR “HARFIATEA”  (WFRA “ VR iEds
E7) o
PC & 5#4L (v8.0)
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ZF PC 3
4.6 IFH]iE

VAT R
455 T 44 AR VR SR AR 2K A K

FEARVERJUESRASE A 7E 2 DA PC i B2 M ARG KR VRl IESRA I 5 AT K
YRR A AR SR AF 1R BT 38 P PR A«

o T FHFEAVE AESRIY AR .

EAFWIERR | #ik

FAVFATHIE ULV TIE, W AEAR R S T L A A VR RTIEIE A
ST SRVFIRAL SR,
VB VEATIE A UEVFATE, TSN P25 o A S L A . itk

AR P2 BT B T STAL L.
o T FHIVE AT F

RTIESRES ik

A2 RV AT HIE FEFHVFRTE, ] DAAS 52 B il b A F A

THEUH SGVF AT E TV RTIE, AT A T 2532 3 LR BRI

o GrlArhiE IR Gy ER A DU R AR S A, LA
TARAFVF AT AT

27~ (Display):

VFA 8 H B Ae AV R IR BEEs ) “Ja " (Scope) F B .

ATHON R VF AT UE IV RTE, AT A T 2552 3 LR BRI

o Gl XM B R E .

E7~(Display):
HAE W RTE B SV Rl UEE BELR 1) “YE " (Scope) FB T, kAN
“X(Y)”

SrheX AT S VP 5CH «

VR IR

vES

I AS 030 30 FL R LT R T o 5
(1, JEIFR TR B 10°X (i 2.

X" O AR TE AP TR P HCT. BERS T b
CLAL A LA B T RE T

V7 L RACEE BN S INEAVFIT B2

PC 415 #ZHL (V8.0)
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2 PC

4.6 i AfiF
VFAIIERAY ik
FHEAVFATE TEPAT TR, 1T BT ZE LR T I RGORS K
o AHTHRVFRIIE, FRKE “IH” (9 x ORI VF AT IRl x+ hiiA
PA L VF ATIE
o filly, WTHEIN T BEL, Wil REHR AT .
G ERARNIRTTS AERIVF TR, AR 2 52 31 BT BRI
o Al rhE SLIMISAT I [A]
o IRl E S IRAL FH 2 5 1R #L
e AFSAERE B Bon THER, 3R VT UE R R (1)
IBATIN A o
FAT VPRI UERAS | AV RTE, SRR A 4552 30 G ) v i s SIS FH 2% 3 P B A6
¢
A IR AT IR IRV RTIE, o] RLASSZ BRI b A
R VFAIE ARIEVF TR, AR 25 32 B BT BRI
o U, &% 14K
o WA Z Ja i R 2
o HTFWRRAIIE (iU
SRVF AT IE ARV AT R, AR 2 32 B BT BRI
o Al b SLMIEAT I [A]
o GrlrrhiE ST I 2 )5 (1 R £k
e ATSAERE B Bon THIER, SRRV UER R 1)
IBATIN A o
UiHg

SEARBAT 50 M RV TUE A, 7 30 T G PR o, T DA T T4
R VAT

THFHREF AR PCS 7

W SIMATIC PCS 7 AT A A AL, AEHTIIER 14 K

B

B AT AR, mTRAEE N Gion) Bt

PC & 5#4L (v8.0)
W A2edE T, 03/2012, ASE02779427-02
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%5 PC 3

4.6 ¥/ ik

R KV ATE R B
AR RE P 5 2 ANVFRIES T, (BGIAAE M2 R BT — VPR IR B “ 280 B3,
WIFRH A “ SRRV RSB

B AT E B A
PIATVE PRSI G 20/E 77 rf il 2 7% B AF GZBATFIE PCS 7 RGU LR 2%
FEREAS A B AT B

TR B
BEEA
FERFIUR SR EV VAl IR AT, WAL A PC 2 A SE oI 25 «
ATV, W RE AT BEAERE AL R 5T (VPR IE 9] U A, VFRTIEBS DI 2 1]
ik
FRVEATUE R PN AN IS S5O/

EZEL

o Tt CHIMLVFATIEEEEE) (Automation License Manager)

4.6.2 BT A 38 T IR 2 £

feifr
LA VFRIUE S IR L A7 5078 77 AT il P A A s
o DU SR VR RIHIE VR T HIE B B
o (PAB AL B B v LN AR A el FR VF P E 35

VFAE R AR AT B A B
o VFHUE®H] U Ak
o VFRNIER P
o ARHAFAES T

PC &5 H2 (V8.0)
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ZF PC I
4.6 T iE

o AN EIIAEEAN
o WBZhfLEE (it U A, ik CD 5 DVD)

L]
PR CRIHRCA AT B IVFRTHIE) A& 4 SIVF i 8] U A edte U 4 b

VFRIIE R SRR TR
FISYE P ALl E A 9 S5 T LA F 525 Ph BRI A7 Ak (07 1) A4 3V m] Ul B (R 3 7L
o i
o BYPIRUKE I
o HEALIE
£

E Z0E 7 o] il B P R Bl o

R ERAE R DB

iR i 4 “YLE(View) >“BHE"(Manage) 1 FAH AL .

RS E O T BN IE BTN b, 7 TF 2 ) b & ShVE mT R B B0 A7 R A
R B O BN IDER TN L, 7T 2R S VF nlE 25 B IR A7 2

b S AR P12 O /S B 0 v kA T R o 72 R B N S S VA
RIERE T VF AR 5

o N =

B DIRURE G S T I R 20 TR

i IS % “BUEP(View) >*EF 38 (Manage) HHHIRHIFE.

AEHE R SEHL RIS I SERL L, 3T TFBE o 0 DDV S 1
HEHESE I A4 G40 (Edit) > BT U (Cut).

EAE 1 LR SELSRTE B U SERL L, T T2 0 3 STV T L3 O O

RS “omiR"(Edit) >“Fils"(Paste).
RIAEIE T VAT IE S P

o > 0 nd =

BEAERIE I BRIEPR
H S) 16 Al il B PR AL A WA 4 T U AT AT B 2 VF TR B D145 K

PC & 5#4L (v8.0)
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%4 PC 3

4.6 Al ik

B B RAR

BV ATE R 8

46.3

fei S

VA IS

118

BEEA
VENVFATIE S Pl 2 2 RGN AU 7y, AEAER VPRSP, /e HRIRah & b B ARiR
AR IR VIV ERX LS, 15U S A VR TR

T UMEH] A 2018 17 AT ik 2 a3 BB Vi IR 9
(120wl & R AT 52 L v e R VA M A D T S

WP IER R ATHE R A

PCS7 L) MATHZA /NS Y R, TREMR . #Eu. SIMATIC BATCH 4. Route
Control 3 A & SIMATIC PDM FJ4RAF 7= S VE Al UE A] 38 B AN [R) A A0S . 2 24 PR ofi) ] 38 ik
AS RT PO 1{ OS RT PO ¥F i iFHHTH J& .

ARV IR S R A T, 152 0. ST PCS 7 H skl i Internet 1 AIHA S FF (http:/
www.siemens.com/automation/service):

o XHET: PCS7 VFnlubfI%E 451

e F4: Process Control System PCS 7, Licenses and configuration limits

£ PCS 7 V7.0 S mhiiAH, XTPO”  GEFEXf %) MvEal, LLUR@EH:

AT DI R L% A G LT SFC LR AT S BB A PCS 7 1t B 4.
B AL AEL ] OS UL, FEEVIIE.

{E CFC 1, 1847 Wt e bR P 072 "S7_m_c” 464k .
AR BT RE AL LR BRI

PC HAS5#AL (V8.0)
A3 T, 03/2012, ASE02779427-02
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ZH PC

4.6 AUk

o PRAEMIRAL ARSI
o JTSIHl AR
o JHTE S REMET AN S AREIEREFE O

HRUEEMNGMELZEL, \ISEFN IREEH RS PCS7; LREAXZRS) (Process
Control System PCS 7; Engineering System), Hll1, “3HHOMTT i FEdt &4 il iE”
(Counting and booking process object licenses) i/ »

4.6.4 5 SIMATIC 35t FEnt 5
AS KIVFATIEE
P47 SIMATIC i it VRIS A g TR H (2 I0H ) I inZm 41 245 10 1 Bt 5 i
.
N AS I, KBTI I R S ATV . DU AP BR A dH ane o SEAE I H B 2 0 H
A B A R
PCS 7 V7.0 5 = Ak :
MRPE IEAEAT N AR P B 28] AS i BEXT R 3, AR5 AT VRl I A 4
TR A v IR SRR IEAE AT I S R P BT S . AR AR “n %L
X}%”(Countable Objects) [{JiF AT ilF % 4H“AS RT PO” .
HRVEAMGE R, ESH% “&T PCS 7 AT (WL 113)” #8457,
Bk
SIMATIC Manager .47 JT.
PR
1. EAALE kR 2 I H 5 R .
2. LA “HIR(Options) >“PCS 7 #AJiEfE B&”(PCS 7 license information).
BEEDHT IT“PCS 7 ¥ I k(5 E”(PCS 7 license information) X} 5 4[E .
3. i hiE A H “ X% (AS RT PO)”
PC 4175 54 (V8.0)
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ZH PC 7

4.6 A ik

giR

46.5

Biid

EZER

120

FHN (R R S B e AL B 1 “ B 41 A4 T HIEXT %7 (Configured license objects) #.
i
VER N5 ) o & L 178 SIMATIC Manager k#6022 5 H s % 835 1 .
[ it 43 SR N AIAE B
o IAMWVFAIE,
o CYHIAT] FH M VE AT EEL H FNE AT A A X SV RIE R A A I R S H .
Hisg CFC X &
PLUR 3T CFC X% 1424 :
M V7.0 FFUG SRR G-
it LAV RIIE R IE R 0 B (PO) AR 32 484 D3 4% BorT AR B B 5 XU A7 B
JETES7_m_c” , HEKAAHAS RT PO” VFaliEZ I “PCS 7 - ia4T I VF il ik AS"(PCS 7
- Runtime License AS).
“PCS 7 YF[ilEA5 " (PCS 7 license information) X 1 HE & 11 HH (1t s A 28 ] - F-0ff g 32 14
AN S ARIZLRNHE, 152 Wi SIMATIC stk FExt % (0T 119)#4) .

AR R E LR, WZHLTN

o “IEFEIEMAIMVIRTIEZE (U 118)” #r.

o (MRS PCS7; LRAISARS) (Process Control System PCS 7; Engineering
System) FMH1) “ TR AEX SR [ E" (Counting and booking process object
licenses) k47

PC HA&S5#AL (V8.0)
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%5 PC 3
4.6 FFITiE

FHR“PCS 7 #HEf5 E"(PCS 7 license information) XIEHEH XI5 Ll & CFC SR A TR &
7N

P A A ) S 7 AE BN JLAN 7 AN R ) «

e “PCS 7 ¥ 1[ilLf5 F”(PCS 7 license information) %} ifi#E
TEZAHEAE Pk “idfEnt % (AS RT PO)’(Process objects (AS RT PO)) kil )5, A&
g AR AR AN A LR I B S B R AR SR HE P o AN e 5 TR L R/
AR L VFRTUESEHAS RT PO”

e CFC ZifHdh gt Lhhe:
1 CFC Sl #d, M4 “#ET0°(Options) > “EI& | I ¥3K"(Chart Reference
Data) 47 7T “ K% 5| %" (Chart reference data) *HiTHE, HHId3E a4 “YER"(View)
> “Gi vt (Statistics) %o~ CFC WZeil{E. “Hesif]”"(Block instances) Hx7ESH “ A
17 OCM Iifig 1%+ 4" (of which are OCM capable) " 7= HT A7 fi % 4k 15 1 R W R %
Gy AN XL G RENS A B

466  IHBERSBKERENS
KT VPTG B, #20 STPCS 7 Hat.

VER[UF 2 9 T P el B IR e @ Ml B 5 (PO) BUAR AR . b %
%14t Automation License Manager 1) “# %" (Validity) 1+ .

OS IREX & K AE %4 (OS RT PO)
AR PV T UE A R R E A A e B IR RN S . AT AR B I R X S B T R A
(R AT o

ARV RS Y], 2 nIAE TR, E3AT 2 /N ] AR

WU VF AT UE B P14 3] OS k454l OS B LAEME REE ([FFESALL B TR
OS % i At 2 OS RT PO VAl IE# 8.

FEGE AT, HRELEAT PRI B A AR G 2

7~fl: OS RT PO (FH%tk: 2000) 2000)

A PH R VF T E e s R AR BT SR VR IR 3T H 5 K i 2000 A

IERSE A VF TR (WINCC Archive)

AV rES T, Bt e RS e B H B0 U4 OS Tt H Hh (K VIAS (BT it (A VF mTIE
HI T AR A A H .

PC & 5#4L (v8.0)
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ZH PC 7

4.6 (] 5F
DAV IF B AL 1% 3] OS RS 4%, OS i T AFuk RS ak AN ARSI 55 2%
7~ 2:  WINCC Archive (H%f: 1500) 1500)
T IV ARS8, vl RSy AN IR 45 2 2L 2 A RS Z0R 29 1500 /.
R
e SIMATIC Manager &3] Jf.
e [/ SIMATIC Manager #4717 “%iik OS” ThAt. RJonl LUfE 4L FE%L
H.
7

NI RERE OS Hh CALASAIVE T A RS 5 LR UM -
1. AL PR 2 I H B8 T H .

2. K H A “TH(Tools) >“PCS 7 WHESs K ”(PCS 7 license information).
BERIFTIF“PCS 7 ¥ n U5 5" (PCS 7 license information) i i&E .

3. LA OS BN, IR MR hiLHE"OS W FEX 4"(OS Process objects).
AN L R S B R AE A BT 1« SALAVF T UEXT %7 (Configured license objects) .

4. N THE OS FIHMEMEH, EELDREFIERLH “HR2E"(Archive tags).
g‘i+ﬁ|:'j%uﬂ*ﬁﬁ&%%&i%%ﬁﬁg“W|nCC UEH:"” -‘Lfme‘-‘uJ_’ E%E@A%\{E ( “%EEH” ;FD “‘[;/Q
W17 ) 4N TAWINCC JTRS” Vi E( .

il
VERIER 5 o 2 3 T 78 SIMATIC Manager k#6022 10 H sl 235 H .

B A AT R S AR A (R

o HILAESRAE AL (OS RS54 Ek OS M LAFui RSy L2delfiin OS RT PO ¥ liiE#
ORI INVF AT FR 3 FE X B

o WUREAR B ARGREIN 5 CAS KIWVARIAHLS 5, T CAS 1145 A2 B i i HI
LUPRIEPINS TRV

o W LIFE PC LZHZAWInCC A" F PRIVl AR AR R HEH o BN AIES
VP IHRE R H AR AT A S AT WIinCC RS ” VFrliE#% . 5% 8L T4
A PR
— OS JIYVARI I 10 000 A2 H
— CAS KRl i 120 000 A2 &

o JTH REVFAIARE R H 19" WInCC V4% VFal ks $ /D> nl 4241k 1 500 ME &,

PC A& S5#AL (V8.0)
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ZH PC

WAEE AL

BEZER

4.6 AUk

o {E¥A CAS L), SIMATIC PCS 7 A IVF AR P eAE 1) A7t A1) PC

uhi I (OS B LAEEE RGEM OS JIkRS-4) .

e {EHA CAS L) 1, SIMATIC PCS 7 VIRV rIHIE# ] % 3AE CAS L. OS #.L.

YEUE R GEHT OS fiRk55 # N CAS 1AL H PRI AR AR
o XFTILRARG, WA FATAHRRE AR B H TR
Bl
WER T EVARGZT 11,000 AN IRAR R, T2 N IR VFATIEE B

o %% 1500 MHRYA M “WInCC 44" VF Rl iE%
(CEEARVFRIUESRM, s, VFRlERA: RO A Rkdk:  1500)

e 1% 10000 MARYE I WInCC JRS” VFrTHIE# 4]
(CREARVFRIUESRA S, VFRESRAY: AU SR; A %dk:  10000)

XLy PSR VF 11,500 AR AR

B

WIAATIF I H A TSI R R H AL, W) OS Fey2x H sh DI SR B

EPEIERBIVFTUEE T (5 118)7 iy

4.6.7 THEH SRS AR 428 1K E RS E

fifr

PCS 7 L) i OS Juds & AR A AL R IA R A 4% LEAT AR, Frf OS Mikgs s 4

PHAELFR AT DA VER] (VRS A H
— NI H B 22 I H R AT DA% R LR 5 X E .

PC & 5#4L (v8.0)
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ZF PC 3
4.6 IFH]iE

rh SRA A AR 5548 HVF AT IR
H R YRR 55 4% 7 LA T TR
o P du)HRiRk%5%:  OS Central Archive Server
o fffJJAF4: WinCC Archive

Bk
SIMATIC Manager .47 JT
PR
1. R kPR 2 1 H B BRI e .
2. EPFSER A “IETH"(Options) >PCS 7 ¥ nJiE{g B”(PCS 7 license information).
BERIFTFFPCS 7 VFAHIESS &”(PCS 7 license information) %} HE .
3. ek IR H “IHRYAE 5" (Archive tags).
R
SR AR IR 25 2% TR “WInCC RS VERTHIE, SRoniEE C <RI R K
7 ) WHUNT“WINCC RS ” 4 AT UFAE
TiBH
VEuHEX % 1 & 73T SIMATIC Manager Rk #5122 10 H 5035 H .
T4 OS IRS5Asisy, VARIEE H D2 H IR
EEZER

ARWTY FEVFTIAREE H R, TES W “ TR AR S iR B (BT 121)7 E40

46.8 TR TR R 2B (A

Y3k B VE AT UE R 41
XLV RIUE B PI VF AT IR AL “THBOHOCVRATIE” o 22ty T NVFRNIER PN, 2[Rl
AINVE AT

A SR VF Al B n] A E SO IS W 5 (B AR D

PC HAS5#AL (V8.0)
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%4 PC I
4.6 i

6. Bl “Maintenance RT (100)” ¢ r]iF %4

WV RIE R e H i — e a2 Wi 2048 100 MEFPE. AR — A dedruh B =
A~ Maintenance RT (100) VFrJiE% %, WnT LLiZ i £ ik 300 ASfFLL A

ERHCHTIRER 41
UM HA2W B4 7E PCS 7 T H thH2E ok B =%
e PCifi

o HEHEWIIIREM M fE (i, AZHAL
e HIILRL (CPU)

o 23k 10 (ET 200 )

o HAZW LR ILIA %

Bk
SIMATIC Manager c.4] JT.

P&’
1. AR g 22 30 H s S H

2. EPSER A “IETH"(Options) >PCS 7 ¥ 1] iE{5 B”(PCS 7 license information).
BEENFT HF“PCS 7 V1] iEf5 E"(PCS 7 license information) % 154t

3. fELILEMPIEREEAH “2kitt % (Maintenance RT)”(Diagnostic objects (Maintenance
RT)).

AN 2 R B R EATL T O “ B4V AT IEXT %7 (Configured license objects) .

TiEA
VERIET % 1 S on 3L T4E SIMATIC Manager k#8002 5 H sl & 835 H .

PC & 5#4L (v8.0)
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ZF PC 3
4.6 T IE

4.6.9 1% BATCH ¥ 2ok

BATCH 5 iV FIE % £
AR B VF P UE 25 S AR A A R SO H 10T, AR SR e O P T BATCH Jlds 4%
(¥ AR B
~: BATCHUNITs CH%iE: 20)
BATCH IR 55 #5VF AT iE 2 8 2 I 4145 20 MG,

=k
SIMATIC Manager .47 JF.
H B
1. R ks 2 0 H 5 e .
2. EFSE a4 “IBTR”(Options) >“PCS 7 k{5 & ”(PCS 7 license information).
B RIFTIFPCS 7 ¥FrlHIEf5 A"(PCS 7 license information) XJiif#E .
3. fEEMFEM P4 H“SIMATIC BATCH #.5¢”(SIMATIC BATCH units).
iR

FHR ) SIMATIC BATCH LG R e L “ CAHSVFUEX 4" (Configured license
objects) .

iEA
VFaIET 5 1 o 3L T4E SIMATIC Manager k#8102 1 H sl & I H .

4610  IHHEEBREES TR

Route Control TAEuk ¥ rliE % £

X§F SIMATIC Route Control fIE R, HVFATARSCH RIS A EL, A CA AR
el RERE R TS B AR B Tl e

~: Route Control Routes (FB#E: 50)
It Route Control fIk45#s VF vl k%80 v ) F7E b R X R R s 5 2 50 4042

PC HAS#AL (V8.0)
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%5 PC 3

W Bt

4.6 AUk

Rk T AR R H R E -
e Route Control H.0 PR /s Route Control i 45-2% 1 i i w0 (1 B A2 55

o AR LI{E SIMATIC Manager [1)“PCS 7 V¥ rJ1iE{7 E"(PCS 7 license information) X
WHEHAE . A E TS LU N

#isE SIMATIC Manager T K125 H
1. FEAFALE kB2 T H s I H .

2. W H A “TH(Tools) >*PCS 7 W HESS K ”(PCS 7 license information).
BERIFTIF“PCS 7 ¥Fnf U5 5" (PCS 7 license information) X i&E .

3. (ELEIDEM P EFEAH “BRIEN% (Route Control JIlR45%%) "(Route objects (Route Control
Server)).
FHINE 1 B AR B0R SR AE AT 1 “ B &P T HIEXT % (Configured license objects) H
Ti B
VERJIER 5 o 2 3 T 7E SIMATIC Manager k#6022 15 H 8% 23 H .

VHER IR - 38 T R4 VP e 29

|

Wik Route Control I 45 %% FFHLI A I FH T 30, 100 B 300 AN AR nlIE 28, Ul
AF— I 0 AT [R] I 25 A B R AR i ) e R AER B SR T A i . B, MRS #s R EIEE 31 A

%101 DL 301 DAL KIT, Route Control Hula2y B R LV AT UE 25 8 O
AMIESF A PRl . Route Control IR 4% #e44 4k 423847 .

WHIERE AR - REEERST BT ATEH

B VF AT R

a1 Route Control 55 #8 IR 235V Fnf IE%4H, WIARSS sk 2 AL H 300 M 4e (i KRR
#l) o T Route Control ii45 25 AN EATA A S br RAHALIIE B, EHR KBRS 1
R - VA VPRSI LLB AT R 4. £F Route Control Wy 48 R ANFEE Y I IFIX — 5

PRS-

Ko

2R VERIAIE 5 7 F81 3 3 Route Control I 45 %5 -
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ZF PC 3
4.7 Hftd PC I

4.7 H% PC

4.71 #E#%& PC ¥ — Mk

faifr
%A PCS 7 HAF)a, 4laSMscElfEEa.

=k
o Tl9c%: PCS 7 #PHFI PCS 7 k.
o DS,
B

ZLRA SIMATIC PCS 7 BOX, M HF M (W FEF#Z4 PCS 7, SIMATIC PCS 7
BOX)

HH BB

N T RENSAE A R TRE S, (ES) RAZ. nBoilil PCS 7 Wi H MFTHT BAME RS
(AS) F1 PC ufi (fy1, OS. BATCH) , WAi{Efify PC ufi EEATLL N3 .

G P e TR AT IX S

N
8

NE

24 SIMATIC Logon {1 #“Logon_Administrator” H /41 (1t 130)
P RCETE T (MU (T 131)

TCE ] TR 3 28 I S e I AR (T 133)

WHE PC ML) R (A4 (W 134)
WERREM 4G AL A (U1 136)

S PC &% AR R FHRAE R (BT 137)

LR RN . SEFME RIS 60 (5T 139)
Wit n] I PC G4 (BT 141)

B T3 PC uh (T 144)

—_—

O |0 N[O o || W|DN
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4.7 4 PC )

4.7.2 SIMATIC Logon

SR REEH B

e USB TR

i1 USB ‘b R R A B R AT A R RN, S RIRshiefy. A RuahiE
FeRIr A R, WE W PCS 7 A X HRS T R R, W20 “PCS
7 IR BRI e S5 AN KB RE 5 5 (BT 107)” #B4).

ARG

i T A% AL BT A 48 A T V.3 19 SIMATIC Logon A& ALt AR 1X— AR %
95, BN ERA V1.3 JT4G, SIMATIC Logon Afits AR T 52 s sk . Wil
TREE AR RS RIAT 8%, 2l k. Ak, nrRUGZaad s A F 4
F I by S 5%

R Ol R B sk, {HEE SIMATIC Logon i (045 B b AT 4L A 1 Il ks I s 1
B, TSGR AR T S . Bl B 4 N\ 1% A B A e b 1) 75

Windows TAEHEEEHR

WUR T ST, WG EAE ISR TAE, 24 SIMATIC Logon 7t Windows TAE4
ARPETCRTE

SIMATIC Logon it H B A F SERF M
WSS TEN AT H ST R, L LU DAk
o i “SHi”(Export), DL PDF #%:0 5 g1t
o FTEMG ST
SR A I ESS Bos rid sk FA R, AN ST H R STR .

LY (filter) WHFHELA L AHUR T Windows 1T 0 FL VA1 1] Bk ik F 90

IfIE . ANCFFFFE 1SO 8601 M)/ Trx.

PC A1 54%L (V8.0)
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4.7 ifEds PC 4%

473 A AL 7 4174 SIMATIC Logon

faifr

HEARMEDPR

130

SIMATIC Logon I SIMATIC Hi-1-454 n 44t FDA 21 CFR &% 11 &4 fifk L) 15 .
EAEH SIMATIC AR T v, wJ LM BL R AR T AT 50 k-

e SIMATIC Logon
73 BE R R AL
e SIMATIC T4
AT A P 5 SO
W EAFH SIMATIC Logon 7t PCS 7 T.) " SEdl vy il R, 7528k 4157 SIMATIC Logon
A P s N3] “Logon_Administrator” JH 4. £ELL MR 20 i N IX s8]
o {EAH PC I -
TEAH“Logon_Administrator"Windows 41

o JEN[ERI AN PC Vs n] ffdgH -
725 5l H 2% ff1“Logon_Administrator’Windows 41 -
i
A Windows 4 “Logon_Administrator” 7t %:%¢ SIMATIC Logon I H )61 .

1. FTIFH P e,

2. 1EF% ik “Logon_Administrator” 4.

3. BEAE “4174& SIMATIC Logon”(Configure SIMATIC Logon) X il HE (1) B 45 H /43 Bic 5]
“Logon_Administrator” 4.
i B
M AZACK X S8 T 7143 it 45 “Logon_Administrator’Windows 2. WIR7E
“Logon_Administrator’"Windows 41 73 liA 4, ARG IRV ) “ A3
SIMATIC Logon”(Configure SIMATIC Logon) X & HE, TGy 120 A AT Ar] B 53 34T
SOEAIE
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%5 PC 3

4.7 #Eas PC 3%
Windows 3+ 1 A P
SIMATIC Logon H /" 24 %/ Windows 21 R b1 . X L6 AN TT LUt Windows 4111
TUL

@it SIMATIC Logon 52 XA P At Esk
o UERMHME PCS T NHRETH PC L3 T SIMATIC Logon.
o UE—4H PC CEitHNL) 8% T“Logon_Administrator” 4.

Ja 85 BRI AR B

o HAEA] SIMATIC Logon B E I M (IR /- HE 21 252 XA Windows Fil /ALK 3t
W, 2% T M (SIMATIC; SIMATIC Logon) (SIMATIC; SIMATIC Logon).

o HICTFEMATIIM N EENG R, EZ% 5 H SIMATIC Logon #4715 a5 BE ¥ W
R ISR

HEZER
o Tt (SIMATIC: SIMATIC Logon)

4.7.4 BEHFES (MU

fai S
AT L AR 7 ] PCS 7, i AT A il 5 e B AT AL 52 RSN 2

{5 PCS 7 1, WTLL4 TR RGO AR 10 T 25 BB U F 3 Bhifi ey O THi %
)

o i

o i

o GLif
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4.7 Hftdr PC I

o UM

o AR

R
LR 2 E M IR R 5L

B
e LRI 45 4R StoragePlus I, Oy BT P RUBRIAJT B b .

X BT F AT i A
o [XHiNE
HG AR PCS 7 1) #HTIXLEEE,
o SR TRHER I
WP S .
LA
AR DR IE S .

o WER T (TEBHFD Mgk

I

— A3ZFF Unicode MIFEFEITE S
2R PCS 7 W EAFFHMES .

- RIB IR R
%5¢ PCS 7 I AL HIIE 5 -

— EBEH K BOARE, DT SR AN T 1 T AR AR S
vl
2 R Y 45 2 A1 StoragePlus Jo, R AJ B BRI T HE S .

EHR
U RAE B S e Windows SR/ HUBT R 3, RT3 PC s
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2R PC Bk
4.7 HE# PC 2%

475 el i B A TR B A B 2R TR TR

faifr

PAN A B R A e B FH T 413 PC il (1342 3 £ oy o 2 R A5 BB

L

WA PC uli HIEAN L ILE PC i K . TAR R R 48, MIATTEHATEL R 8K
BB B A 2 P 4%

1. f£ Windows I LR O REAL I e 48 PC 3 ( “FRAGHIIN"(My Computer)) .
2. WEAESIMATIC Shell” SLfF.

3. MR FER R ks “HE..."(Settings...) 12
BT T “ 3k & 1 287 (Select Terminal Bus) X5 AE

4. {E “MLERCAE" (Network Adapters) 4177, 16671 2% b i 2 LA T A5 P 8 H A 3 £ A5
Be,

5. i “ffixE"(OK).
TR
W RARIARE S I XS EAE, KBNS 3k PC sk 16 W 450 42

6. B LA LEAE
WA 2% 3 L A 2 FRT AT AR 1K o

AR ML IE R FER IR T
1. 4TIF “M%44%" (Network Connections) Xif 1 HE F (1) i 2 ¢
2. JEPE A RIGEE” R

PC & 5#4L (v8.0)
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ZF PC 3
4.7 Hftd PC I

3. M & 2k L) PC ulh HEAT A5 I BTl FH I 2 17 A2 T “ 4427 (Connections) 4113 1 75
Hlo Wb BN K A By 3 TV o
iH
WHRAH T IUAR ML IERLS, WL TEAM B0 TR TR 2 A F
B MIZEFN QIREERIRS PCS 7; 4 FEIEHIRSE) (Process Control System
PCS 7; Fault-tolerant Process Control Systems).

TR
LR BERCE 5, S A RERRE Hh IR SR TGS .
DR 2 B 2k _EIK) PC b BEAT JEAR I8 A F R R AL - F13R T

4. i “HfiE"(OK).

W
=

WAl S 794 PC II04% (T 141)

4.7.6 W RE PC 36 L) B & B HIZEE

faifr
PR )RR, SRR e N ML PC 2k ] K.
PATLL R AP
o ) S LiX PCuh

HEPE S I 430 2 H
— JlId CP 1613 8 CP 1623 Ml {5 Ab B A& 410 1) gk B PC k.
BRI AE I SRR TR L0 PC 3 COURAE T3 LA 1SO BhiX
o)
o frfy PC ufi:
B PC SRR A

B3R
CAEH “IHn(Start) SEHRT SIMATIC NET SCfFIATIT T “ Bt PC ufi"(Set PC Station)
HEEHE.

PC 415 #ZHL (V8.0)
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2R PC B
4.7 HE# PC 2%

Eit CP 1613 5k CP 1623 EE A ERN L] B4 LK PC 3

WIRT) 62k B PC ulfiiiid CP 1613 a2 CP 1623 il {5 Ab M Es 34T 0%, 15X Ty CP
1613 AbBERHAT LA T D BR:

e
IR EAE PC 3l EHDR 22 T PCS 7 81 AF, WIATT EHATHIPIANLL “hatfE” TFKLIK2D 8K

—_

CRRUET . EMTERLIKH, PRI (Modules) > <5 TR SR A 1R R4 2438 L 2% 1)
Hkr> >“E " (General)

2. “hRAE” - X TEAEAEN PC MLEEIR, KisiT B E PG £i:0" (PG mode).

3. TEMTERLE, P “HiE"(Modules) > <HIT5 1) R ZR A5 1 258 PIC #% (1) 2 B> >“Hh
h"(Address).

4. WEMEE (TCP/IP ksl MAC Hilit, B F#p30 .

TS ARAHE P A E BRI ) B8 L1 PC 3
WMREAET) B B 1SO WM, (HAKIIE ML IERC 231 MAC Hihit, 355X Br bt i
LG R AR AT LU P BR:

1. TERTEALE T, JEF “RiH(Modules) > <145 1) S 235 1) I 45 TG ic 4% 11 44 > >“Hh
H"(Address).

2. i N MAC Hihl, 217 PC s a5 2z bt

A PC BB ) Ko
X PC AT CL R 2D ER:
1. ERIEALE S, %8 “ Vi) s (Access Points) U3
2. fEFEF, HEHFESTONLINE” .

3. fE L F3CGER ik Bt (Properties).
#4T IF“STONLINE Jm ¥£"(STONLINE properties) X5 4E

4. fF “HrICIE: D S350 (Assigned interface parameter assignment) HEH RS H . 470
WEPC NHEE (AH) "(PC internal (local)). LI 5 S{OX S48 o

5. i “HiE”(OK).
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ZF PC 3
4.7 Hftd PC I

4.7.7 AT BEAT R AE D 2 E LA iR B

H B
WUREAET) Rk EAT TCPAP Bl W ) R L A7 h v I 28 3 e 4 AT
DL A4

HIPH & E “M2%i%ER:"(Network Connections) 1%} 1EAHE .

7“4 i%E3(Network Connections) AHFHEHi%#E T Mk,

EFESE A “ 3 (File) >* )@ 1" (Properties)..

MR 7RI A2 1 IEFE Internet F3i (TCP/IP)”(Internet Protocol (TCP/IP)).

¥l “J& M (Properties).

07 TCP/IP Hbhl:
WA E . “fl R IP Hulik: "(Use the following IP address:) &% AE

— NP Hidk,
— HINT RS

7. ¥ “HiE”(0K).
G E TCP/IP Hutil.

2B

A PPN BB 24~ R 2 & o I O BB

LB

w BT

WERAT H ZASFRAER) I 28 TG FL A, W20 6 Won i A PE e s o C “ g g 1k
(Network Properties): “&2¢ > 2k % & "(Advanced > Advanced Settings)) . 2%k
FH P4 A PR BT AT AN AR A FH ) P90 248 T O 245

G PCS T 2 )5, BHRIHHIL—ANKIEHE, DA Z57E I i 48 FH -1 2 v S5 28 11 9 24 T i 25
EFEEN A 2 e, Bl “RfE”(OK) BhEFE, ARJE i “ 27 (Yes) Bk “E R
(Reinitialize) XJifHE
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136 A3 T, 03/2012, ASE02779427-02



2R PC Bk
4.7 HE# PC 7%

4.7.8 TSR PC M4 BOAE SR A

faj /v
HAEME R TIEAS, BRCL SO T ATA NG S, R E R
o LA
o EfTHHL
PiiA
PG PR W E, AR AIET S S BEl LU CHPRED .
A 2% A TERCT ) “ BB BRI ST, A EE S E .
H 3R AMER R AR AERE
A 28 B SR R AL E 2 (10/100 Mbps) FlH/ERER, (TR
o AT RE—FhXUa Bl G R R, RN, WSO AR i A BT
Hh A 2 K
o CEXUTARE M mEd B AR, EHHEUT, R ANEGE KR AL et
b R IEHR .
Bk
RS G R TEADT )« F PR BB S AT, T R M R
PC A1 54%L (V8.0)
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ZH PC

4.7 ifE# PC Zf
ERALE | B A AT IERR SHRE.
PC WA CP 1613 5k | 1. 7 “JHAA"(Start) SH | i TR ik
CP 1623 (1) SIMATIC NET 3 | 2 1ty 15 d3¢41
e WE PC
2. PC b > i > M
248
PC INTEL M4e&micas (s (1. M “IFha(Start) ok | 508 m P4 -
H B AL KRR AE I 46 55 ;!ET'?@ “'\‘Aﬁ%%ﬁ)%f; SRR AR (I T
ey e evice Manager R .
Fodiv) B T oepmEme | PHLHIMARLED |
(Network Adapters). | ® HEZHSERDO T
2. EPEMLEIE LA . o RN T
3. X > Bt
. “Eg"(Advanced)
IR
ATHRHL SCALANCE X-400 o il Telnet 5k Web | i L1412
Based Management
SCALANCE X-300 (WBM) 4125
SCALANCE X-200 o fif Internet
SCALANCE X-200 IRT Explorer T ¥ 28 #:4)L
ESM g4 AR AE
http : \<TCP/IP Huhil:
OSM S
AS MG CP 443-1 HW Config: 15 “ALER A T L
CP 443-1 Jg{t >“1&35” | (Transmission
(Options) &35 >“&14 | medium/Duplex) F 4
I} 2% %% & (Individual FIRMEP (BRINK
Network Settings) 41 | &: “H3IXE"
(Automatic setting))
BEZER

o FE{EULH] (SIMATIC NET; TolEUKM Az #eil SCALANCE X-200) (SIMATIC NET;
Industrial Ethernet Switches SCALANCE X-200)

o HAEULH] (SIMATIC NET; ToLLIKMAZHell SCALANCE X-300) (SIMATIC NET;
Industrial Ethernet Switches SCALANCE X-300)

PC HAS#AL (V8.0)
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2R PC B
4.7 HE# PC 2%

o FE{EULH] (SIMATIC NET; Tl EUKM Az #eil SCALANCE X-400) (SIMATIC NET;
Industrial Ethernet Switches SCALANCE X-400)

o Tt (SIMATIC NET: TMEELKKIZZ#Hl SCALANCE X-300; SCALANCE X-400)
(SIMATIC NET; Industrial Ethernet Switches; SCALANCE X-300; SCALANCE X-400)

o FJit (SIMATIC NET; TOLLIKM OSM/ESM) (SIMATIC NET, Industrial Ethernet
OSM/ESM)

4.7.9 ZRZEWBAEF. RENEF. REE

faifr

ZAVHEAER . IVEAMERP RS Se i, R g e deii . AT E A
RS SN PR )

BAF BT (R R U] T 2 JR Ak S 2R R

TiEe
IR0 PCS 7 WA AR AR B, 727% pes? readme SCA:.

Microsoft 24t B4MEF

Siemens X} Microsoft £ %] Microsoft #E &4, SQL Server Fl Internet Explorer :Aii [
LAVEBAMEF RS TR . % PCS 7 Z At EAME PRI R, ATEL
SIMATIC % )" 37 #5114 H ID: 18490004 (http://support.automation.siemens.com/WW/
view/en/18490004) F 345

EZER
o WA RGNS (T 78)” #RoY

4710 w5 SNMP k%
LiFly

A LUE el AR AT SNMP ZhEM4Lt.  BAT SNMP ZhReRI AT 65

PC & 5#4L (v8.0)
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ZH PC

4.7 ifEds PC 7%

e PC il - SIEMENS Tk PC (IPC)
o LKA

- #HL (SCALANCE X...)
- ESM f1 OSM
- AfEALEESS

o JLEi#

- MIZRIE R A
- ATHHL

OPC M55 & 1% HAT SNMP ZhRe Al T2 Wi, e sz eyl I AL PC uh 15
M SNMP JIR%5 .

Ja B SNMP fR%

407 SNMP R4

N

o b~ W

140

R “gEElER (Control Panel) 17T “ s i/ Ex Windows 4114 (Add/Remove Windows

Components) XJ 1 HE 7Bt

1E“Windows 4114 (Windows Components) 1]+, #%H “4114"(Components) 41| H ]
“EHURNIE AL T H”(Management and Monitoring Tools) & 4.

CIER CEFRNINAL T H"(Management and Monitoring Tools). il “#4l{5 E”(Details).

BATIF “EBAE A T 2 (Management and Monitoring Tools) X 1A

1E PR T 1K T 411 (Subcomponents of Management and Monitoring Tools) 4]
Ferb Lk “fa] B 48 4 B3 (Simple Network Management Protocol) 5 6 HE .

s “Hfe”(0K).
SNMP 4B E B

T “3H5iHLE B (Computer Management).

/EH S gE R SR IR S5 AN HIRE S (Services and Applications) >“filz45”(Services) H
Ho

PEFESNMP 125" (SNMP service) 5k“SNMP” 4 H .
P a4 “ B (Properties).
T “224>"(Security) XETHF .
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LR PC %
4.7 HE# PC 2%

6. EFELLFIETZ —:
TG “4B 6 THLEZ SNMP #4441 (Accept SNMP packages by every host) 370 :

- AREMTHERE.

OIS “A M52 SNMP #1411 (Accept SNMP packages by this host) #5i :

— MU N BRI ARl A H M 5 A HE PC 44 LR 4Edr iy btk . 704 MS ik
5 o e BLIX PR A Hihk

— I NYEY Ik 55 25 A H bl 5 A HL PC 44 o

7. 1E “PZ AL R (Accepted community names) i A AEZH 7 Hh 4 ) B 132/°55 5 1n) AL
PRI 2 FR

ST 5 O A £ B
SR N W A A R, AR DU SOR R R G AT R A

P (PCS 7 MR R RS w4aiia PCS 7 fl WIinCC - 3EACRY) (PCS 7 process
control system, Security concept PCS 7 and WinCC - Basic document)

ARATERER, WS W PCS 7 Hid XA

4711  WAIEBTERSE PC KILE&

JRIE
TR LA F5 EHAT L R AP IR,
1. PS uif e AL Z% .
T EE R TUAR N T4 PC SN IR TUAR TAES RO ) PC it CIRSS 2 A1 T A
R
2. EHEIUREO:
XFW G PC b Z MU ER:, T8 HEAETU4 PC o LA S IERL RS,
3. XWTHRES-BE WA RG R, FFE RS 2 & F HL.
PC MilITLA& 2R

FAAE LN TURIERLLL AT

o XJ T BATCH x5+
AR BIBR N LUK W 9 2% 38 e 2 ) R 2 LG (A2 3D o
s PC HIAE BATCH JiR454%, IXJ/EME—— M RVFIITCRIER !
o YT OS 55 dsFERARFE BN SS 45 :
T 1) COM 5 11 1) 2 1 1 Ak U 4 1L 208 e 280 B o A ) o8 6 3 PR 45 £ 1 4% HL 48
(XL .
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ZF PC 3
4.7 Hftdr PC I

BEIUREN
WRAHEAEH G PC ol (Pl OS M54 ZIMEALITURER:, WFHEIERERTURIKAER
BT
AL CHRE B CMSGERCE T EEAL TR IER: .
e BATCH Jlegsds (AT BN 9 £ 1G04 A e LU SR L )
® OS x5
o PRATIEHIINGS %
o YRS AR
o rPRIAR RS A
o RN RS
TERA TR IR S SR AR R g8 b, nl AT LU N RE .
1. {£ Windows ZtJ§ 55 LA MR TE AL HH ik £ PC 3 ( “IRIG HLIK"(My Computer))
2. JEFE“SIMATIC Shell” SCfFJ.

3. fetRsEE s, RS “JLREE..."(Redundancy Settings...).
AT IT “IU4 ¥ E”(Redundancy Settings) XJ i HE .

4. ? “fﬁjﬁé’?ﬁ(ﬁﬁE‘Jﬂiﬁﬁ%”(omional connection to the redundant partner) X4, 20 A%
i
— 7 “H"(Serial port) FHAIFd, BHCOM1” B*COM2” %4 H .
- TE “MZIERC Y (Network adapter) 474K H, P mmmmmemmmo- 7 %H.
ol 3o B 1) 4% 3 T s 11 3% 42 <
— 7E “H0"(Serial port) FhidRH, R - 7 %H.
— M “WILIERL 28" (Network adapter) N Hz41 &4, 26T ) X 4% 48 T 2% o

5. My “HiE”(OK).
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2R PC B
4.7 HE# PC 7%

MR- 2B TAES RS0 (OS. BATCH) MIMHINb B
LR LAY L 40 % PC wh i RU A0 G
1. B REFM G FEEHI RS PCS 7; AR FEHI RS (Process Control System PCS
7 Fault-Tolerant Process Control Systems) " ()i B HEAT 145
% 4L (OS. BATCH) KKt i B
B L TUR RS A ik 12
1. IR TN GIREEHI RS PCS 7; L FEIEHI RS (Process Control System PCS
7; Fault-Tolerant Process Control Systems) " i1t Bl AT 815 .
SIMATIC A3 i B Bt in 2 2R

1. BTN GEREd 5248 PCS 7; SIMATIC #4245#1) (Process Control System PCS 7:
SIMATIC Route Control) " AL [P AR N 15 H AT H 4

o
=

1 5 D T B B B I TR (T 133)

4712 WA

fEisr

X PCS 7, ARV Windows 7/Server 2008/Server 2008 R2 it ELA 1) “BLidi i f 1)
#:."(Fast user switching) T g 2 Windows H /.
O3 N IE sk 21 SRR AR I T e
/J\;[:,\
Pk A
LT RE I Y ko b ., BT e 3l PC b

PC & 5#4L (v8.0)
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2R PC ik
4.8 [ RISE T J 773 S T

Bk
o DU I 0L B 5 Sk R B AT R
IR
1. 1E “TFE”(Start) SEE) “i247"(Run) MHEHEFH A LU R @r4:  "gpedit.msc”.

BT IF “ A Hb 4L S5 g 48 2% (Editor for local group policies).
2. ERDEREIY, EF AU THEYIREE > T A E > AR > R 47> % R (Local

Computer Policies > Computer Configuration > Administrative Templates > System >
Logon).

3. JAH “Bai b P ) N 1 £ (Hide entry points for fast user switching) #£75 .

4, NVHKE.
RS, Windows“JF 45" (Start) Ay “Puad - Ui ” Dhrg A rnl H .

4713  BMBAKTEZE PC

faifr
AT RERS A TR (ES) 414 FEFIIER PCS 7 1 H (KT H 3k RGH PC i
(OS. BATCH. RCS) , iHHHATLL MM E, JHGAES FERBIPHT PC .

LEEZ )N

P WL BREAS TN (LA # 7% SIMATIC PCS 7: LFFAE 74) .

4.8 B AR AN S PR i R

4.8.1 PCS 7 M infE FFsL R iR

faifr
AHRIPRAAT R PCS 7 1B AR PP A0S FTRE P 1A IR

PC HAS5#AL (V8.0)
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24 PC 3}
4.8 I TERISEIT R P L I

BEiR

o [ffhnft:
- EREZW LR (UL 145)
- JREREHMTE (U1 149)
- ZIHUEAT (DT 149)
— DiagMonitor (11 149)

o SIHRET:
- PRI (I 152)
— ML PR (UL 152)

4.8.2 2 W Th e

HT PCS 7 L] w2k AT AR HAE FIIET

X PC uh, @il LI R T EXF PCS 7 1) BT RS WA B U )

o X4 Windows 7 Ultimate. Windows Server 2008 £1 Windows Server 2008 R2 #
YER N PC %
— RealVNC (#HkfiA, 1S W PCS 7 Hib X1
- EFEEIYMY (RDP, Remote Desktop Protocol)

o XT3 Windows 7 Ultimate 1 Windows Server 2003 #:4F 2 4:¥) PC uf
- ffiffl“NetMeeting” 11k R4 1ifE
— RealVNC (M, &SN PCS 7 Hib P
— LMY (RDP, Remote Desktop Protocol)

o

3L RDP 5 1) oH SN 2 U I I AR AT 25 1 o

e
H vT OB Ik LR B AR AT A
o rfifidk CHHIMRIMEAS)
o TCP/IP &4 (L) MM &S
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= H PC 4}
4.8 I TERISE IR P L I

REMEOR
WARES PCS 7 L) $ATiE 2, A 1B T Z BIREHABUR i o

LI LAV, AR UIEit.  H AR o X 2 2 il iti, A REWS A T
SR AR LR A

LREE T 1Y (RDP, Remote Desktop Protocol)
Al LAk RDP (Remote Desktop Protocol, ZFE5LH L) %F PC i (P #2128 W Al 4k 4
AT LT ) 6
TR N AE S UL :
o Uf[H—H Pmnk il & B sy o8 % GEBNEH/admin” 5“/console” 40 ,
A RIS PE s RDP 1 il
o P IRESIBATING S EEE RSN PC 5 S 1 B
o FHP e HARTEEN AN HMI 417 R GES WL “wg i 4R 7 (1192)7 )
fE BN R VFRS 1 AL
o iijf RDP AT M1t
— AR R A 8 AR PC 3EAT #4438/ 387 A 8
- WEIMBIEN
i
A HEHITIRE
AN FEE T RDP $447 LA R #R1E:
o Al R IR PR R AR
o ZUHFNERS

o it RDP Vi i)t ML i% & I st g A AR A 1
i
PCS 7 Web %& i
¥ PCS 7 Web % 7 g FHAE Zeom Ak 551, DL ERRTIAGEH .

)8 F B k85 NetMeeting & AIE (GER T Windows XP/Server 2003/Server 2003 R2)

R B WEE Windows B k&%, )52 i H NetMeeting 4 & 41 71
1. A “45H01HH (Control Panel) 37 JF“Windows i 5% (Windows Firewall) ¥ & %} i HE .
2. EF “f4M (Exceptions) LI .
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ZH PC

EZER

4.8 W ITF RIS FE 70 e

3. rh “EFE 5L (Remote Desktop) #E.

4. Wil “YSINFERP..."(Add Program...).
BATIT “AINFE"(Add a Program) X5 HE .

5. ki “W Y (Browse).
EH“NetMeeting” TR 3C4FF .

6. E#“conf.exe” It

7. i “37JF(Open).  Hiidi “HfiE”(OK).
“conf.exe” FEFBSINE] “FERFIR 45" (Programs and Services) 41 /. F2 /7 Aof ik
“conf.exe” #E.

8. & “FF %" (Programs and Services) %1% H1i%#%“conf.exe” .

9. Hifi “4wiH"(Edit).
“Yw i (Edit Program) SFHEHEF] I .

10. 15 “HMGEH.."(Change scope...). AT L) FrE s . HERE&EA “H w1
#’(User-defined list). i A\ CAHACHENL L. i “HfiE”(OK).

11,8055 “HiE"(0K). KT IF“Windows [ k%" (Windows firewall) Xf 1% HE, 3 H. “{5 41
(Exceptions) &I 4k o

120904 “FEJ7..."(Program...). HFTIF “Us L/ 7" (Add program) XJiG4E .

13. 158 “W %" (Browse).

14 AEBAE RGN RGO Pk 30 mnmssrve.exe” .
R bR e, SO T Windows f“System32” S Serh

15. %15 “4TJF"(Open). #idi “#isE”(OK).
“mnmsrvc.exe” FEFPIGANINE] “FE 7RIk %" (Programs and Services) 41J#&H
“mnmsrvc.exe” HESHLIET .

16. 515 “ " (Edit).
“Yw i (Edit Program) SHEHEF] I .

17505 “H ML (Change scope...). HET L) & I E .
HEAFHIVCE A “ g X7 (User-defined list). %A CFEAGHENLAOMAE . o “
5"(0K).

18,855 “Hiz"(OK). 44T JF“Windows 5 K 15" (Windows Firewall) % i .

%_

19. 5055 “HiE"(OK)o KR HIIXUEi E

R4S (PCS 7 iR 2 4:; PCS 7 1 WIinCC %24 - B4 SRY) (PCS 7 process
control system, Security concept PCS 7 and WinCC - Basic document

Y BRI R, A& 0 (PCS 7 Bk ) (PCS 7 readme)

o HRERGIKHLAE )

® |Internet: http:// support.microsoft.com/kb/878451/en-us (http://
support.microsoft.com/kb/878451/zh-cn)
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ZH PC

4.8 I TERISE IR P L I

48.3

faifr

2R

i

BE

aF
iy

148

WA BB B3R

WY PC WifE B35 H8hE 5%, Al LIFE Windows TAE4H & Windows Ji ] H 8% 5%
ifit. ZVEARRER T,

PC 7 T Windows T /41,

UiHg
REANSKA “ A8 %" (Automatically Log On) SHFAE i N 3560 2 54 3. i
IR, MJazh PC abimIA L A5l e at.

1. 1E “JFiR"(Start) SCERH “I217"(Run) SCAKETHIALL Far4-:  “control userpasswords2” .
2. i “#fe"(0OK).
FFTFE “H Pk P (User Accounts) X 5 AE .

3. 1t “H"(Users) it iR, EF “ At &AL P (User for this computer) %13 HH A Y.
1) “HP” (Fln S_User) , FHEER] “H 7 abZitiin NI 4 FH E%ZI“ EfEH LR (Users
must enter a username and password to use this computer) D
SR JE Lt “ N (Apply)s
FFIIF “ A 3% 3" (Automatically Log On) XFGHE.

4. #F “#Efg. (Password:) LA K “HfiiN# Y. ”(Confirm Password:) 7Bt S A FTiE ] 7 (1) %5
i, RJE s “Hhe”(OK) BTN

5. il “He”(OK) k] “H ik 17 (User Accounts) X iGHE.
HAERI A AEh &k Tthie. EH a5 SIMATIC PC 5, 4 Hah#UT Windows &5,
CAST DS 3 N R

o HIER, PUTIHLEMCZHT, AZ0AE Windows ik A\ S ERAE R G0 H AR 48 i 20 1 8 B
(EWF, Enhanced Write Filter),

o XMIUNEMAR AR TCT g Windows HEER, IF H RS LUInE 8 X Ae 0k .

o UHTETER «H P abZitdi N P 24 Rl A ge Al FH It v ML (Users must enter a
username and password to use this computer) SEHEFIZRI R “ N H]"(Apply) 2 “
SEP(OK) 424, A 44TIF “ H3) % 5" (Automatically Log On) % H .
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%5 PC 3

484

48.5

faifr

N

4.8.6

féifi

4.8 1 TERISEIT R P L I

o UURCAHN AZEFALBATE S, Ak« H b it A P A4 R RS A R A i ot
HHL"(Users must enter a username and password to use this computer) & iEHE— X,
ARG GRS IEHE . A, ATRLS: “ N7 (Apply) 2 “#iE”(OK), %o “H3)
B k" (Automatically Log On) % I .

o {E SIMATIC IT 385 F, i#ffasE SIMATIC IT Management Console ] “# % > R4t
> 47 42"(Settings > System > Security) TG 7 “Windows H F* H 3l & 5" (Automatic
Windows user logon) 77 .

R T
A IE I F-10B PCS 7 WA M AR 1015 B, 155 W PCS7 B AT

ZIFALIAF

J T ARFEERE AT, ANAE SRR R ZE PC sl AL R % % o SR AE T FE I sk
AR AR R & (Flhn, CD/DVD ZIAL) .

USRI S TRt A2 = S BB 20, 2% i B AR 2SR WU o EZI SR LA n] A
5B 2RI FREAT 2
LRSI, VS TR R SR L 3 7 10 U W AT R A

DiagMonitor

DiagMonitor %44 Fi -5 11 & BLAIHR 15 SIMATIC PC - O A R o) j . 3 B nl i i A
TR

o LK (SNMP)

e |nternet/HiE

- WL
- SMS
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= H PC 4}
4.8 1 TERISE IR P L I

o OPC (%% SIMATIC HcfthRi R
o Web 3}

DiagMonitor A M. 45 REF BIR SIMATIC PC LW PR /IR .

Rk
i DiagMonitor #A4E, 25035 A2 AH . AR TR A 5K
BiBe
HR AV PC RMAEAE RAE RN BRI EH 5 B, 72 ILF M (DiagMonitor A1’
f&®) (DiagMonitor Getting Started) 1 (PC DiagMonitor ¥11-) (PC DiagMonitor
Software).
o fififf
K5 PCS 7 45411t SIMATIC PC HIfE%2 Witk PC (i5Z W ST PCS 7 H A
PCS 7 HiX 1P .
o HWIERZAR
HAE R0 E 1 DiagMonitor #F 1] 5 2k Aiid& F T SIMATIC PCS 7 [f#fE R4 454
fH GES I PCS 7 Hi6 XA - A R EHEER .
e SNMP k%) s
HZMHRERE, ESI “afjE H SNMP k5 (1L 139)” .
FR 1
BiHA
HAeil L TCP/IP Internet Pl AT R IR AR, PR IZ MRS A FEFT 711 SNMP 1)
W

423%% DiagMonitor %%k

1. %30T HF PC [¥) DiagMonitor # . 47 5¢ DiagMonitor & fFa] HYE B, 152 0L PCS
7 HIRSCAES
AT AR 30
— DiagMonitor_Silent_Install.bat
— CM_Activate.exe

2. EHANTEL.
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4 PC 3
4.8 B ERISE T FE Pt i I

SNMszﬁ
. T IRSS A

2?”&WP%%GWMPwmwa&WP”Tﬂﬁﬂﬁﬁﬁﬁﬁﬂ,%F%ﬁ“*
(Security) £ .

3. MEFELUNIEIZ

JA B R IET, REHTU T RE

SR FATAT R Tl Ao
SNMP £4"(Accept SNMP
packages from any host)

“CHSZRAXSEENY e SRERAN:
SNMP f1”(Accept SNMP ANt i1k AR SO PR DA S 0 T A ik (U0
packages from these & MS g5 Akt Py

hosts) o P RSTHS:
A HHbE BA H T H SR AL BR

4. 18 “BeZ A4 B (Accepted community names) T i A7 42 4 i EAT 152/ 5 15 )AL

B FFI 44 5K o
207 DiagMonitor
Bi B3
ST EALES I < H" (Management Station) 4145 T H U8 i B A8 2 AR I P s
Z\jj o

TERTA Z AL o EPATAH .

1. 76 “JT4R"(Start) S5 SIEMENS SIMATIC 7=t F, E#E3% H1.#r 2 “PC DiagMonitor > &
31 %.2%"(PC DiagMonitor > Management Explorer) )5 5 SIMATIC PC DiagMonitor.

2. BHTLAUF A
- PSR HA “uh > B..(Station > Add...), ARGk “ A’ (Local station).
— WRFREL, AR, Bl AT N IR

AIERE

R ZEFHIE“SIMATIC PC DiagMonitor” 4 BuhfE AR H P &8sk # B3R 3, 75 “TAR

> % E..."(Tools > Settings...) FHUHIEF “Ffi Windows 431 )i 2" (Start with Windows
session) i,
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= H PC 4}
4.8 1 1ERISEIT R P L I

4.87 FRARPET

(R AR R
(4617 PCS 7 (1) PC AR QUL B AR LT BN T
o BREEGGFUER G CPU I, I RIS E REOLH.

o SERORIREFF I D AT ESAE ) RAM f. — SRR R R P AN RO T ) RAM
o

WERAE T B Ry R, 1817 PCS 7 W AEHIE .

4.88 R R P

PSR
B RERAAAEVFITIE S Y] USB #iErh . AR, AU A, “VFariEssl” , B
A= AR “HRBL
i PR ARy B AR P
A B PR P T KR PR A4 L V7 T 5 P IS 1)
WEAERE P AR PP B Bl [ 2 B, T e B A EL R BT 75 FRV/F PTIE 35 B S0
<38
FEAE IR S BERE P 20, SR 2R VP T LR D HEER AR AL BEZ B
RV TR P HERRAE AL 2 22 41

AL I AR TR VU S PIHERR AR AL B b
o BPTAVER RS YULIE R R B W, VAT AT USB Fe/VE RIS PR .
o RPTHVFTIES PULE BTG T BB X, W, RerX.
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2 PC

4.8.9

EZER

4.8 W ITF RIS FE 70T e

WinCC/DataMonitor

SIMATIC WinCC/DataMonitor 7] { Fi i T HiE T Intranet/Internet [1] A & BT A BhEE)2
2 WIinCC i FR 50k

R T RE MR T B AT LS R ARl 4 i il BOIR A 5 7 o i . 3RS A A 25 b W A R 43
MrArs. Bl USRS Hbr P BEME R IR L Web TUHIAREF K215 K. DataMonitor
i (Bl IpAa = PC) £ a2 4E i tn WInCC Ik%s 2% 11 DataMonitor AR 25 8 1)
B

WinCC/DataMonitor .45 L R IhHERI T T, Al HS 4 HAR R FH 34

o “IIFEm” ThREMNAHTRIAEN “ANEFX )5~ 1 MS Internet Explorer it WinCC
o R AT WA PR . bAb () DataMonitor 75 Ik 25485 5 WIinCC Web 3 ' 245
AR RHLE], Bl . 8 BRI EE SR 2% N .

o “Web .0y ThREFMER F e A5 BT/ 7E“Web Hoy” U b, By mf
PLZH 4 DataMonitor [ 2 S nxt % (RIFTIER) Web 354F) , FE8 L0 K R Rl i
seAh, H P ar LU T DataMonitor ST 5 1) LA “Web Hoty” A (it FE 8

o NI ThReH T BRI T WInCC 1247 R &G/ e AR I 25 345 5L WinCC K
VRS e 254 T AR g S et o TSR H el S R AE FIUE X Web BT RIS AR A . TP
AFRRME AR L P WIinCC IR SR AE . T I F oy A i Bl vl 2 o
CSV AT LMESATIE D b

o “Excel T/E{” Thage—FHRE TH, ¥ WInCC H i B HRSEEE R 2 il FR1E
LR E] MS Excel W1, MIHAELELE 0 HT S FF
A LU Excel TAEfM AT K AT, @i Intranet/Internet #24k.  nJ L “45R”
IhReR I kA Excel TAEH, Ml & WIinCC £l 14k .

o LU “HF” ThEefh A R SR SARR B IR AR . X SR T WinCC
FTEMENEEL LR AT Excel TAEMAERL. i, IXFE(E AT L4 e o PR Es 5077 s £t
BTG AT . R LA PDF A% 007, i L AT RS 4 5 B0l ok o 1 B A2

% SIMATIC WinCC/DataMonitor (15 5., 2 M. SIMATIC WinCC/DataMonitor [k
W, Process Control System; SIMATIC PCS 7 DVD Lff)i#4%%: 23_DataMonitor__V...
\Documents\<Sprache>
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P %

5.1 B A - AR R A

5.1.1 EATHEASHME

HA TRRA SN AR 1 e Z b

PCS 7 #4434 MR, il Process Control System; SIMATIC PCS 7 DVD 54 T4
EAE e 30 S VA Sl o S S s B VSN S S R BT R A

HEMRMEE, WEW “PCS 7 BAFKIVF Al FIFAL (3T 113)” #57

N RERF R R

H AV R UEE B | AL IR PRV W]k 2

s

STEP 7 PCS 7 JEAR LFEALE:
o JUTEBIIUH X 21 SIMATIC 4 #il s
o JHTRHTRE{FELE ) HW Config
o T IMTM LA NetPro

SCL ghi kb iaiE 5 (S7 SCL, Structured Control Language)
M2 1EC 61131-3 ArvfEE AT H /7 ThRe R gm AR 1K =y 2 5

CFC 4L REE] (CFC, Continuous Function Chart) — JH T4 IEC
61131-3 brAExES: H S Dy sediAT BB S, HA MRS
fie

SFC I E L BE &l (SFC, Sequential Function Chart) — F -5 55 A 7 i
FPATEI A CREERE ) , HAA W D) he

PH T.) 2% (PH, Plant Hierarchy) — H-T7E 1) #E P BoRIH ;i
DRl 2SN 7 SR SRS/

IEAPO o IIFEXI4 (PO, Process Object) #IE — HTH#AEIEA A gk Hds

{18 T ) a4 ) P L S
o SASHBIT (IEA, Import Export Assistant)
ARUIFHBWEZAEL, WZH “aligaba (0 159)” .
PC 454X (V8.0)

A2 2 FHE, 03/2012, ASE02779427-02

155



KR

5.1 1R A - BATFEHI1EN]

N ] ZE iR

PCS 7 [ A TS F KL (B (B LS KB R e (il HI 1/O
B RIER ) FRIAR AL R ol e

WinCC ARSI, A AR A B A uli e b DR S I f] R 21 2

A MAGAT 55 st

AS-OS T A&

Mk T IR AS/OS 18

PV Insinfo iR %% 2%

4 WIinCC Az Wi g $2 1k ES AR &) T’

SIMATIC NET PC
Bty

I ABRIR PC A 2225 1 9 2 38 e % R AR A 4L

BATCH T & &%t

T BATCH T FE R4S 411

BATCH /. BATCH “Efi4e. BATCH #t. BATCH WinCC % )" ik
IDEI\‘\

BATCH WinCC 45251675, BATCH N[ 16

ARUEEHEEZAEL, iIE% “SIMATIC BATCH I AfH4
(U 157)” §#B4rs

Route Control
Engineering

Route Control Engineering 1444

LA Route Control. Route Control Engineering. Route Control fE.
Route Control [fifi

[RET B EZER, 2% “SIMATIC Route Control (1 fF
AL (UL 158)” oy

PDM

T I v & CREHA 4L
ARIETEEEZER, W% g (00 159)” #0.

5.1.2 BAE R AR

Btk Rk N AR P A TR IR

PCS 7 &4+ A, ¥4 id Process Control System; SIMATIC PCS 7 DVD by ff 5 uifi

VLT N TR -

A P X8 N RS P i EEVF AT IR

BEZMKERE, W% “8% T PCS 7 8 (T 113)” #)s
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KR

5.1 R A - HAFENI1EH]

T4 75 ] ZE iR

H AL VF Al IR B | Y A58 A0 BEVF TS

e

WinCC PR T ARl 52 ARl A vh - rT AR ) vl AR A 25 A

VFRUEE B 200
BEMRMEE, WS “EFE MRV g] (50 118)” &),

SFC m ¥tk

A8 AT LS s A A I ) R &

PCS 7 [fitk

BE AT TG E O L R A B O e GERE R AS ATTHIBD

SIMATIC NETPC
Brr

Ferp GLAE AL AT AT T AL NI PC v 2228 1) I 2% 3 il 4% o

SIMATIC BATCH k{44

SIMATIC BATCH [ 27 i ik

PCS 7 &4 23], Filid Process Control System; SIMATIC PCS 7 DVD 4 SIMATIC

BATCH 235 L W R o

A P X6 N YRR P 5 EEVF AT IR B

HEMRAELE, AIZ% “PCS 7 MAFMVF A FIHFRAL (51 113)” #53.

TP AR R EHR

H A VEPTEE B | F AR BEVE Al Uk
a5

BATCH Base 47 BATCH ‘223 1 i

B i A R 1) 2
BV IE R S BATCH AP 5 5 s 405 8 R Ge it 4.

BATCH Builder

wAEAE PCS 7 ES L. HT414 BATCH I H 2l 4 -6 .

e OM

e Builder
BATCH 2Rt P IR 55
Fastobject e POET /iR #

e BATCH DBMON
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KR
5.1 1R A - BATFELHI1EN]

FEFp 2% (OE:Ei 3

BATCH % /' i e BCC - fitA=/= 4zl (BatchCC) /& SIMATIC BATCH 1/ T4t
AR A R RO 4. BatchCC & T E 5
SIMATIC BATCH I %, %t nf LA{E BatchCC Hid ity

e RZE - BATCH AL Jy g s £ o7 A2 il 1 1 I B -4 BT = A= 10 G
o

e BATCH % - {ERIf¥) BATCH 4T ENLhifig

BATCH fli43¢  |e BCS-BATCH Jli/FHH RS T HITh/ric

o CDV - fLAE =B BOR IS . A7 0 AT AR = s

o VFTTIEE I :
WEZAMAGEE, WS W “IERF LRV UE S P (T 118)7
Wy

BATCH Blocks BATCH #2114k

BATCH WIinCC | PCS 7 OS [k

Client Options

BATCH WinCC PCS 7 OS 1tk
Server Options

BATCH Getting | SIMATIC BATCH [ 7413l H
Started

51.4 SIMATIC B 2354

SIMATIC Route Control N FF2F K ZE ik

PCS 7 &4 23], Filiid Process Control System; SIMATIC PCS 7 DVD 4 SIMATIC
Route Control %3 LA N FHRER . f 1K 26 5 R PP 75 B0 nf UE 254

FLZHREL, WZ% “PCS 7 HAFRIVFATARAL (5T 113)” #7).

TP AR R ERR

BV UEE B | T AL IR SR IR

Route Control Base | fiTfi Route Control %% 1) 3 Al

15545 5% SIMATIC Route Control [ 3C+4.
Route Control % /7 ity | T #8142 A H TR TR 412 K

Route Control F TG A B Bty 0 3 AT =B H )1 AR
Engineering
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KR
5.1 R A - HAFENI1EH]

Y 2y s R E AR
Route Control fli% | HI T #8424 %, JFH{E Route Control H.00H1/5¢ PCS 7 OS 5 [
i R GEZ A (4 1
VERTE A 100
BEZARAGE, WS R IEM VRS A (0T 118)”
oy

Route Control Library | 97 F 15 H P AL e el B B 042 Ll 145 Route
Control & /i b W P RH# AR B A R T AR

Route Control PCS 7 OS 1
Faceplate

51.5 AR AR

fEisr
NHN LR AT TR R N 0 RS 75 BB I ml e ]
WEZMKGEE, WS% “PCS 7 HAFMVE T FIFAL (VT 113)” #4).
i
A K5oR PCS 7 WHATICAINE B, 1ESHLF 7% PCS 7: PCS 7 [1if (Process
Control System PCS 7; PCS 7 Readme) {4,
PCS 7 %527+ 4
A PCS 7 ARG LHRE 7ok L HIX LN R o
NRERF R HIR
IEAPO SANFHBT (IEA, Import-Export-Assistant) - ] -ttt &
TR TR (B, SABHRE AR
A IEA FEYF AR
S7-PLCSIM CPU i &
SFC m[ ik SFC A RALIEAF ] T S R AR R34 461 o
VXM (Version Cross T I 72 5 W S 7ot TR 2H A E s AT RROAS B A
Manager)
PCS 7 PID Tuner R ESHIEITEN
PC 454X (V8.0)
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5.1 1R A - BATFELHI1EN]

PCS 7 JEA i ;
PCS 7 w2tk

MR GESo

DOCPRO UELELAT T2 AR G SCRY A L T A o
OpenPCS 7 A LEREN 20 A A H R (K Sk ) OPC %11
PCS 7 THifi; AR Dyl TR

DotNet HEZH
CHFR R NET HEZZ” )

Microsoft JF &I — AT G, MR G LI LA
AT PR 5 G R .

SIMATIC Logon

o F5h PCS 7 N HHFE & SR A €670 e 25 HA AH N 2 51 AL
FR (%) Windows FH /2 /H F 41

o Wuimilid SIMATIC Logon & i N FHFE - 10 FH o R HE

o RATFICRINfE

SIMATIC PDM BREN PR A A SHE. iAFiZK. SIMATIC PDM
FVHEH NN P R A S 2N R &
WebNavigator iz F % 4ii | T PSC 7 Web [z 55 %% H G K e AH S E 13 RE R AT
H
P2 EEA IR M A

Process Control System; SIMATIC PCS 7 DVD ' A5 LU T N FEFE .

IASipE s

] BEAIR

S7-F Systems

HT-404 SIMATIC S7-400F/SIMATIC S7-400FH [f ik 224> 1)
Ae. N R B e S CFC vh&il (i, s
F A I R S N I RE D, TP AR BN R FRE 25 SRR T

2
He o

BEEHER

RPN L HAL I IR TS R, IS %77 (SIMATIC PCS 7 A FEF2H) 7 48D

Wi Hx STPCS 7.
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Hi-R
5.2 1R B - PC 24 L1 C ik (A

5.2 Mk B - PC ¥ EHIC AR AHS

5.2.1 BN AR

faifr

AT AEARHELLZS TP PCS 7 1) PC oit. il 22 IR e R ORI ik b e, 3
R PC bl T2 Rl g, it

o {EN2zhe T BATCH &) b AR, CLRRINSS . 20 A UR B AR il R G A3
(1L 166))

o 0 OS W5 sttt (FEMR 5S4 L2 7% i (U0 168))
o {2 OS Mud5 %Al BATCH Jlkd5 s (Ik554% LIRSS 4% (UL 167))

PREARS
%256 PC Uiy, PCS 7 REULAERLF UL T LI M R0

o THAZL
- XTFLFE41%& PC
PCS7 T A& AR%. BATCH L F A& %A%, Route Control T F£4 4 &4 fl PDM

o
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